Relational database that makes the most of your Mac's visual
talents. Lets you draw on-sc;een lines to interconnect databases.
Gives you a simple spreadsheet-style series of cross-references.
Simple but sophisticated. Easy to ·use. Acclaimed by the critics.

BORLAND
INTERNATIONAL

..

REFLEX
FOR THE MACTM
Borland's No-Nonsense License Statement!
This software is protected by both United States copyright law and international
treaty provisions. Therefore, you must treat this software just like a book, with
the following single exception. Borland/ Analytica, Inc. authorizes you to make
archival copies of the software for the sole purpose of backing-up our software
and protecting your investment from loss.
By saying, "just like a book," Borland means, for example, that this software may
be used by any number of people and may be freely moved from one computer
location to another, so long as there is no possibility of it being used at one
location while it's being used at another. Just like a book that can't be read by two
different people in two different places at the same time, neither can the
software be used by two different people in two different places at the same
time. (Unless, of course, Borland's copyright has been violated.)

WARRANTY
With respect to the physical diskette and physical documentation enclosed
herein, Borland/ Analytica, Inc. ("Borland") warrants the same to be free of
defects in materials and workmanship for a period of 60 days from the date of
purchase. In the event of notification within the warranty period of defects in
material or workmanship, Borland will replace the defective diskette or
documentation. If you need to return a product, call the Borland Customer
Service Department to obtain a return authorization number. The remedy for
breach of this warranty shall be limited to replacement and shall not encompass
any other damages, including but not limited to loss of profit, and special,
incidental, consequential, or other similar claims.
Borland/ Analytica, Inc. specifically disclaims all other warranties, expressed or
implied, including but not limited to implied warranties of merchantability and
fitness for a particular purpose with respect to defects in the diskette and
documentation, and the program license granted herein in particular, and
without limiting operation of the program license with respect to any particular
application, use, or purpose. In no event shall Borland be liable for any loss of
profit or any other commercial damage, including but not limited to special,
incidental, consequential or other damages.

GOVERNING LAW
This statement shall be construed, interpreted, and governed by the laws of the
state of California.

First Edition, August. 1986
Printed in United States of America
987654321

REFLEX
FOR THE MACTM
VERSION 1.0

BORLAND
INTERNATIONAL

4585 SCOTTS VALLEY DRIVE
SCOTTS VALLEY, CALIFORNIA 95066

Apple and LaserWriter are registered trademarks and Finder, ImageWriter, MacPaint, and MacWrite are trademarks
of Apple Computer, Incorporated. Macintosh is a trademark of McIntosh Laboratory, Inc .. and is used with express
permission of its owner. Microsoft Word is a registered trademark of Microsoft Corporation.
Copyright © 1986 by Borland/Analytica, Inc.
All rights reserved.

CONTENTS

INTRODUCTION

iii
v

Installing Reflex
Backing Up Database Files
SECTION ONE: Single Files

1
4
14
20
30
54
58
64
77

Database Basics
Creating a Simple Database
Entering Information
Finding Information
Producing Simple Reports
Rearranging Fields in Files
The Employee Database
Redesigning Data Entry Forms
Reporting on the Employee Database
SECTION TWO: Multiple Files

85
97
116
127
132

Multiple Database Design
Building A Multiple File Database
Entering Information in Multiple Files
A Three-File Stocks Database
Reporting on the Stocks Database
SECTION THREE: Details & Techniques

165

Details and Techniques with Examples
SECTION FOUR: Reference

209
223
289
313
320

Reflex Formulas and Queries
Menu References
Functions
Error messages
Reflex Data Sheet
Index

INTRODUCTION

This manual introduces you to Reflex for the Mac, a powerful new
product that merges the power of relational database technology with
the calculation capability of a spreadsheet.
Some key features of Reflex are:
Simplicity of database design. Reflex databases are designed
in much the same manner one would use MacDraw to create an
image. Instead of sketching a database design on paper and then
having to type in a long list of definitions, you can now draw your
database directly on the Macintosh screen. As a result, it is possible
to create complex databases literally in minutes rather than days.
Simplicity of report design. Most database systems only
provide limited reporting facilities. Reflex offers a very flexible
"what you see is what you get" report and data entry form layout
capability. All Macintosh supported fonts and graphics may be used.
Both the Apple ImageWriter and LaserWriter are supported for
output. At last, the user is in control of the total look of a report.
Reflex allows you to handle complex tasks such as "what if' tax
modelling, client billing, cashflow management, and portfolio
analysis without the need for programming. You will find a range of
ready-to-go business solutions on the Examples disk supplied with
this package so that you can start discovering the benefits of the
Reflex concept right away.

Using This

Manual

This manual is divided into the four following sections:
Section One: Single Files will show you how to design, create,
and modify single file databases. You will be introduced to some
basic database design concepts as well as those features unique to
Reflex. Reports will be produced on files that you create. Although
Section One is written in tutorial fashion (and it is therefore assumed
that users will read its contents in the correct order), the abundant
use of graphics taken from the Macintosh screen make it simple to
follow the sequence of events at a glance.

Section Two: Multiple Files begins with a general discussion
of multiple file design concepts and contains many pictorial
explanations. The rest of Section Two is written in a tutorial fashion
and takes the reader from creating a two-file database up to using
and reporting on a quite sophisticated three-file Stocks database.
Many actual graphics taken from the Macintosh screen are used.
Section Three: Details & Techniques will help you get the
most out of Reflex. It is here that information on advanced
techniques will be found. Topics include importing/exporting data,
printing facilities (such as creating headers and footers), and
database reorganization.
Reflex Reference contains a wide range of general information
about Reflex features. It is here that you will find: a listing of all
menus and descriptions of their options; a description of all Reflex
functions and their syntax; and a list of Reflex error messages with
descriptions of each.

Obtaining Help
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There are two ways in which to obtain help while using Reflex. You
may select general Help information by selecting the Help option
located in the. menu. Alternatively you may press the Shift and
question mark ("?") keys to obtain a special Help cursor which will
display relevant Help information for anything pointed to. More
specific details on Reflex's Help facilities are given in Section Three:
Details & Techniques.

INSTALLING
REFLEX

To use Reflex on the Macintosh you require:
> 512K of memory or Macintosh Plus
> The Reflex system disk.

> A second disk drive (a floppy drive or a hard disk)
recommended.
> A printer (Reflex supports the Apple Imagewriter and
LaserWriter for output).

Getti ng Started

Before starting to work with Reflex you should make a copy of the
Reflex system disk and the Examples disk. Store the originals
away in a safe place and then use the copies for daily work.

Copying the Reflex disks to standard floppies:
> With the Macintosh on, insert the Reflex disk.
appear on the desktop.

Its icon will

> Insert a blank disk in the external drive and wait for its icon to
appear. If the disk has never been formatted, a dialog will appear
asking if you want to have the disk initialized. In this case, click on
the button marked Initialize. Give the disk a name when you are
asked to do so.
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> Select the Reflex disk icon and drag its ghost image on top of
the blank disk as shown below.

When the blank disk icon turns black let go of the ghost image. The
Macintosh will now make a copy of the Reflex disk files on the
blank disk.
> Follow the same procedure with another blank disk for the
Reflex Examples disk.

Installing Reflex on a Hard Disk:
The procedure for installing Reflex on a hard disk is only slightly
different to making a backup on a floppy disk.
> Start up the Macintosh and hard disk. Insert the Reflex disk and
wait for its icon to appear on the desktop.
> Open the Reflex disk icon by double-clicking on it.
> Select every item (hold the Shift key down while you click on
each icon) except the System Folder since you do not want to
replace your current hard disk system files. Next, drag the selected
file ghost images over to the hard disk icon. Let go of the ghost
images and the files will be copied.

> Insert the Examples disk and copy the files it contains in the same
manner.
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BACKING UP
DATABASE
FILES

There are some basic guidelines for saving databases so that you can
keep your information as up-to-date and consistent as possible.

Making backup copies of single or multiple tile
databases:
> You may make copies of Reflex databases either from the Finder:
or by using the Save As option located in the Reflex File menu. For
single files, there are no special considerations. However, for
multiple file designs it is extremely important that you copy the
complete set of files at one time. If you do not do this you may end
up with inconsistent data in the files. The best approach is to keep
related files together in one Folder and to copy that folder whenever
you wish to make a backup.

> This will also ensure that your Reflex files will work well with
the hierarchical filing system (HFS) by Apple for the Macintosh.
With HFS, if individual files of a related set are located in more than
one folder, Reflex will not be able to find them when you attempt to
load the complete set of files or run a report that requires the
information they contain. Your options are to keep related files in
one folder; pre-open all the files that you will need; or Show the
relevant file images in the Database Overview window.
> You may rename database files at the Finder level in the normal
manner. For single files, there are no special considerations. For
multiple file designs, if you delete or rename any files from a linked
set Reflex will be able to find these files from within any related
files.
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If Reflex cannot find the linked file it requires, the dialog shown
below will be displayed.

Database File "topic couldn't be found. If you
haue deleted "topic" in the Finder, please see
Details 8' Techniques in the RefleH manual. If
you haue renamed "topic" please enter the new
name and select IIrename.
ll

1I

IsubHeading
(( Cancel ))
(Rename)

In the above example, Reflex could not find a file called "topic"
which was part of a linked set. If the file had been renamed at the
Finder level, simply entering the new name (subHeading) in the text
box provided and clicking on· the Rename button would have solved
the problem. The situation is a little more complex when a file
containing a Link or Links is deleted - refer to Section Three: Details
& Techniques for more information on this subject.
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Section One:
Single Files
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Database Basics

Database Basics

Reflex provides you with serious and sophisticated database design
and reporting capabilities whether you are storing the names of a
few friends, managing a small office, or keeping track of the data
within a large corporation. Probably the best way to learn about
these capabilities is to start by building a simple database file.
,In the first tutorial section you will build a file designed to store
information on your friends' birthdays. While this may seem to be a
rather simple application, it nevertheless allows you to put many of
Reflex's powerful design and reporting features into action right
away.
Once you have created the Birthday file and produced some simple
reports on it, the final part of this section will show you how such a
simple design can be upgraded into a more practical form - an
employee record file.
If you are new to database programs you should pay special
attention to the explanations and examples given in the first tutorial
sections that follow. This will not only ensure that you understand
the basic ideas of designing, building and using databases, but they
will make you aware of any features special or unique to Reflex.

In its simplest form, a database will consist of a single file
containing a number of records, which in tum contain a number of
fields.
Let's stop right here and examine, from the bottom up, what we
mean by field, record and file.
Consider the kind of information you will need for the birthday file
we will create shortly. Below is a list of friends' names and their
birthdays that are likely candidates for entry.

FIRSTNAME
Frank
Mark
Pakic:;a
Alice
Roger

LASTNAME
Smith
Johnson
Robeds
Springfie ld
Davis

BIRTHDATE

8/6/59
10/18/63
3/1/45
9/6/51
4/11/48
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Fields

For each friend there are three distinct entries in the list: a First
Name; a Last name; and a Birthdate. In database terms each of these
entries is known as a Field. A field is the smallest unit of
information that you can distinctly enter in a file.
We could, of course, add many more fields to the above list (such as
home addresses and/or telephone numbers) if we wished, but let's
leave it this way for now.

Records

Each row of the list (the combination of the First Name, Last Name
and Birthdate fields for each friend) is known as a Record. A
record must be unique in that no other row in the same file may
contain exactly the same information (see the section on Key Fields
below for relevant information on this topic).
Once you have one or more records, you store them on disk as a
database File. In our example we will call our file "Birthday" and
use it to store the information shown in the list.

A Database

Birthday

file " "
Fields

First Name
Last Name
Birth Date

Records

First Name
Last Name
Birth Date
First Name
Last Name
Birth Date

Key Fields

2

Each record in a file must be given a Key. This is where one or
more fields uniquely identify each record in a file. Choose the key
field(s) carefully so that they make each record different from the
others: choosing just firstname as the key would be inappropriate
since it is possible that you know people with the same firstname.

Oatabase Basics

Choosing a combination key consisting of the First Name and Last
Name would be a much safer approach. You could arrange it so that
all fields in a record are part of the key, but this does not necessarily
ensure record uniqueness; it's much more efficient to use the
minimum number of fields necessary.
Searching A
Database File

Once you have entered data into a file you'll need to be able to
search through it (there may be oile or maybe hundreds of records)
for useful infonnation. Typically you will want to see only a few
records in your file that meet some specific set of conditions (eg:
Show me the names of all those friends that were born in 1945).
Reflex provides an automated search facility, called QueryBuild,
that helps you build an accurate database record qualification. You
are also provided with a more versatile, free-fonn method of directly
typing in record qualifications.

Producing A
Database Report

Once you've entered infonnation into a file you can look at
individual records on the Macintosh display, enter new records, or
update those that already exist. However, all searches you carry out
are temporary - the results of each viewing are not saved.
If you want to find some specific information in a file and then save
the search specification you created for later use, or if you wish to
perform more complex queries or calculations than that allowed by a
database file search, you would use a Report.

With Reflex you can automatically produce simple table-style
reports, or you can take advantage of its freeform reporting features
to create customized reports containing simple or complex
calculations, arbitrary organization, fonts of different style and, if
appropriate, graphic images.
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Creating A
Simple Database

Insert the Reflex boot disk, and turn on the Macintosh.
When the Finder has loaded, open Reflex by double
clicking on the application icon.
•

File

Edit

o

System Folder

Uiew

~
Reflex

/
Double click. on

Special

~

Person Info

t~e

~

Employee

R.eflex program icon

When Reflex is loaded you will be presented with the Database
Overview window. All database files are built and modified within
the Overview window; it is here that you will create fields, set their
type, arrange record Keys, delete fields and, later, link database files
together.
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Creating a Simple Database
•

File

Edit

Format

Describe

Oueruiew

Window

DataBase Oueruiew

Not ice tflat tfl is window fla s no
close box

Unlike standard Macintosh windows, the Reflex Overview window
does not have a close box at the top left comer. This is because the
Overview Window is meant to be available regardless of what you
are doing with Reflex.

Go to the File menu and select New Database File.
Edit

Format

Describe

Oueruiew

Window

New Report .••
Open Database File ...
Open Report ••.
f !OS(~
Close All Documents
Saue Design
3€S
S<W(~ f!~",

Reuert to Old Design

3€R

Page Setup •.•
Print •••
Quit
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A dialog appears asking you to provide a name for the new file.

Type the name: Birthday

create File named:

I Birthday
Create

Eject
Cancel

Driue

If you make any typing mistakes use the Backspace key to remove
them and then retype the correct information. Note that the file name
is singular rather than plural. It's a good idea to use a singular
naming convention since it will make your work easier when you
refer to file names in formulas and queries later on.

Confirm that you want to create the file by clicking on
Create or by pressing the Return key.
An image of the Birthday file appears in the top left comer of the
Overview window.

Name bar
Status Icon

first field
selected
Within the Overview window all database files have the same
general appearance. A single file image consists of a box which
contains:
• A Name bar: This contains the file name which you entered
after selecting the New Database File option.

6

Creating a Simple Database

• A Status icon at the top left comer: This icon informs you of
the status of a file design. If the box has an "X" inside it then the
current file design needs to be saved; you have either just created the
file or modified an existing one. If the icon is clear this means that
the file design is safely stored away on disk. If the icon is gray, this
indicates that a database window for this file is open.
• An empty field space and/or one or more completed field
names: A database file contains one or more fields. These contain

information about the various attributes of some object or event on
which you wish to store data.

Since the first field is already selected, you can enter a
field name by typing: FirstName
Reflex needs to have field names that do not contain any spaces.
Use the "_" character if you want some separation between the parts
of a name (Date_of_Birth or Purchase_Price, for example). If you
accidentally enter spaces while defining a field name, they are
automatically converted to the "_" character as they are entered.
Spaces included in database file and report names are handled in the
same way.
Notice the uppercase "N" in FirstName. Using uppercase letters
inside field names helps separate words without the need for blank
spaces. (On a general note, it is important to try and use meaningful
field names as much as possible. Reflex allows you to use names
up to 32 characters long - so use Birthdate instead of BDate, or
Employee# instead of Empno.)
If you make any typing mistakes use the Backspace key to remove
them. Alternatively, you can delete the whole field by clicking on it
and selecting Clear from the Edit menu. Then choose Insert Field
from the Overview menu to enter a field name again.
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Reflex fields can be one of seven different types. You
can see the choices by clicking on the Describe menu.
•

File

Edit

11XI8irthday

I FirstName

Format .11~"".III=-- Oueruiew
v'TeHt Field
Number Field
I nteger Field
Date Field
I
Logical Field
Time Field
Sequence Field

Window

I

H Unl( 1(! On(~ ., '" ,. H(~( oni
H I: 0!!~~!:1 ~(ln of Links 1(I ., ' " ,.

HH(

onis

Key Field
.....Non-Key Field

Note the check mark next to the Text Field menu option. This
indicates that the field name you just entered (and which is currently
selected), is of the field type Text. A text field may contain any
characters that can be displayed on the Macintosh screen, including
spaces.
Fields are automatically of type Text when they are created; you can
change this default field setting via the Describe menu. Since you
will be entering a person's first name in the FirstName field don't
change the default.

To enter a second field choose Insert Field from the
Overview menu.
•

File

Edit

Format
md(~ B<11 <lb<I~~~ m(~ ·'Binhd!H.f'
Show Unl(ed rih~s
:){(!~
Protect Design

Insert FIeld
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Creating a Simple Database

Space for you to type a new field appears just underneath the first
one.

~8irthd8Y

,FirstName

.

As with the first field position, this second field is already selected
for you. Be careful, if you click outside of the file image at this time
the field will no longer be selected.

~8irthd8y

~8irthd8Y

,FirstName
Selected

.

FirstName

Deselected

To reselect the new field position, select the file image, go to the
Overview menu and choose the Insert Fiel.d option once again.

Name this second field by typing: LastName
Again, use the uppercase "N" to make the name easy to read. This
field will also contain part of a person's name so you can leave it as
a Text field.

Instead of choosing Insert Field from the Overview
menu to enter the third field, this time just press the
Return key.
Another new field space appears. Pressing Return after entering a
field name is a short-cut method of telling Reflex you want to insert
a new field.
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Name the third field by typing: BirthDate
This third field will be used to store your friends' birthdates.
Currently, it is a Text field so you must tell Reflex that it should be a
Date field.

Go to the Describe menu and choose the Date Field
option•
•

File

Edit

Window

~~~~~~~~~Numbe~r~Ftie=ld~------------~~~~~
~Birthd8y

FirstName
LastName
BirthOate

Integer Field
I.'

.

I

Logical Field
Time Field
Sequence Field

n Uni(

1(! OrH~ -, '" ,- Hewni
H [oHt~dion of Links 10 -, '" ,- He( onis

Key Field
v'Non-Key Field

The BirthDate field can now only be used to store information in the
form of a date - if you enter freeform text (such the name of a month
or an incomplete date), Reflex will automatically reject it and prompt
you for information in the correct date format which is
Month/Day/Year. If you choose the wrong field type option or need
to change a field type you can do so. Select the relevant field by
clicking on it and choose the preferred field type from the Describe
menu.
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reatlng a

Imp e

ata ase

You now have a simple file design, but it's not complete yet. Each
record needs to have a Key - a field or group of fields that is chosen
to uniquely identify each record in a database. If you attempt to save
your design before choosing a key Reflex will display the message
below.
Euery Database File must haue at least one
key field. The key fields of a File are those
fields that, taken together, distinguish
between any two records in the File.

R

OK

)]

In the Birthday file you might choose to use the LastName field as a
key identifier of your friends. One problem you might encounter,
though, is that you have more than one friend with the same last
name.
A better solution would be to use both the FirstName and LastName
fields as a combination key. You might know two people called
Alice, but it's fairly unlikely that they will have the same last name.

Select the FirstName field by clicking on it.
•

File

Edit

Format

Describe

Oueruiew

Window

DataBase Oueruiew

!Xl Oi rthday
LastName
BirthOate
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Go to the Describe menu and choose the Key Field
option.
•

File

Edit

Format

Window
Number Field
I nteger Field
Date Field
Logical Field
Time Field
Sequence Field

/Xl Bi rthdoy
LastName
BirthDate

t· .. ····,························· .... ···· .. ········ .. ····· ........................................................·· .. ··········t

H t ink 1(I Hrw ,~ '''~' fh:H ord
H t oH~~{;Hon of Unks: 10 '~'"

I'

HH(

onis:

Notice that the FirstName field is now underlined to show that
you've made it a key field.
•

File

Edit

Format

Describe

Oueruiew

Window

DataBase Oueru
~ Birthday

LestNeme
BirthDete

If you ever make a mistake and want to change a key field back into
a non-key field you can do so. Select the field and choose the Nonkey field option from the Describe menu.

Select the LastName field by clicking on it. Go to the
Describe menu and choose the Key Field option.
The LastN arne field is now also underlined in the file image.
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Every record in our Birthday file (the information on each individual
stored in the FirstName, LastName and BirthDate fields) will be
uniquely identified by the combination of a first name and a last
name.
If you try to enter the same name twice, Reflex will inform you that
a record with that information already exists and will offer guidance
on how to resolve the situation.
In the event that you do have more than one friend with the same
name you might want to distinguish between the records by
including the BirthDate field as an additional part of the key. Or you
could add more fields, such as a middle name, a telephone number
or an address that would further ensure record uniqueness.
(Reflex also provides the Sequence field type which can be used to
tag each database file record with a unique record number as it is
entered. You may choose a number for the record or, if you don't,
Reflex will automatically provide one.)
For now, let's stay with the simple design you've created and start
entering some records.
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Entering
Informalion

So long as you are building or modifying a file in the Overview
window, the file image will have an "X" mark in the top left comer the Birthday file you just completed currently has an X mark
present.
"

"X" mark. in
status icon

File

Edit

Format

Describe

---+- ~ Birthday

FirstName
BirthDate

Confirm your file design by going to the File menu and
selecting the Save Design option.
Edit Format Describe
New Database File ...
New Report ...
Open Database File .•.
Open Report ...
[ ~ose
Close All Documents
S<we fh,,,
Reuert to Old Design
Page Setup ...
Print ...
Quit
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Ouen

Entering Information

This saves all infonnation about the Birthday file to disk: its name;
its structure; the names and types of fields it contains and its position
in the Overview window. Also note that the status icon no longer
contains an X mark. This confinns that the file is ready to be opened
and infonnation added to it.
There are two ways to open a Reflex file:
• You can go to the File menu and select the Open Database File
option. You will then be presented with a list of names from which
you choose the one you wish to open.
• You can double-click on a file name' bar, just as you would click
on an application icon from the Finder.

Double click on the Birthday file name bar.
A blank data entry window appears in front of the Overview
window.
Formula
panel

Vert ical divider bar

Mis

Name
panel
labels
{

Bi rthD. t.

~: : : : :": : : : : .: : : : : : : : : : :;': : : : :

.'::::::::::;':::::::::,':::::::::;

Horizontal divider bar

~

Fields

Act iVity Indicator

/
~ :

• The file name - Birthday - is in the window's title bar.
• There is a set of three labels that correspond to the names you
entered in the file image (FirstName, LastName, BirthDate).
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• Alongside each label there is an empty field - this is where you
will enter the infonnation you wish to store. Notice that the first
field is already selected. The selected field's name - FirstName- is
displayed at the top left of the window in its own special Name
panel. If the need arises (you wish to see all of a long field name,
for example), this name panel can be made wider.
Move the cursor over the vertical divider bar. The arrow
cursor will alter shape to indicate that the field name
panel can be made wider or narrower. Press the mouse
button and drag the vertical divider bar to the right.
•

File

Edit

Format

Describe

D

Databl

Birthday
~~

FirstName
FirstName

LastName
Bi rthDa te :::::::::::.::::::::::::::::::::::::::::::::::::::::::::::.,:::::::::::::::::::::::::;

Return the vertical divider bar to its original position.
• A fonnula panel is to the right of the field name panel. This is
where search criteria will be entered. It too, can be resized to
accommodate long fonnulas.
Move the cursor over the horizontal divider bar. Again,
the standard arrow cursor will change into a doubleheaded arrow indicating that this divider bar may be
raised or lowered. Move the horizontal divider bar up
and down to see how it may be repositioned.
•

File
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Birthday

_ _Ir""I~~
FirstName
TFirstName
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FirstName

II FirstName
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LastName
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Return the horizontal divider bar to its original position.
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Entering Information

• To the left of the empty fields, Reflex has preset some labels
based on the names you originally supplied in the Overview windowFirstName, LastName, BirthDate - which help identify each field.
The data entry fonn design shown above is the default design; you
can customize this any time you want. The sizes of fields and their
positions can be changed, and graphic images can be easily "cut and
pasted" into data entry fonns from other applications.
With Reflex you can have many windows open at one time.
However, infonnation can only be entered or modified within the
active window. Right now Birthday's data entry fonn is in the active
window.
(An active window can be recognized by the horizontal lines in the
title bar, scroll bars for moving around a document, a size box for .
changing the size of a window, and a close box for removing a
window from the display. See Macintosh, the owner's
guide for more infonnation on Macintosh window features.)

Depending on which type of Reflex window is active, different
menus appear in the menu bar across the top of the screen. For
example, currently there's a Database menu visible; if you make
the Overview window active again by selecting it from the Window
menu, the Database menu disappears and the Overview menu
appears.
This ensures that you will always have the most appropriate menus
available however many different types of windows are open.
If the Birthday window is not currently active click on it
anywhere, or if it's hidden from view go to the Window
menu and select Birthday. Fill in the first record's blank
fields with a friend's name and birthdate. Type their
first name in the already selected FirstName field.
Edit the text as you would any Macintosh text. The important thing
to realize however, is that the first time you click on an unselected
field you will select the complete field (the field will tum black);
entering a single character will replace all of the field's contents. If
you click on an already selected field, you may then edit specific
portions of the field's contents.
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Press the Tab or Return key to move to the next fie~d.
For dat-a entry, the tab order (whether you use the Tab or Return
key) is from left to right, top to bottom of the data entry form. When
you have tabbed to the last field in a form, using the Tab or Return
key will return you to the topmost field.

Enter the last name in the selected LastName field.
Complete the first record by moving to the final field
and entering the Birthdate.
Notice that an X mark has appeared in the top left comer of the
window - it was placed there when you typed into the first field.
While creating the Birthday file within the Overview window there
was an X mark in the file image until the completed design was
saved to disk. An X mark in a data entry form has much the same
purpose; it means that the newly entered record is not yet a
permanent part of the file.

Go to the Database menu and select New Record.
Alternatively, just press the Enter key.
A blank new record appears. The New Record option, or the Enter
key, not only produces this blank record, it .also places the
previously filled out record into the Birthday file.

Fill in the blanks again, this time with another friend's
name and birth date.
You could go on entering information in this manner, but instead
let'sjust save the two records you've entered.

Go to the File menu and select Save Record.
This confirms that you want to save all entered records to disk (the
first record, and the currently displayed record). The X mark at top
left has now been replaced by a clear rectangular icon; this new icon
shows that the record shown in the window has now been entered
into the Birthday file.
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Entering Information

• It is important to be aware that Reflex has an auto-save feature
which ensures that new or modified database records are not left
unsaved for too long a period. If no activity occurs for about two
minutes, Reflex will automatically save changes made to all
database files.
• Error messages can appear as a result of this auto-save feature
(there may be some physical problem with the disk and'or disk
drive). When a problem occurs, Reflex will first display a dialog
alerting you to the situation and then display an informative dialog
indicating which file has encountered trouble.
To save you the effort of entering lots of names and birthdates in the
Birthday file, there is a demonstration file of the same design on the
Reflex disk. You can now load that file and start learning how to
search for information.
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Finding
Information

Go to the Window menu and select Database Overview.
The Overview window moves in front of the Birthday window; it is
now the active window. Notice that the status icon in the Birthday
file image is gray. This means that a window for this file is currently
open.
The status icon in the database file image provides three types of
messages:
• An X indicates that there are file design changes still to be saved.

~ birthday

firstname
lastname
bi rthdate
• A grayed area indicates that the current file displayed in the
Overview window is open somewhere within Reflex. No changes
can be made to this database while it is open.

Ii

birthday

fi rstname
lastname
bi rthdate

• A clear icon signals that there are no unsaved changes to the
database design and it is not open.

Lj

birthday

fi rstname
lastname
bi rthdate
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Finding Information

Note that when using the double-click method of opening a file, you
must not click on the status icon that appears at the top left comer of
the file image. Clicking on the status icon has the same effect as the
Hide Database File option in the Overview menu - the currentI y
selected file image is removed from the Overview window. (This is
very similar to the close box that can be used to remove windows.)

Go to the Overview menu and select Show Database
File. When the name list appears find and select
PersonInfo. Then click on the Show button to display
PersonInfo's file image in the Overview window.
The file PersonInfo appears in the Overview window near to the
Birthday file image. Except for the contents of their name bars, the
two are identical in design.

Ii File Edit Format Describe Oueruiew Wi
DataB€

iii Birthday
Fi rstName
LastName
Bi rthDate

~
Fi t-::: t Nfl rn e
L ;J ::: t r',J ij t-n e

Eii rt~-ID;Jte

•

To avoid confusion, it is probably a good idea to now close
Birthday's data entry form and remove its file image from the
Overview window.

Go to the File menu and select the Close All Documents
option.
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The status icon in the Birthday file image will shortly clear (it will no
longer be gray), indicating that this file's data entry form has been
closed.

Hide the Birthday file image by clicking once on its
status icon.
You are now ready to start work witli the PersonInfo database file.

Open PersonInfo by double-clicking on its name bar.
A new data entry window - titled PersonInfo - appears in front of
the Overview window. The first record in the file is shown.

Ii File Edit Format Describe Database Search Mis

FirstName
LastName
BirthDate

If you want to browse through this file go to the Search
menu and use the First, Last, Next and Prior Record
options to look at records.
• First Record displays the first record of a file whatever the current
position is in that file. The first record can also be displayed by
pressing the "00" and "F" keys at the same time.
• Last Record displays the last record of a file whatever the current
position is in that file. Can also be selected by the 00 L shortcut.
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• Next Record moves one record toward the end of a file from the
current position. Can also be selected by the 00 N shortcut.
• Prior Record moves one record nearer to the beginning of a file
from the current position. Can also be selected by the 00 P shortcut.
When Reflex cannot fulfill your menu choice, it will display a
relevant message to that effect. For example, if you try to use the
Next Record command when you are already at the end of a file you
will first hear a beep (or the menu bar will flash if you have turned
the Macintosh speaker off via the Control Panel). If you try to use
the same command again, Reflex will display the dialog box shown
below.

This is the last record.

I(

OK

))

Reflex automatically arranges, or sorts, records in ascending order
by the key field(s) you choose - in this case alphabetically by the
combination of first and last names. The key field(s) control what
records actually appear when you use the First, Last, Next and Prior
Record commands.

Using QueryBuild

If you need to find a specific record or set of records in a file, use
the QueryBuild feature designed into Reflex. This method of finding
records can be of great help while you are still learning how to use
Reflex. It is also a lot quicker than just browsing through a file
hoping to locate the information you require.

If it is not already selected, click on the FirstName field
of whichever record is currently displayed. Go to the
Search menu and select the Search On option.
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The QueryBuild dialog box appears as shown below.
Enter qualification for the record(s) desired.
Field to Search:
Operator to Use:
@
Equal
FirstName
Not Equal
LastName
Less
BirthOate
Less Or Equal
Greater
Greater Or Equal
Starts With
Includes

IIII

Ualue to Find:

o
o
o
o
o
o
o

nFind nil )1
( Cancel)
HelP)

)
)

fiNO

( [Nl[H

)

~I------------------------~I.

The default at this time is the Find All button at the top right comer
of the dialog (note the dark ring around the button). If you use this
option right now~ you will be returned to the PersonInfo window
and all records will be accessible. Instead, let's continue building a
query with QueryBuild.

The first field in the Field to Search box - FirstName should already be selected. If not, select it now by
clicking on it once.
This tells Reflex which of the three existing fields you want it to
search through. QueryBuild offers a range of operators which you
can use to fine tune your file queries - notice that the radio button
next to the word "Equal" is selected as a default.
Clicking on any of the other operator radio buttons will make them
active. Right now, you don't need to change this.

Notice the Value to Find box, it already contains a
flashing text insertion point cursor. Enter a first name "Patricia" (without the quotes).

24

Finding Information

Enter qualification for the record(s) desired.
Field to Search:
FirstName
LastName
BirthOate

Operator to Use:
@ Equal
0 Not Equal
0 Less
Less Or Equal
Greater
Greater Or Equal
Starts With
Includes

o
o
o
o
o

nil )

( Find

( Cancel)
( HelP)

[

fiNO)

(

Of!

)

(

OK

)

I[

ENTER

B

I

Ualue to Find: Patricia

This tells Reflex the contents of the FirstName field you are
searching for. Notice that the Enter button is now the default button
(i.e. the most likely next move is to actually confirm the text you
have entered so that QueryBuild can start to create a relevant query
for you).

Click on the Enter button.
Enter qualification for the record(s) desired.
Field to Search:
FIt"stName
LastName
BirthOate

Operator to Use:
@Equal
0 Not Equal
0 Less
Less Or Equal
Greater
Greater Or Equal
Starts With
Includes

o
o
o
o
o

( Find

nil )

( Cancel)
( HelP]

(

nNO

)

(

OR

)

I(

OK

B

( [N1IH )

Ualue to Find:

rrstName = "Patricia"
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Your completed qualification is now displayed at the bottom of the
dialog box. With this simple query, only those records with
FirstName fields that exactly equal your search value will be located
and displayed for you. Case does not matter for searches; if you
specify "Fred" Reflex won't find "Freddy" or "Alfred", but it will
find "fred" or "FRED". To actually put the query into action:

Click on the OK button.
The QueryBuild box disappears. Reflex then finds the first record
that meets the current qualification and displays it in the Personlnfo
window. Earlier we used the First, Last, Next and Prior Record
commands in the Search menu to move through a complete file.
Now that we have asked Reflex to find and display only those
records that meet the qualification, the record commands have the
following effect:
• First Record displays the first record that meets the current
qualification.
• Last Record displays the last record that meets the current
qualification.
• Prior Record moves one qualified record nearer to the first record
that meets the current qualification, skipping those that do not.
• N ext Record moves one record nearer to the last record that meets
the current qualification, skipping those that do not.
Notice the Formula panel towards the top of the window. Reflex has
automatically pasted in the qualification you created via the
QueryBuild dialog. If you want to change the qualification you can
use the QueryBuild option once again, or you can edit or replace the
contents of the formula panel directly.
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Finding Information

Go to the formula panel and select the word "Patricia" as
you would any other Macintosh text.
•

File

Edit

Format

Describe

Edit

Format

Describe

Database

Search

Misl

Type: Mark
•

File

o
l j FirstName

Database

Person Info
IIFirstName ="Mark"

Search

Mis
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Fi rstName lPatri ci a
.
Las t Nam e ~'M:i:'~:h"~:~"r~'::::::::::::::::::::::::::::::::::::::::::::::::::::::::i

Bi rt h Date
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Data Entry

Patricia has now been replaced by the word Mark. You have directly
entered a new qualification in the Formula Panel without having to
use QueryBuild. (Note that space characters are not changed to the
"_" character when you enter text in the fonnula panel.)
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Go to the Search menu and select First Record (or use
the OOF shortcut).
•

File

Edit

Format

Describe

Database

Search

Mis

The record containing the first name Patricia is no
longer displayed. Instead the first record containing the
name Mark appears. Nothing has happened to the
"Patricia" record - it is just no longer displayed. Use the
First, Last, Next, Prior Record commands to see what
other records have been found by Reflex.
• If you need assistance in creating a database query select Search
On .•. in the Search menu to invoke the QueryBuild feature.
• If you want to enter your database queries directly, click in the
fonnula panel and use standard Macintosh text entry and editing
methods.

• Alternatively, choosing the Edit Record Qualification option
from the Search menu places the text cursor in the Fonnula panel or
selects text previously entered in the panel.
It is likely that you will find yourself using a mixture of entry
methods while learning about Reflex's many database file search
features.

Since Reflex uses the existing qualification to decide which records
it will display, you must delete any such qualification from the
fonnula panel when you want to have access to all the records in a
file. There are three ways to do this.
• Go to the Search menu and select the Find All option.
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• Select the qualification in the formula panel - with the cursor, or
via the Edit Record Qualification option from the Search menu and press the Backspace key or use the Cut or Clear option from the
Edit menu.
• Click on the Find All button from within the QueryBuild dialog
after accesssing this dialog by selecting the Search On ... option
from the Search menu.
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Producing
Simple Reports

Database files are what hold your information - where you enter and
edit information and carry out simple searches for specific records.
When you wish to produce a detailed listing of the information in a
file or a set of files (a database) you will need to design a Report.
Reports also allow you to perform powerful calculations, and create
search formulas that can cope with many complex conditions to find
information in one file, many files, other reports, or even the current
report itself.
The process of producing a report can be as simple or as complex as
you wish. Keep in mind the purpose of the report - is it a simple
name and address list, is it a business report (such as a profit and
loss statement), or is it a very detailed breakdown of services given
and money owed?
Although all reports are equivalent in that they can be customized as
much as desired, Reflex offers a ready-made report format; the
Table-Style Report.

• The Table-Style Report on a Database File: The TableStyle report is a straightforward listing of the contents of a single file
where each record is listed as a row of fields on the Macintosh
display. The default style is that every selected field of every
selected record in a database file is displayed within what is known
as a Repeating Collection.
In brief, a Repeating Collection is the mechanism used to obtain a
specific view of the records within a file.
• If there is no qualification, the repeating collection will retrieve all
records in a named file.
• If the qualification asks for records where the last name is
"Johnson" then only those records with a LastName field equal to
Johnson will be displayed (see content pages and index for location
of more specific information on this topic).

Reflex provides automated methods of choosing the fields that will
be displayed and, by using query formulas, the records that will be
displayed. You have full access to Reflex's retrieval formulas. If
you wish, you can also customize the format of a Table-Style report
so that it no longer appears as a row of fields.
If you do not wish to use a table-style report, you may create a
custom report from scratch.
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Producing Simple Reports

• A Report which you design yourself: This type of report
is totally freeform - there is no default format. Fields from any file
can be placed anywhere within the report. You will have full access
to Reflex's query formulas, and this is the type of report where you
will start to make full use of Repeating Collections.
As you become more familiar with Reflex you will find it easier to
decide which type of report will be most useful to you. For now,
let's use the table-style report.

Go to the File menu and choose New Report.
A dialog box will appear that offers three report options.
Choose one of the following ways to make a new report:
Table-style report on "Person Info"

( Option 1 )

Table-style report on another Database File

( Option 2 )

R report which you design yourself

( Option 3 )

K Cancel

n

You can get a table-style report on the currently selected file
(PersonInfo); you can get a table-style report on another file; and
you can display a blank report with which you create completely
freeform reports.

Click on the Option 1 button to produce a report on the
PersonInfo database file.
Another dialog will appear where you can select the fields you want
to include in this report. The first field of the current file - FirstN arne is already selected for you.
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Choose Report Fields from the List of Fields below.
Report Fields:
List of Fields:
Fit stName

LastName
BirthDate

I(

OK

))

Cancel

Options available to you are:
• Select each field by clicking on it in the List of Fields box and
then click on the Include button. This will place the chosen field
name in the Report Fields box. The order of the fields in the
Report Fields box dictates the order in which these fields will appear
in the report. Clicking on the OK button will continue the report
procedure. Clicking on Cancel will make the dialog go away and
end the report procedure.
• All fields may be included in the report by clicking on the

Include All button. Clicking on the OK button will continue the
report procedure. Clicking on Cancel will make the dialog go
away and end the report procedure.
• If you have done either of the above actions in error, you can
remove all the Report fields and start over again by clicking on the
Clear All button.

Click on the Include All button.
The three existing field names will appear in the Report Fields
box to the right of the dialog.
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Choose Report Fields from the List of Fields below.
Report Fields:
list of Fields:
FII s tName
FirstName
LastName
LastName
!Hm ,...-_ _ _-.. BirthOate
BirthOate

III!:.::::::II:l

I
(}

I(

OK

))

Cancel

If everything looks correct, click on the OK button.
The QueryBuild dialog appears in order to let you specify which
records you want to include in the report; you will want all of them
so just click on the Find All button (you can also hit the Return key
since Find All is the default button).
A standard file dialog will now appear asking you to supply a name
for the report.

Type: BirthdayList
To produce the report, click on the Create button
The table-style report will now appear in a new report window (in
some cases it will be necessary to use the window scroll bars to
move around the form and see all of a report). Notice that the
records are automatically sorted by the FirstName/LastName key
that you set up earlier.
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The Report window contains:
• The name panel and formula panel like those that appear in data
entry form windows.
• The status icon in the top left comer which currently has an X
mark inside it indicating that this is an unsaved report.
• Labels above each column identifying the contents of that
column.
• A row for each record in the Personlnfo database.
• A box with thick vertical bars (handlebars) on each side that
surrounds the records; this indicates the Repeating Collection
mentioned earlier.
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Click on the vertical gray handlebar down the left of the
displayed records.
"

File
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Fonts

Style

Window

BirthdayList

II

I
As you click on the gray handlebar, the repeating collection will be
selected and tum black.
"
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BirthdayList

IIPe~sonlnfo

Also, if you look in the fonnula panel you will see the name
PersonInfo has now appeared there. As explained earlier, a
repeating collection is the mechanism by which you can obtain a
specific view of the records in a file. By clicking on the current
repeating collection we can see the name of the file that it will view
for us. The actual fields that appear within a repeating collection are
selected by you - you earlier told Reflex to include all fields in this
table style report.
Later, you will see how to change the name of the file on which a
repeating collection will provide a view. For now, let's see what we
can do to customize the report that we have already produced.
Perhaps instead of arranging a birthday list by name you would
really want to have the records appear in order of birthdate.
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If the repeating collection is not selected, click on it to
select it once again.
The gray handlebar should tum black as it is selected. Make sure
that you have it selected correctly.

Go to the Report menu and choose Sort On Fields...
"

-0
~

File

rl

Describe ~ Fonts Style
Dir Calculate
88
IIPersonlnfo
............................................................····1

Edit

Format

Window

11 • • 11 •• iI [I III

A dialog appears asking you to select the fields on which to sort and
the order in which the records should be sorted.

If it is not already selected, select the BirthDate field
and click on the A... Z,O••• 9 button to sort in an
ascending order (the Z.. A,9...0 button is used to sort in
a descending order).
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The chosen field name will appear in the Sort Fields box to the right
as shown below.
Choose Sort Keys From the List of Fields Below
Fields
Sort Fields
FirstName
(a) BirthDate
LastName

~

ButhOate

I(

OK

))

I

Cancel

Click on the OK button.
The BirthdayList report will reappear.

To sort it by birthdate go to the Report menu and choose
Calculate or use the 00= key combination as a shortcut.
The report is now rearranged in ascending order by the contents of
the BirthDate field.
•
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When a table-style report is first created, it is automatically
calculated by Reflex. Whenever you make changes you must
recalculate the report with the Calculate option or the 00 = shortcut.
You can choose any field, or group of fields, to sort on in a report it does not have to be one of the key fields. It can even be a
computed field (a field which will display the sum of a specific
report column or a group of fields, for example).
In addition to changing the order of records in the report you can
also change the number of records that appear by using Reflex's
formulas. Currently, the table report contains all the fields from all
the records in the Personlnfo database. Let's use QueryBuild once
again to list only those records of friends with a birthday after 1959.

Select the current report's repeating collection by
clicking on the gray vertical handlebar that appears on
either side of the displayed records.
The gray lines will tum black to indicate that they have been
selected.

Go to the Edit menu and select Paste Query.
Format

Describe Report Fonts
:·:1 rthdaylist

Style

Window

A standard file dialog will appear asking for the name of the
database file you wish to report on.
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Select Personlnfo from the file list. Click on the Show
button.
After you have supplied the name and clicked on the Show button,
the QueryBuild dialog will appear. Notice that the file name that you
have just selected - Personlnfo - has been automatically entered in
the display area at the bottom of the QueryBuild dialog, along with
the word "WHERE".
Enter qualification for the record(s) desired.
Field to Search:
FirstName
LastName
BirthOate

Operator to Use:
@ Equal
Not Equal
Less
Less Or Equal
Greater
Greater Or Equal
Starts With
Includes

o

o
o
o
o
o

o
Ualue to Find:

((Find All ,
( Cancel)
(

HelP)

(

HNO

)

(

Of!

)

(

OK

)

( [Nn:H )

I

renOnlnfO WHERE

The query "Personlnfo WHERE" tells Reflex that you are interested
in finding some records in the Personlnfo file WHERE they meet
some specific qualification. The query is not complete, however,
since you still need to supply the record qualification.
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To find all those friends that have birthdays after 1959:

Select the BirthDate field in the Field to Search box.

Field to Search:
FirstName
LastName
BirthDate

This tells Reflex which field you are interested in searching.

Select "Greater" from the Operator to Use list by
clicking on the radio button alongside it.
Enter qualification for the record(s) desired.
Field to Search:

Operator to Use:

0
0

FirstName
LastName
BirthlJate

111,11

Equal
Not Equal

!1i;~1~ :~ : ~ual
o ~ n{~~ud(~~

This tells Reflex the type of operation you want it to perfonn on the
chosen field.
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Enter the date value shown below in the Value to Find
box.
Enter qualification for the record(s) desired.
Operator to Use:
Field to Search:
FirstName
lastName
Bit thlldte

(Find All )

0
0

( Cancel)

o
o
o
o

( HNO

)

(

Of!

)

(

OK

)

Equal
Not Equal
less
less Or Equal
@ Greater
Greater Or Equal
S1<lrh WHh
I !H~lud(~~

o

( HelP)

I(

ENTER ))

Ualue to Find: 112/31/59

IPersonlnfO WHERE

(You could, of course, also use 1/1/60 as a value to find and the
"Greater or Equal" operator.)

Click on the Enter button.
The complete query, which appears in the large display area at the
bottom of the QueryBuild dialog, tells Reflex that you want all
PersonInfo records where the birthdate field has a value greater than
12/31/59 - in other words, all those records that contain birthdates of
1960 and above.
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It is important to note that date values can be used in formulas only
if they are indicated as date constants by preceding them with the
"@" symbol; this distinguishes them from straightforward numbers
separated by the "/" division sign.
For example:
• the formula @ 12/31/59 is equivalent to December 31, 1959.
• the formula 12/31/59 is equal to .0065609622 .....

Enter qualification for the record(s) desired.
Operator to Use:
Field to Search:
FirstName
LastName
BirthOate

(Find All )

o Equal
o Not Equal
o Less

( Cancel)
(

Help]

o Less Or Equal

(

AND)

@ Greater
Greater Or Equal

(

OR

)

I(

OK

)1

o
o S1.:wh WHh
o !ne!udeiUalue to Find:
Person I nfo WHERE BirthDate > @ 12/31/59

If everything looks correct, click on the OK button. The
BirthdayList report window will reappear.
Notice that QueryBuild has automatically pasted the completed
record qualification into Personlnfo's formula panel.

Use the 00= shortcut to recalculate"the report.
A new report, including only those records where the BirthDate field
has a value greater than 12/31/59 will appear.
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You can modify this query formula as much as you want after
selecting the repeating collection again and calling up the QueryBuild
dialog via the Paste Query option in the Edit menu. Or, you can,
after selecting the repeating collection:
• Go to the Report menu and choose the Edit Formula option or
the OOQ shortcut. This places the cursor at the left-hand side of the
formula panel if it is empty, or selects the whole contents of the
panel if it contains text.
• Click directly anywhere within the formula panel and edit the text
as you would any Macintosh text.
Other example searches you might like to try are:

Example 1:
List all records that have a last name that starts with the letter fiR".
It's useful to learn how to build this type of query formula for two
reasons. You may not always know the exact spelling of some
textual information you wish to display. Or you may wish to list a
group of records that have something in common.

• Step One: Click on the repeating collection and select
Paste Query from the Edit menu. A standard file dialog
will appear asking you to select the file to search. When
you have selected Personlnfo, click on the Show button
• Step Two: The QueryBuHd dialog will appear. Click
on the LastName field that appears in the Field to Search
box.
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• Step Three: Click on the radio button alongside the
Starts With operator in the Operator to Use column.
• Step Four: Enter the letter "R" (without the quotes)
in the Value to Find box and then click on the Enter
button.
• Step Five: If everything looks correct, click on the
OK button.
The formula panel should appear as:
•
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Fonts

Style
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BirthdayList
II Person Info WHERE STARTS(LastName,"R")

~ rl

FirstName

BirthDate

LastName

lIc:::t 0\)0

!n!"o •• o!"

Again, there is the name of the database file followed by the word
WHERE and then a qualification. In this case, the qualification
includes the STARTS function name since you want to display onl~
those records that contain a LastName that starts with the letter "R"

• Step Six: Recalculate the report with the 00= shortcut.
After calculation, the report should appear as below:
•
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Example 2:
List all those records that have a firstN arne of Mark and a birthdate
after 1948:

• StepOne: Click on the repeating collection and select
Paste Query from the Edit menu~ A standard file dialog
will appear asking you to select the file to search. When
you have selected PersonInfo, click on the Show button.
• Step Two: The QueryBuild dialog will appear. The
FirstName field should be already selected in the Field
to Search box (if it isn't, just click on it).
• Step Three: Make sure that the radio button
alongside the Equals operator is selected.
• Step Four: Type in the word "Mark" (without the
quotes) in the Value to Find box and then click on the
Enter button. The query formula thus far, will be
displayed at the bottom of the dialog.
• Step Five: Notice that among the buttons on the
right side of the QueryBuild dialog are two marked
"AND" and "OR". These are used to join multiple
qualifications together into one cohesive query formula.
Click on the" AND" button. Notice that the word AND
appears at the end of the currently displayed query
formula at the bottom of the dialog.
• Step Six: You are now ready to complete the query
formula. Click on the BirthDate field in the Field to
Search box. Make sure that the radio button alongside
the Greater operator is selected.
• Step Seven: Type the date value 12/31/48 and then
click on the Enter button. The completed query formula
appears at the bottom of the dialog.
• Step Eight: If everything looks correct, click on the
OK button.
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The fonnula panel should appear something like below (you may
have to resize the fonnula panel see all of the fonnula at once):
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fo WHERE FirstName = "Mark" AND BirthDate > @ 12/31/48
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Mark

LastName
Roberts

BirthDate
2/13/48
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Recalculate the report and it should appear as below:
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Up to now we've been selecting complete records - that is, we have
not changed the number of fields that are displayed. This is not
difficult to do.

Select the repeating collection. Go to the formula panel
in the report window and make sure that it only contains
the word:
Personlnfo
Edit the text as necesssary to ensure that this is the only word in the
fonnula panel.
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Next, go to the Report menu and select the Design option.

Edit

N<mH~

Pro1 (~( t Obj~~e1
PFotect Report
[Hport Data ...
Show Header
Show Footer
II""Display
Design

Notice that the Display option currently has a check alongside it to
indicate that this is the current activity. Further visual confinnation is
given in the activity indicator at the bottom left of the report
window. It contains the phrase:
• "Report Display" while infonnation is displayed

IRe port Dis P1ey I¢ I
• "Report Design" when you are making changes to the report
design.
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Having selected the Design option the activity indicator should now
read "Report Design" and the report window should appear as
below:
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Note that the blank repeating collection and the fields that it contains
are a Design Template - it shows how each repeating collection
record will be presented when you actually calculate the report with
the Calculate option in the Report menu or use the 00= shortcut.

Click on the first field under the title FirstName.
The field is now selected (black) and the name of the field will
appear in the name panel. As mentioned earlier, a repeating
collection only gives a view of the records within a file - it is the
fields within the repeating collection that control which fields from
each record will actually appear. We can test this by deleting a field
from the report.

With the Firstname field selected, go to the Edit menu
and choose Clear.
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The FirstName field will disappear from within the repeating
collection (note that its label remains since the two objects are not
dependent on one another). You could calculate the report right
now, but it would still have the heading for FirstName and the
repeating collection would be unnecessarily wide (it is now easier to
see the gray, box-like shape of the repeating collection since there is
a blank space where the FirstName field used to be).

Select the FirstName label by clicking on it anywhere.
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Go to the Edit menu and choose Clear.
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To show that objects in reports may be moved around
freely: Click on the LastName label. Then, with the
Shift button pressed, click on the BirthDate label and the
two remaining fields.
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Release the Shift button. Click anywhere on the selected
objects and, with the mouse button still depressed, move
the objects slightly to the left.
The fields and labels will suddenly float freely within the report,
keeping track of every move you make with the mouse.
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Move the four objects to the left until they meet the
vertical gray handlebar of the repeating collection and
then release the mouse button.
"
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Any number of objects in a data entry layout form or a report may be
selected for movement using this Shift-Click technique.
You could go ahead and calculate the new report now, but there is
some empty space to the right of the BirthDate field that you might
want to remove. This is no problem since you can resize repeating
collections much as you would an ordinary field or label.

Select the repeating collection by clicking on either of
the handlebars. A small white resize box will appear at
the bottom right corner of the gray repeating collection.
Place the cursor over it and keep the mouse button down
as you drag the corner to the left.
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As you move left, a ghost image of the repeating collection will first
appear and then shrink in size as it keeps step with your movements
of the mouse. When the ghost image is just big enough to contain
the two remaining fields, let go of the mouse button; the repeating
collection will now be smaller.
•
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If it is not quite the right size, just follow the same procedure until

it is acceptable.
• You cannot make a repeating collection smaller than the field(s) it
will contain - any attempt to do so will first result in an audible error
signal and then, on a second attempt, a dialog which states:

Objects in a form may not olJerlap.

I(

OK

)1

When the repeating collection and the fields are correctly
positioned, go to the Report menu and choose Calculate
or use the 3fb shortcut.
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Now you have a report which contains only the last name and birth
date of each friend - the first name field is not displayed because of
the design changes you made.
Any report can be modified in this way. The only limits are:
• The repeating collection must be asked to query an existing
database.
• Any formula you enter must conform to the valid formula syntax.
If either of these conditions are not met, you will receive a relevant
error message.

Once you have produced a satisfactory report, you can save it to
disk for future use or you may print out a copy by going to the File
menu and selecting Print.
• If you save a report to disk, you are in fact only saving the design
template. When you open a report again you must recalculate it; this
ensures that each report will include only the most up to date
information.

Before you do any printing, however, you should get to use a few
more features of Reflex.
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Rearranging
Fields in Fires

There is one very important topic that should be covered before
moving on to upgrade the Birthday/Personlnfo database file design
into something a little more practical - it has to do with the way in
which fields, and especially Key fields, can be ordered in a file
image.
You may have noticed that when you used the First, Last, Next and
Prior Record commands with both the Birthday and Personlnfo
files, the order in which records appeared was based on a person's
first name. Also, when you created a default format report on the
Personlnfo file the records were again presented primarily in first
name order (with first name sort conflicts being resolved by means
of using the sort order of the last name). To obtain a different sort
order you had to use the Sort on Fields ... option in the Report
menu.
While this arrangement may suffice for a personal birthday file,
there is another way to design the database file so that records can be
browsed through and sorts can be performed in a more sensible
fashion: You must arrange the Key fields in the order "LastName"
and then "FirstName".
Currently, you should have both the BirthdayList report window
and the Personlnfo data entry windows open (check in the Window
menu). Before making any design changes to the Personlnfo file
image it is neces~ary to close the associated data entry window - but
since you won't be needing the BirthdayList report window again
we can remove it as well.

Go to the File menu and choose Close All Documents.
This will close the BirthdayList report window and the Personlnfo
data entry window. The Overview window will become the active
window. The image of the Personlnfo file is now easy to see.
Reflex allows you to move fields around inside the file image box.
To experiment with this feature:

Click on the LastName field.With the mouse button still
held down, drag the field downward until it is slightly
below the BirthDate field.
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LJ

Personlnfo
Fi rstNeme

Don't worry that the field's ghost image might move beyond the file
image box, just let go of the mouse button when the LastName field
is correctly positioned. As soon as you let go the LastName field
assumes its new position below the BirthDate field (the BirthDate
field moves upwards one place). Notice that the LastName field has
also lost its status as a Key Field.

• If you move a non-Key field above an already existing Key field,
the non-Key field will automatically be converted into a Key field.
• If you move a Key field below a non-Key field, the Key field will
automatically be converted into a non-Key field.
• If you move a Key field just above or below another Key field, it
will remain a Key field.
• If you move a non-Key field just above or below another nonKey field, it will remain a non-Key field.

You now want to make the LastName field the top-most Key field.
First click outside of the file image to deselect the
LastName field (if you do not do this you will only end
up selecting the field text itself). Then reselect the
LastName field and move it above the FirstName Key
field.
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[XI

Person Info

FirstName
BirthDate
You may find that the first time you try this that the field doesn't
drop into the correct position - simply pick it up again and make
sure that you place it clearly above or below the relevant field(s).
Note that the LastName field is now underlined, indicating that it has
once again become a Key field.

Confirm the new field order by going to the File menu
and selecting Save Design.
Shortly, the X mark will disappear from the status icon in the
PersonInfo file image, indicating that the design change has been
saved.
To see the effect of making the LastName field the top-most field:

Open the Personlnfo file by double-clicking on its name
bar.
"
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Clearly there is a major difference - the first record displayed is for
Frank Barrett, whereas it was previously a record for Barbara
Jackson.

Use the First, Last, Prior, Next Record commands to
see the other records.
Also, even though you have changed the order of the fields in the
Overview file image, the fields -in the data entry form are still in the
original FirstName, LastName, BirthDate order.
• The Tab or Return key still moves in the usual left to right, top to
bottom order.
• Any new fields inserted in the file image (as opposed to just reordering present fields) are added at the bottom of the relevant data
entry form.
• Changing the order or number of fields in a file image does not
affect the order of fields or the way fields are tabbed to in a data
entry form.
If you wish to have the fields in a data entry form arranged
differently to the default provided by Reflex (Le. you want to place a
new field at the beginning or in the middle of the data entry form),
you can select Form Layout from the Database menu and make any
allowable change.

Any Table-Style report on the new PersonInfo database file will be
sorted by LastName and then FirstName unless you specify
otherwise.
The value of placing Key fields in a specific order may seem
minimal when we are talking about a simple birthday file. However,
as you begin to develop more and more sophisticated databases, the
need to have the most efficient design possible will become
apparent.
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The Employee
Database

In the introduction to this first section, the Birthday/PersonInfo file
was described as being a simple example. We can, however,
redesign it to be much more useful - we can tum it into a fairly
detailed personnel file that could be used to store information on
company employees.
Currently, you should be able to see the PersonInfo file image and
its data entry window.

Remove the Person Info data entry window by clicking
on its close box at the top left corner.
The PersonInfo file image should now be selected (black); if it is
not, just click once on the name bar, or on the last field in the image.

Go to the Overview menu and choose Insert Field.
Just as before, a space for a new field appears underneath the lowest
existing field.

Personlnfo

Type: Address
After entering the name, press the Return key, which is
the shortcut method of inserting a new field space in a
file image.
Type: City
As you can see, it is not difficult to add fields to an existing file simply insert a new field space and enter the name of the field you
wish to include in the file. If you make any typing mistakes before
asking for another new field, simply backspace.
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The Employee Database
To clean up errors spotted after the field has been entered:
• Select the field, go to the Edit menu and choose Clear. Retype the
correct field name.
• Alternatively, select the field and then select part of the fieldname
as you would any other Macintosh text and just retype the correct
information.
To save you time and effort, there is an almost complete employee
file - called Employee - provided on disk. You could now save the
changes that you've just made to the Personlnfo file, but instead
let's use Reflex's revert option.

Go to the File menu and select Revert to Old Design.
.
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A dialog will appear asking you to confirm that you do indeed wish
to revert to the last saved database file design.
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If you select Reuert, you will lose all Database
design changes since the last time design changes
were saued.

If

Reuert

II

Cancel

Click on the button marked Revert.
When the X mark disappears from the status icon this indicates that
all changes to the original file structure have been discarded and the
file image is now exactly as it had been before the addition of the
Address and City fields. You can now remove the file image by
clicking on the status icon in the file image - this has the same effect
as clicking on the close box of a window.

Next, go to the Overview menu and select Show
Database File. When the standard file dialog appears,
locate and select a file called Employee. Click on the
Show button.
This will place an image of the Employee file in the Overview
window.
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The Employee Database
Notice how the first three fields have the same names as those in the
PersonInfo file you were working with earlier.
Additionally, we have fields for:
• Address, City, State, Zip, and JobTitle: These are Text
fields.
• Salary: This is a Number field.
• Employee#: This is a Sequence field.
Use the field type options in the Describe menu to verify
these field types.
Specifically, notice that the Sequence field option in the Describe
menu has a check mark next to it when the Employee# field is
selected, but the option is not actually available - it is gray. (In fact,
the Sequence Field option is gray - but it has no check mark - when
the other fields in this file image are selected).
• This is because you can only have one Sequence Field per
database file; Reflex will automatically increment the Sequence value
as new records are entered, and/or you may select particular values
for one or more records.
When we were just dealing with a few friends in a simple birthday
file, we didn't have to worry too much about more than one person
having the same name. In an employee file, where there may be
records for hundreds of people, the chance of such an event taking
place is much higher. To avoid conflicts we need to use a new Key
that will ensure that every record can be uniquely identified.
Considering the various fields to choose from, we can see that one
very good Key would be the Employee# field - every employee has
a unique number. You could use others, but let's use it here.
Select the FirstName field. Go to the Describe menu and
choose Non-Key Field.
The underline disappears from the FirstName field and the field
moves just below the LastName key field.
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Select the LastName field. Go to the Describe menu and
choose Non-Key Field.
The LastName field is no longer a key field. Now make the
Employee# field a key field.

Select the Employee# field. Go to the Describe menu and
choose Key-Field or use the OOK shortcut.
The Employee file image should now look as below:
•
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Note the "X" mark in the status icon - it indicates that changes have
been made to the design of this database file.
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Double-click on the Employee file's name bar in an
attempt to open it.
Since you have made some major changes to the file structure,
Reflex will now display a dialog asking if you want to save the
changes or cancel the open process:

There are Design Changes that affect this
Database File. They must be saued before
this document can be opened.

I(
(

Saue Changes

))

Cancel open)

Click on the Save Changes button.
After saving all changes, Reflex will then open the Employee file.
The Employee file already contains a number of records which can
be viewed, reported on or, if you wish, changed (but don't change
them yet). First, notice how the Employee# field is at the bottom of
the data entry form even though you placed it at the top of the file
image in the Overview window. The FirstName field is at the top of
the form and above the LastName field although this was changed as
well.
• As mentioned in the last chapter, changing the order or number
of fields in a file image does not affect the order of fields or the way
fields are tabbed to in a data entry form.
Although you can leave the form as it is, this does present an
opportunity to find out how to redesign a data entry form.
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Redesigning Data
Entry Forms

Go to the Database menu and select the last item - Form
Layout.

FirstName .Jo,jnna
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Copy Record
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The data entry form window now switches to a Form Layout
window.
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Redesigning Data Entry Forms

There are a number of visual clues as to the switch:
• Field data is no longer displayed.
• Grid lines, to be used in accurately positioning objects in the data
entry form, are shown as a default (they can be turned off via the
Hide Grid option in the Format menu).
• The activity indicator, at the bottom left comer of the window,
now reads "Form Layout" as opposed to "Data Entry".
• Also, the Database menu has now been replaced by the Layout
menu.
When you are working with a Layout window, you can make
simple changes (such as changing the contents of a label), or you
can radically alter the form design (by adding and deleting labels and
pictures). With the Employee form, all you will be doing is
changing the contents of a few labels, resizing some fields, and
taking the Employee# field from the bottom of the form to the top.
Double-click on the FirstName label and place the text
insertion point between the "t" and the "N" characters.
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Q

65

Press the space bar to insert a space character between
the two characters.
•

File

Edit

Format

Describe

Layout

Fonts

Style

W

Employee

II
Firs t Name L::::::::::::::::::::::::::::::::::::::::::::...................................,
LastName. ~
Bi rt hDate

Addrceist~

.

'1mri

~i~i~i

r::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::':::':::::::::::::::::::::::::::::::::::::::::::::::::::::.::::::::::] .. i ....... : . .

:t:J ~:::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::i

,~

~

;
; .
. .!. . ,I. . ... ,i ,1:. . ,.1. .
St a te i::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::"'::::::::;' .: .......... .
ZiD'(:::::':::::::::::::::::::::::::::'::::::::::::::::::::: :::::::::::::::::::::::;:

:

..

,i: . . .

II!I!I

Select the LastName, BirthDate, and JobTitie fields in
turn and insert a space in each so that the form looks as
below:
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Layout

Fonts

Style
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Employee
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II
First Name
Last
Birth Date

Sal a ry

~=~=~~=~~========~
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Notice that even though you change the labels, the actual name of
the associated field does not change (check this by selecting a field
and looking in the name panel at the top left comer of the window).
• Fields and labels are independent - Reflex merely provides a
default label based on the field name supplied in a file image. You
may change a label (or any other default form design feature for that
matter) by switching into a Layout Form window anytime you need
to.
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Next, select the BirthDate field by clicking on it once.
•
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Style
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Employee

~ BirthDate
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This field is too large for a birth date value, so let's reduce it.

Move the cursor over the small white resize box at the
lower right corner of the selected field.
•

File

Edit

50

Format
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Layout

Fonts

Style

n

Employee

Ej Bi rthDate /I
First Name t... ................................................................................!:

j

IQ

• • ··.~:~:;:~~~.~~~~~~-~~-~~~~• • • •I
With the mouse button. held down, drag the resize box to
the left - it will follow every move you make with the
mouse. Let go of the mouse button when the field looks
something like the one shown below.
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Select and resize the rest of the fields shown below
(State, Zip, Salary and Employee#) in the same manner.
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So far, you've changed some labels and resized some fields. The
next step is to reposition the Employee# field at the top of the dataentry form. (There is no sp~cial reason why you have to do this; it is
just being included as a practice task.)

Since you will be moving fields around, it is a good idea
to give yourself some extra room by making the
Employee layout window larger (at least make it a little
deeper). Just use the Employee window's resize box at
the bottom right corner as you would with any other
Macintosh window.
Once you have done this, you will need to make a space at the top 0:
the data entry form to place the Employee# field.

Select the First Name label by clicking on it once. Make
sure that you do click once - otherwise you will select
the label text only rather than the whole label itself. (If
you run into problems, just click anywhere else on the
form and then reselect the First Name label.)
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Then, with the Shift button held down, click once on
every other field and label in the form until they are all
selected (black).
•

File

Edit

Format
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............ .

Now that all the fields and labels have been selected, you can move
them, all at once, to another location.
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Place the cursor on the last field - Employee# - and,
with mouse button held down, drag the fields toward the
bottom of the window.
-'
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De9cribe
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Click anywhere on the form to deselect all the fields.
"
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~
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Now select both the Employee# label and field by using
the Shift-Click technique just described.
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Finally, keep the cursor over the Employee# field and
hold down the mouse button. With the button still
depressed, move the label and field to the new position
at the top of the form.
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At this point, you could return to data entry activity, but there is
another type of design change you should make to this form.
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Select the BirthDate field and then choose the Display
Format option from the Format menu
•

File
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First Nam
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After selecting Display Fonnat, the following dialog will appear.
•

File

Edit
r.

@ Short Date Format

o Long Date Format

o Abbreuiated Date Format
EHample

~F_or_m_L_a~yo_u_t

[(

OK

II

Cancel

12/31/84

________________________~~-----

Currently, the BirthDate field is set to display date infonnation in the
short month/day/year fonn - an example of this is included in the
dialog. Let's change this so that BirthDate entries will be displayed
in the Abbreviated Date fonnat.

72

Redesigning Data Entry Forms

Click on the radio button next to "Abbreviated Date
Format" and then click on the OK button.
•

File

Edit

o Short Date Format
o Long Date Format
~Rbbreuiated
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Date Format

II

OK

I

Cancel

))

Dec 31,1984

...............................
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You have just set the display fonnat for the BirthDate field. Before
you see the effect of this change, let's make sure that the Salary field
is displayed in the correct dollar fonnat.

Select the Salary field and then choose the Display
Format option from the Format menu.
A different display fonnat dialog will appear.
•

File

Edit

@General

o Decimal
o Scientific

t

OK

II

[ (ancel

o Dollars
o Percent

I_I Digits to the right of the decimal point (0 to 15)
o

Format with commas
EHample
12345.61
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Click on the radio button next to "Dollars". Then enter
the number "2" in the box just below the last radio
button - this ensures that only two digits (the cents
value) will appear after the whole dollar amount. Click
on the OK button.
II File Edit

o General
o Decimal

o Scientific

II

OK

I

Cancel

11

~Dollars

a Percent

D

Digits to the right of the decimal point (0 to 15)

D Format

with commas

EHample

$12345.67

Now you can see the effect of the two display format changes.

Go to the Layout menu and select Data Entry.
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Selecting Data Entry from the Layout menu switches the layout
window back to a data entry window and displays the first record in
the file. Note that the grid lines are gone, and you now cannot select
the field labels or make any other major design changes.
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You have now made some major changes to the original Employee
file.
• The database file Key has been changed from FirstName,
LastName to the Employee# field.
• Some labels have been reformatted.
• Some fields have been resized.
• The Employee# label and field were moved to the top of the data
entry form.
• The default display formats of the BirthDate and Salary fields
were changed.
In addition to the above changes, you could have:
• Moved individual fields and labels, or groups of fields and labels,
to any position on the form.
• Made the data entry form look like a form you currently use for
recording data (by pasting in a form design created with any
Macintosh graphics application).
• Changed the font and font size/style of labels and/or fields.
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• Displayed the values within the fields differently. There are
options for positioning field contents Left, Right and Center in the
Format menu.
• You could have also created a "comments" type label which can be
of variable size (depending on how much text you wish to enter) and
which may provide appropriate guidance for the person doing data
entry.
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Reporting on the
Employee
Database

Some example reports you may wish to produce from the Employee
file using QueryBuild or direct formula panel entry are given below.
Unlike the earlier examples given in the section on producing simple
reports, the reports shown here demonstrate how you can sort
information in any order you wish - you are not constrained by the
order of records in the database"file itself.

Example 1:
• List records of all employees by the Employee#,
LastName, and salary fields only. Sort by salary.
To do this:

Go to the File menu and select New Report.
A dialog will appear asking what type of report you wish to create.

Select the first option - A table-style report on
"Employee" .
Another dialog will then appear asking you to select the fields to
include in the report.

Select the Employee#, LastName, and Salary fields in
that order, "including" them in the report by clicking on
the Include button after each selection. When all three
fields have been included in the Report Fields box to the
right of the dialog, click on the OK button.
At this point, Reflex will display the QueryBuild dialog, in order
that you may specify which records in the current database file you
are interested in seeing. You'll want to see all of them at this point
so:

Click on the Find All button at the top right corner of
the QueryBuild dialog.
A standard file dialog will appear.
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Enter the name of the report you wish to create (if the
name is already taken by another document, you will be
notified of this). Click on the Create button.
The report (here named EmployeeRep) should appear as below:
Ii File Edit Format Describe Report Fonts Style Window

D
~

EmployeeRep

II

EmQ.lQyee#
LastName
Salary
··j"""·········.. ···········.. ··· ..·.. ··· ..···"TTR·i·c·h·a·r·ci"s. ·······. ···. ·······. ········. ·. ·······. ···· . ·"TT$·~~l"1··0'0'0':·0·0············· .

i 'Dreyer

2
3
4
5

; [Hami ]ton
~Clayton

[MarkS

6

'sargent

7
8
9
10
11
12
13
__ f

A

rJ~CkSOn

1 i$49500.00
11$37500.00
i ~$341 00.00
11$28250.00
1 i$34125.00

I!$45500.00

~Goldman

j i$51 000.00

. iBarrett
!Gray
i [Raymond
i lRedford
!Roberts

i 1$54000.00
1i$37500.00
1~$38500.00
i ~$31 000.00

i

i r·
;

"

11$29500.00

1 ~i.... ONM,'7_."'_,,-"'-,,-r..-~

Currently, the report is sorted by the Employee# key field, but we
want to see the records arranged in descending order based on the
Salary field. To do this:

Select the repeating collection by clicking on either of
the vertical handlebars. Go to the Report menu and
select the Sort On Fields... option.
When the Sort On Fields ... dialog appears:

Select the salary field and then click on the button
marked "Z...A,9 ...0". Click on the OK button. Finally,
recalculate the report with the 00= shortcut.
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The newly sorted records should appear as below:
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Sal ary
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! 1$51000.00
1i$49500.00
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i [Gray
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i [Ham; 1ton

1 i$37500.00

i [cl ayton
~ fHoffman
i [Redford
,n

1~$341 00.00

i tsargent
:

j i$34125.00

~ ~l$3-2~5~0~0.~00~--iI!

1i$31 000.00

:,
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Example 2:
• List records for employees that have a salary greater
than $35,000 by LastName and JobTitie only. Sort by
Job Title and LastName - in that order.
Rather than adding to the current report:

Just click in the close box located at the top left corner
of its window. Then go to the File menu and select the
New Report option.
A dialog will appear asking you to select the type of report to be
created.

Select the first option - a Table-Style report on
"Employee". When the report field dialog appears asking
you to indicate the fields to include in the report, make
the necessary selections (LastName, JobTitle) and click
on the OK button.

79

The report field dialog will go away and the QueryBuild dialog will
appear.

When QueryBuild appears, select the Salary field name
(you will have to scroll down the list of names in the
Field to Search box) and enter the record qualification
shown below:

Enter qualification for the record(s) desired.
Operator to Use:
Field to Search:
BirthOate
nddress
City
State
lip
JobTitie

Salary

o Equal
o Not Equal
o Less
o Less Or Equal
@ Greater
o Greater Or Equal
o S1<wh With
o Inelud(H

(Find

nil )

( cancel)
(

Help)

(

nNO

)

(

OR

)

((

OK

)1

( [NlTH )

Ualue to Find:

rO,orY> 3500

Note that the qualification "Salary> 35000" appears in the display at
the bottom of the dialog only after you enter the number in the Value
to Find box and click on the Enter button.

Once the qualification is entered, click on the OK button
and supply a name for the report when the standard file
dialog appears.
Reflex will now produce the report for you. It should appear as
shown below (this example report is called EmployeeRep2):
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File

Edit

Format

D

[X1

Describe

Report

Fonts

Style

Window

EmployeeRep2

II
LastName

JobTitle

Sort this report by 10bTitle and LastName.
Select the Sort On Field... option from the Report menu.
Next, select the JobTitle field and click on the
A... Z,O ... 9 button.
The 10bTitle field name appears in the Sort Fields box on the right
of the dialog.
Now select the LastName field. Click on the
A... Z,O ...9 button again.
The LastName field name appears in the Sort Fields box
immediately under the 10bTitle field name.
If everything looks correct, click on the OK button and
then recalculate the report with the 8€b shortcut.
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It should look like the one shown below:
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EmployeeRep2
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LEistName

JobTi tIe
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GrElY
llEngi neer
Hami I ton
[ [Engi neer
~--------~------~
HoffmEin
[ [Engi neer
~--------~------~
MEirks
[ [Engi neer
.---------~------~
RElymond
l [Engi neer
.-~------~------~
Redford
[ [Engi neer
.---------~------~
Ri chards
[ lEngi neer
.---------~------~
Roberts
[ lEngi neer
~--------~------~
Sargent
[ lEngi neer
~~------~------~
BEirret t
llMEInager
~----------------~
Dreyer
llMEInager
~~--------------~
Goldman
llManager
~~------~------~

~----------------~::

If you wish, you may now print the reports you have created or
design some completely new versions. Just ensure that you work
with a copy of the Reflex program disk and that you do not alter any
of the files on the enclosed Examples disk since you will be needing
them for Section Two.

Although you have only been dealing with single file databases so
far, you can still use Reflex's powerful functions and formulas -you
don't need to create multiple file databases to become eligible.
Specific information on Reflex functions and formula use can be
found in the relevant sections indicated in the contents page - Section
Two is recommended reading, however.
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Section Two:
Multiple Files
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Multiple
Database
Design

Deciding what is and what isn't a "good" database design is a tough
job.
You may think that by consulting a set of approved rules the task
would be made much simpler: after all, there are grammatical and
syntactical rules for writing letters, with or without word processing
programs; similarly, there is an analogous mathematical "grammar"
for producing accurate numerical information with or without
computer-based spreadsheets.
Unfortunately, while there are well defined concepts and techniques
for building useful databases, it is extremely difficult to discuss
them in general terms. Just as the law cannot have rules that are as
complex as all the situations that people find themselves in, the rules
of database design cannot be made to account for each and every
type of application that needs to be developed.
In this Second section, you will begin using Reflex's features to
design and create multiple file databases. To begin with, the
databases will be of fairly limited sophistication. By the end of the
second section, however, they will be powerful enough to provide
quite complex information.

A Single File
Database

The illustration below shows, in table fashion, a single database that
contains information about the stocks owned by a group of people;
this example has been chosen more for simplicity of presentation
than real-world accuracy.

FirstName

LastName

Frank
Mark
Patricia
Alice
Roger

Smith
Johnson
Roberts
Springfield
Davis

Tel·

Stock 1

Stockl_Amt

Stock2

3034442777
9910111021
772 4031254
4493200417
5664047777

Great Northern
Solgen
Revshr
Zenith Paper

10
240
143
300

Canyon Oil
Apex Chemicals
Great Northern
Revstar
Solgen

Canyon Oil

24

Stock2_Amt
100
15
200
90
500
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Notice that:
• In our example, we are modelling individuals who own a
number of stocks. Our file is designed to show two stocks per
stockholder when we read each record in that file.
• Each row of the table is known as a record. Each record must be
unique in that no two records may have exactly the same values in
the key. Our single file example lists information on five
stockholders and therefore contains five records.
• The unique column headings (FirstName, LastName, etc .. ) allow
us to attach some meaning to the entries that appear below them.
Therefore, the names of all the individuals who hold stocks are
listed in the FirstName and LastName columns. The column
headings are the names of the fields that go to make up records.

Limitations Of
The Single File
Database

The arrangement shown above, is one of a few possible designs for
a single file database of this form. There is little margin for
improvement.
While information can be successfully entered into and reported
from this database, it will eventually become obvious that the way
the data is arranged in each record limits, or complicates, the types
of queries that can be made of the database as a whole.
For example:
The request: "List all those stockholders who own Canyon Oil"
would appear to be trivial, but it is not. We can obtain the relevant
information but only by asking the question in a clumsy manner:
Stock!

= "Canyon Oil" OR Stock2 = "Canyon Oil"

• We have to ask for both stock values to be checked because we
cannot be sure that Canyon Oil will always be listed as Stock! for
every holder.
• We cannot even enforce an arbitrary rule that says only Canyon
Oil can be entered as the first field because, as the table shows, not
every stockholder owns the stock.
What if we wanted to list the total amount of one stock - Revstar, for
example - held by our stockholders?
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We have to tell the database program to look through both stock
name fields for the value "Revstar" and upon locating any such entry
to move over to the relevant stock amount field and note the
Stock_Amt. After all Revstar fields have been found, the program
must then sum (add up) each of the stock amount values. We would
achieve this with the following formula:
SUM(Stockl_Amt from Stocks where Stockl = "Revstar") +
SUM(Stock2_Amt from Stocks where Stock2 = "Revstar")
These difficulties are trivial when compared to the following
development:
• How do we handle the event when a current stockholder buys a
third stock?
Clearly, we can go back and add an extra pair of fields to the file
design so that Stock3 and Stock3_Amt can be entered. But what
happens when somebody has four or five stocks? What number of
fields will handle all occurrences of stockholder purchases?
If we feel that ten stocks might be a realistic limit, or make the
decision that we will not accept any client that has more than ten
stocks, we are still only compounding some very real design flaws.

Most stockholders will have fewer than the maximum number of
stocks and therefore each record will contain many empty fields.
Such a database becomes increasingly wasteful of disk storage and
is clearly a poor design. (Also, be aware that any reports you created
for this file will have to be updated to take account of all new fields
and their names).
Further, querying the database file becomes acrobatic in that each of
the ten stock fields of every record must be checked, say, to find out
who owns a particular stock or set of stocks. Also, the performance
of the database - in terms of time taken to respond to a query - will
become more and more unacceptable as additional stockholders are
entered.

A Multiple File
Database Design

There is no hard and fast rule about when you should adopt a
multiple file database design approach. What we can say is that a
database must be able to cope sensibly with most of the complexities
a particular application will require.
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In addition to the deficiencies mentioned earlier, most users will also
find the Stocks database just described to be inelegant: There are a
large number of fields which mayor may not contain information;
Each record may be too large to fit neatly on the computer display;
Formatting printed reports neatly on a single page could be quite
difficult or impossible.
Now let us consider how to go about designing a more practical,
multiple file version.
Basically, Reflex can be said to provide a way of storing
information about "objects" or "events" in multiple files that are
connected together by means of Links.
When we use the words "object" or "event", we're really talking
about identifying the individual real world items about which we
wish to record data.

Objects

• In our example database both the person (as identified by the
firstname and lastname fields) and stocks (as identified by their
names) are objects.
Which objects are used in a database design depends very much on
the type of real world situation you are interested in; specific
applications can be modelled in a number of ways. In the current
Stocks database design we are interested in storing information
about a group of stockholders and the stocks they own. The
database file contains three objects:
• The first Object is the person we are wanting to store information
about - A Key of lastNarne and firstN arne is used to identify this
object.
• The second Object is the name of the first stock that the person
may own - Stock! is the name used to identify this object.
• The third Object is the name of the second stock that the person
may own - Stock2 is the name used to identify this object.

88

Multiple Database Design

stock

object

1astName
firstName
Te1#
Stockl
Stock l_Amt
Stock2
Stock2_Amt

object
object

An Object only identifies the thing we are going to record data about it does not really tell us much about its qualities. For this we rely on
Attributes.

Attributes

An Attribute is a feature or property of an object.
For stockholders these would be a firstname, an address, a
telephone number, or even a birthday. For stocks these might be the
amount of stock owned, the price of the stock, or the type of stock.
In the Stocks database file:

• The first object - the person - has a single attribute called Tel#.
• The second object - the first stock - has a single attribute called
Stockl_Amt.
• The third object - the second stock - has a single attribute called
Stock2_Amt.

object
object
object

stock
1astName
firstName
Te1#
Stockl
Stock l_Amt
Stock2
Stock2_Amt

uttributes
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A Multiple File
Stocks Database

There are two major changes we have to make to the single file
Stocks database in order to have it function more efficiently.
First, place all logical groupings of objects into separate database
files; if we do this with the Stocks database, we end up with two
files.
One file- called stockholder - only contains information about the
people who own stocks. The other file - called stockholding - only
contains information on the stocks that these people own.

stockhol di ng

stockholder
lastName
firstName
Tel#

stockname
stockAmt

Notice that the two files can store the same information as the
original single file design, only now, the person fields and the stock
fields exist separately. Naturally, this means that there is no way to
find out which people own which stocks.
Therefore, the second step is to connect the records of these files
with Links, which appears in Reflex as shown below:

stockholder
lastName
fi rstName
Tel#

theStocks
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stock hoI di ng

~/

theStockholder
stockname
stockAmt

Multiple Database Design

• The stockholder file has a key (lastName and firstName) that will
uniquely identify each record.
The new Collection of Links, which we've called theStocks,
has been included to associate each record in the stockholder file
with records in the stockholding file (more on this in a moment).
• The new stockholding file has its own unique key combination
(the Stockholder, and stockName). The Link called
theStockholder is the "other side" of the Link Collection called
theStocks that now exists in the stockholder file. It has been
included to associate each record in the stockholding file with the
corresponding record in the stockholder file.
To explain why you need the Links in the new two file design, we
must consider the ways in which the records in multiple files can be
related, or connected.

Linking Records
In Different Files

When you wish to create multiple file databases with Reflex you
cannot be vague about the nature of the relationship between the
records in each file involved; there are only a few possibilities to
choose from and you must choose the most appropriate one if the
system is to function appropriately.

A Link to One
Record

The simplest association between a record in one file and the records
in another, can be set up by choosing "A Link to One Record" from
the Describe menu. You might use this relationship if you had to set
up a multiple file system to store information on a stockholder who
owned only one stock (although this is a rather unlikely reason to
create a Stocks database). This is specified in Reflex via the "A Link
to One 'stockholding' Record" option in the Describe menu. A link
between records is shown on the next page.

91

Here we have one stockholder record and one stockholding record,
connected by a link line. The objects which the line connects are
called Links and they always exist in pairs. A Link does what its
name suggests - it links records in one file to records in another file.
In our example, the Link in the stockholder file, which we've called
theStocks, uniquely identifies an associated record in the
stockholder file which contains a matching Link called
theStockholder. This specific stockholding Link, in turn,
uniquely identifies the associated record in the stockholder file
which contains the Link called theStocks. In other words, if
stockholder "A" is linked to stockholding "X" via theStocks, then
"X" is linked to "A" via theStockholder.
• Following the link line from the stockholder file to the
stockholding file we can say that the Link called theStocks will
link with at most one record in the stockholding file; this is what we
set by using the "A Link to One Record" option in the Describe
menu.
• Equally, we can set the Link called theStockholder in the
stockholding file to be "A Link to One Record" in the stockholder
file. Then one record in the stockholding file will link with at most
one record in the stockholder database file.
This database would actually appear as below in Reflex:
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A Link. to one
stock.f-Jolder Record.

Lj stockhol der
lastName
firstName
Tel#
theStocks

V

Lj stockholding
theStockholdel'"
stockname
stockAmt

)

/
A Link. toone stoc k.f-Jol ding
Record.

If you were to enter some data into a database with two files Alpha
and Beta that are linked one to one, you would: fill in the Link on
one end or the other to indicate which Alpha record is associated
with which Beta record, or which Beta record is associated with
which Alpha record. Reflex (with Link checking enabled), ensures
that the record on "the other end" of a Link actually exists. The
program also automatically fills in the symmetric Link in that record
so that there is an association back to the record on "this" end of the
Link.

A Collection of
Links to Many
Records

So what happens when we progress to store information on a
stockholder that owns more than one stock?
This is where you need to use A Collection of Links to
"stockholding" Records from the Describe menu. We can
visually represent this record association as:

lastName : Roberts
firstName: Patric;a
Tel-:
415999-9000

stockname:
stock Amt:

Revstar
143

stockname :
stock Amt:

240
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Here we have a situation where for every record in the stockholder
database there may be zero or more linked records in the
stockholding file. (It is important to note that this is only a
representation of how the records may be linked. Reflex only
requires that one Link line be drawn between associated file images.
Complete details of how to do this are given in the tutorial that
follows.)

• theStocks has now become A Collection of Links to
"stockholding" Records.
• theStockhoIder will remain A Link to One" stockholder"
Record.
This two-file database would appear as shown below in Reflex:

. A Link to one
"stockFJolder" Record.

Lj stockholding

Ej stockholder1astName
flrstName
Te1#

~

theStockholder

)

stockname
stockAmt

theStocks

/
A Collect ion of Links to
IstockFJolding" Records.

Even though this one-to-many record arrangement may seem to be
quite adequate for the stockholder and stockholding database design,
there is one other appropriate way to associate the records in
separate files.
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Many Records
A Pair of Link
Collections to
Many Records

The two-file database example discussed so far is not the most
appropriate database design in that it stores information primarily
from the stockholder's point of view; its focus is on the individual's
stockholdings. It is simple to redesign the example to more easily
find out which stockholders own stock in a particular company; to
do this we must use the arrangement where each end of a Link pair
is a Collection of Links to records.

company

stockholder

stockname: So1gen
symbol:
SolG
price:
35

lastName : Roberts
firstName : Patricia
the-Stocks
I Solgen :~-~~~

HH~i~

~~~IRe~v~st~a~r:~~:~J~::::~:::h
lastName : Davis
firstName : Roger
the-Stocks

lastName : Smith
firstName : Frank
the-Stocks
IRevstar,

~~HH~

the-Stockho lde-rs
'Roberts IPatricial
• Davis IRoger J

price:
the-Stockho lde-rs
• Roberts IP atriciaJ
;~HH~
::::::: .JSmith IFrank I

• The Stockholder file contains essentially the same fields as those
shown in the previous example. The Link called theStocks is set
as A Collection of Links to "Company" Records. This
essentially says that "Stockholders may have many stocks".
• The Stockholding file has been renamed and altered so that it now
stores information about each company (stockName, symbol, price)
and a Link to each stockholder (theStockholders). The Link
called theStockholders is set as A Collection of Links to
"Stockholder" Records. This essentially says that "Companies
may have many stockholders".
This database would appear in Reflex as shown on the next page:
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A Collect ion of Links to
"stockfJolder" Records.

Ej stockholder
lastName
firstName
theStocks

/

Ej
~

company
stockname
symbol
price
theStockhol ders

)

A Collect ion of Link.s to
"company" Records.

The rest of Section Two provides a detailed look at how to design
and create multiple files and how to search them for information.
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Building a
Multiple File
Database

The first multiple file database system that you will create with
Reflex is based on the stockholder/stockholding design discussed
under the title "Multiple File Database Design".
Although not a complete model to begin with, this stocks database
will- by the time we've finished with it - be sophisticated enough to
store information on any number of stockholders and the stocks that
they own.
Initially, we only have a single file: Stkholder (remember that it is
easier to refer to singular names than the plural when it comes to
creating query formulas). You willleam how to create the second
database file that you'll need - Stkholding - and then link the records
in both files. Lastly, you will be able to rearrange these two files and
add a third one to create a really useful stocks information database.
Although Reflex allows you to have many document windows open
and many database file images displayed in the Overview window at
one time, it will be a lot less confusing if we begin with a clear
screen. So, before starting this tutorial section:
Go to the File menu and select Close All Documents. To
hide any file images in the Overview window, click on
the status icon in each image.
Next, you will want to take your first look at the current design of
the Stkholder file.
Go to the Overview menu and select Show Database
File. A standard file dialog box will appear.

File list box - first file automatically selected

birthday

:'B

Selected disl< name

Disl< eject
button

Drive
selection
button
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This standard file dialog box has:
• A file list box with an associated scroll bar. The scroll bar
allows you to move through a file list that is longer than can be
displayed in the file list box. Select a file by clicking on it with the
mouse.
• A Show button. Any selected file will be "shown" in the
Overview window when you click on this button.
• A Cancel button. Clicking on this button will end the database
file "show" process and send the standard file dialo~ away.
• The selected disk name. This informs you of the currently
selected disk - it is the disk from which files may be loaded, or to
which files may be saved.
• The disk Eject button. Clicking on this button will eject the
currently mounted disk in the selected drive - this option is not
available when the selected disk is a hard disk.
• The Drive selection button. Clicking on this button will
switch you from the currently selected disk drive to another disk
drive. The disk name and the contents of the file list box will be
updated when new drives are selected in this way.
As you can see, the Reflex™ disk is currently selected. However,
the database files you want are not on this disk, they are on the
Examples disk you have been supplied with. To access them:

Insert the Examples disk in the external drive.

Attorney
Buy
Capital
Check
Client
Company
Deduction

~

Show

EHamples
Eject

Cancel

Driue

Notice that the disk name changes - from Reflex to Examples.
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Use the scroll bar to locate the file called Stkholder (the
list of files may not be exactly as shown above).
Alternatively, you can use the fast-find method: just
press the "s" key to automatically select the first file
that starts with that letter or type as many letters as
necessary to identify the file you are trying to locate
(i.e. "stk").
When you locate the Stkholder file, select it with the
mouse and click on the Show button.
The Stkholder file image will appear in the Overview window. It
will already be selected for you.

"

File

Edit

Format

Describe

Oueruiew

Wir

DataBase Oueruiew

~
Lij::;tNarne
Fi t-::;
,J ij rn e
-t r'-

.

As you can see, it already contains some basic fields for each
stockholder. However, it would be much better if we added a few
more fields, so that we can store information on a stockholder's
address and maybe even their telephone number.

Since the file image is already selected, go to the
Overview menu and select Insert Field.
A space for the new field appears just under the lowest existing
field.

To enter a new field name just type: Address
For the next field you can use the shortcut method of inserting a new
field.
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Press the Return key; another field space appears.
Type: City
Repeat this procedure for the remaining fields listed
below.
State
Zip
Tel#
All the new fields you've entered are Text fields. Since Reflex
automatically creates new fields as text fields, you don't have to alter
them in any way.
One field that may at first appear to be a Number or Integer type
field is the telephone number field which we've called Tel#.
However, this must be a text field because it is not a valid number; it
contains a space and the dash character (eg: 221 343-9999).
Likewise for Social Security Numbers, etc ... Also, Text fields are
sorted differently than Number fields.

As Numbers

As Text

1
2
10
19
20
21

1
10
19
2
20
21

SORT ORDERS
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The Stkholder file should now appear as below:

IS

File

Edit

Format

Describe

Oueruiew
D~

~stkholder

LastName
FirstName
Address
City
State

Zip
Tel#'
The X mark in the status icon at top left of the file image indicates
that there are unsaved changes to the Stkholder file design. You
could go to the File menu and use the Save Design option to save
all your additions, but since we are about to make some other major
changes, let's just move on.
Go to the File menu and select New Database File. A
standard file dialog will appear, asking that you provide
a file name. Type: Stkholding and then click on the
Create button.
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A new file image for Stkholding will appear in the Overview
window, just underneath the Stkholder file image.

Ii File Edit Format Describe Oueruiew Wir
DataBase Oueruiew

[Xl Stkhol der
LastName
FirstName
Address

City
State

Zip
Te1#

1Xl 5tkholdin g

.'

1

I

'

This second file will be used to store information on the
stockholdings of each stockholder. Just so that these file images will
be easier to work with, we will arrange them as shown below:
"

File

Edit

Format

Describe

Oueruiew

Win

Data8a:

~ Stkholder

LastName
FirstName
Address

City
State

Zip
Tel#
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To move a file image:

Place the cursor over the name bar of the file and press
the mouse button. Be careful not to click on the mouse
when the cursor is over the status icon since this will
"hide" the file image. With the button still pressed
down, pick up the file image and move it.
File images may be moved around freely in the Overview window,
but you cannot place one file image on top of another.

To start entering fields in the Stkholding' file, make sure
that it is selected and then go to the Overview menu.
Select Insert Field.
An empty field space will appear in the Stkholding file image. You

will need to enter the following fields:
• stockName: This needs to be a Text field. It will be used to
store the name of each stock.

• stockAmt: Since stockholders will always own whole stock
amounts - there will be no fractions of stocks to store - this needs to
be an Integer field. You could make this a Number field, but Integer
fields take up less storage space, can be computed more quickly,
and prevent the entry of erroneous fractional amounts.
• stockPrice: This needs to be a Number field since it will
contain fractional money values.
Enter all the fields listed above into the Stkholding file until it
appears as below:
•

File

Edit

Format

Describe

Oueruiew

Wi

DataB~

fX] Stkholder

fX] Stkhol dl ng

LflstNflme
FirstNflme
Address

stockNflme
stockAmt
stockPri ce

City
Stflte

Zip
Te1#
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Once you've entered all the fields, you must then set each field to th
correct type. StockName is a text field so you can leave that one as i
is. StockAmt and stockPrice have to be set as Integer and Number
fields respectively.

Select the stockAmt field by clicking on it. Go to the
Describe menu and choose Integer Field.
The stockAmt field is now of the Integer Field type and will only
handle whole number entries (a check mark will appear next to this
menu option when the stockAmt field is selected).

Select the stockPrice field by clicking on it. Go to the
Describe menu once again and choose Number Field.
The stockPrice field is now of the Number field type and will accept
whole number entries or floating point entries (whole numbers with
a fractional part).
You now have two file images sitting in the Overview window.
They each contain some of the fields that will be needed to store
information on stockholders and the stocks that they own. How do
you get the records in these two files to work together?
With Reflex, you associate the records in one'file with the records in
another file by using Links in each. Initially, a Link is just a name
in the file image; it looks exactly like a text field until you use a link
line to connect it with a Link name in another file image. On
connecting two Link names with a link line, the names change to a
bold font and they take on a special status in the Describe menu.
Be aware that you cannot create a Link line between two existing
field naPles - Link lines can only be drawn between new field
names in file images (these can be field names in completely new
files or new field names added to existing files).
• When a Link is first created it is set as A Link to One " ... "
Record, where the actual name of a connected file is displayed
within the quotes in the relevant Describe menu location.
• Alternatively, you may set a Link at either end of a Link line to bt:

A Collection of Links to " ... " Records, where the name of a
connected file is displayed within the quotes in the relevant Describe
menu location.
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In the current example, you clearly want to make sure that every
stockholder record in the Stkholder file is linked to every relevant
stockholding record in the Stkholding file. First, let's make the
connection between the two files and then discuss the procedure in
more detail.

Select the Stkholder file by clicking once on its name
bar. Go to the Overview menu and choose Insert Field.
A new field space will appear. This is where we will put the first
name.

Type: theStocks
Right now, this new field looks just like the others - and in fact, it
has a Text field type. Check this by selecting the new field and
going to the Describe menu. There should be a check mark
alongside the Text Field option.
Since a Link has to link to something, you must now create another
name in the Stkholding file.

Select the Stkholding file by clicking once on its name
bar. Go to the Overview menu and select Insert Field.
(Alternatively, you can just click on the last field in the
Stkholding file image and press the Return key).
Now enter the second Link name.

Type: theStockholder
(It is important to note that the name you give a Link should never
be the same as the name of the database file which contains the
records it links to. This can cause errors when you start to use these
names in formulas and queries to search for information since it will
not be clear which name - the Link or the database - Reflex should
search).
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If the file image is not wide enough to accommodate any name you
enter, just use the resize box at the bottom right of the file image to
make it wider much as you would resize a window (click once on
the name bar to select the file image - this will show the resize box).
This second name has a Text field type for now, too. The two files
should appear as shown below:
"

File

Edit

Format

Describe

Oueruiew

U

Datal

~ Stkholder

LastName
FirstName
Address
City
State

1XI Stkholdlng
stockName
stockAmt
stockPri ce
theStockho1 der

Zip
Te1#
theStocks

Clearly, the names are not yet connected and therefore cannot serve
any special purpose. To connect them:

Place the mouse cursor over the name called theStocks
in the Stkholder file. With the mouse button depressed,
move the cursor towards the second name called
theStockholder in the Stkholding file.
~ Stkholder

LastName
FirstName
Address

City
State

Zip
Tepo~

_n8 =.l o-:~~}---
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~ Stkholding

stockName
stockAmt
stockPrice
theStockhol der

Building A Multiple File Database
A line will appear as you move the cursor away from the Stkholder
file and closer to the Stkholding file. This is the Link line we
mentioned earlier; it will connect the Link names in both file images.

To complete the link line, continue moving the cursor
until it is over the name called theStockholders. When
you have it centrally placed over this name, let go of the
mouse button.
The line will become permanent indicating that the two names are
now connected. Also, notice that the names now appear in bold
type, signifying the change from a simple name with a Text field
type to a Link.

~ Stkholder

LastName
FirstName
Address
City
State

~ Stkholdjng

stockName
stockAmt
stockPri ce

theStockholder

Zip
Tel#
{he tockS
Now check on the status of each Link by first selecting
theStocks (if it is not already selected) and then going to
the Describe menu.
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File

Edit

Window

Format
Nmnt!(~r rh~h1
Inh~!JN H(~ld

~Stkholder

LestNeme
FirstNeme
Address

City
State
Zip

Tel'"

l}oh~ n(~ld

!. o~ji( n! f ieW
linH~ H(~!d
Se(IU(m(.~

I

Held
I'

I

I

I

'.

I

I

R Collection of Links to "stkholding" Records
Key Field
V"'Non-Key Field

3CK

Notice that the Describe menu now indicates that theStocks is
currently A Link to One Stockholding Record (there is a
check mark to confirm this). What's the explanation for this?
When you completed the line between the two Link names you were
actually telling Reflex that, until you say otherwise, records in the
stkholder file and records in the stkholding file are associated in
some way.
The only thing that you haven't told Reflex is what type of
association this should be. The fact that theStocks is currently A
Link to One" Stkholding" Record is simply due to the fact that
this is the default setting.
There are two possible settings we can select for theStocks.
• One record in the Stkholder file can be associated to at most one
record in the Stkholding file - A Link to One "Stkholding" Record.
• One record in the Stkholder file can be linked to zero, one, or
more records in the Stkholding file - A Collection of Links to
"Stkholding" Records.
What would be the best option to use?
The first option (oQe-to-one) only allows you to store infonnation
on stockholders that own at most one stock. Stockholders typically
own more than one stock.
The second option (one-to-many) allows you to store infonnation on
stockholders that own many stocks. This is the more appropriate
record to record association to use.
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Select the Link called theStocks and go to the Describe
menu. Skip the A Link to One" Stkholding" Record
option which currently has a check mark by it, and
instead choose A Collection of Links to "Stkholding"
Records.
You have just set the Link called theStocks correctly - now each
Stkholder record may be linked to zero or more stock records in the
Stkholding file (the check mark is now alongside the A Collection of
Links to "Stkholding" Records option).
•
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Now see if you need to set the Link called theStockholder in the
Stkholding file.

Select the Link called the Stockholder. Then go to the
Describe menu and check its current setting.
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Notice that the default setting for the Link called theStockholder is

~

Link to One" Stkholder" Record. Is this correct?
Consider the following arrangements:
• Each record in the Stkholding file may be linked to zero or one
record in the Stkholder file.
• Each record in the Stkholding file may be linked to zero, one, or
more records in the Stkholder file.
A Link to One "Stkholder" Record is the correct setting. This is
because the two file database you are working with is designed to
store information on individual stockholders and the collection of
stocks that they each own. No attention is paid to storing
information on the companies that issue the stocks and who the
stockholders are for each of those companies.
Since the setting is correct, you can continue. All that is left to do is
choose the Key for the Stkholding database file (Reflex requires that
every file has at least one Key field). The correct Key is a
combination of the Stockholder and stockName.
For our purposes, this Key should ensure that the records in the
Stkholding file will be unique.

Select the Link called the Stockholder. Go to the
Describe menu and select the Key-Field option.
Notice that the Stockholder jumps to the top of the field list in the
stockholding file and that it is now underlined. The underline
visually confirms that this is now a Key field.
~Stkholder

~ Stkholding

LastName
FirstName
Address

City
State

ZiD
Tel#
theStocks
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Building A Multiple File Database

Select the stockName field. Go to the Describe menu and
select the Key-Field option once again (or you can use
the OOK shortcut).
The stockNarne field is now also underlined.

~

Stkholder

LastName
FirstName
Address
City
State

~

Stkholding
theStockholder

stockName
stockAmt
stockPri ce

Zip
Tel#

theStocks
Both files are now complete. You can now save their designs.

Go to the File menu and select Save Design.
Reflex will now save the file designs to disk and, when this
procedure has finished, the X marks in the file image status icons
will disappear. The files are ready to be opened, but to save you
time, two files with the same design as Stkholder and Stkholding are
provided on disk. They already contain information for you to work
with.

Clear the Overview window by clicking once on the
status icons in the Stkholder and Stkholding file images it does not matter which file you hide first.
Now that the Overview is totally clear, you can show the already
completed stock files.

Go to the Overview menu and select Show Database
File.
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When the standard file dialog appears, asking that you select the file
to be shown, locate a file called stockholder (the Examples disk
must be selected for this to work).

Select stockholder with the mouse and click on the Show
button.
The stockholder file image will appear in the Overview window - it
will already be selected for you.
"
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•

To display the image of the linked file - it is named
stockholding - use the Show Linked Files option in the
Overview menu or the OOG shortcut.
•
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Window

Building A Multiple File Database
As you can see, the two new files are of the same design as the two
you just created. Take a look at the information they contain-starting
with the stockholder file.
Double-click on the name bar of the stockholder file.
A data entry window for the stockholder file will appear in front of
the Overview window. The fields in the data entry form should look
like those shown below:
iii File Edit Format Describe Database Search Mise Window
D

stockholder

Data Entry

The first field in the Overview file image appears as the top-most
field in the data entry form. To the left of each field appears a label;
the default labels have the same names as the fields you entered in
the Overview image. The first field - LastName - is already selected
for you and its name appears in the name panel at the top left comer
of the stockholder window.
You can always customize this form by going to the Database menu
and selecting Form Layout but, for now, let's leave it the way it is.
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Use the Tab key to move down the fields until you get to
the first Key field copy in the Link labelled theStocks.
•

File
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The major difference with the data entry fonns that you were
introduced to in Section One of this manual is the appearance of the
Link Collection - here it's called theStocks. Notice its special
appearance.
Key field copies

/

theS

I

~
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cad") row of Key field copies is a Link.

There are two sets of three fields arranged as rows inside the gray,
box-like, Collection of Links called theStocks.
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• There is a LastName field, a FirstName field, and a stockName
field. These are copies of the contents of the Key in the stockholding
file (theStockholder and stockName). Each row (a combination of
the three key fields just listed) is a Link to one record in the
stockholding file. You can check this by clicking on one of the Key
field copies in any Link and going to the Describe menu.
Probably the best way to check what's going on is to open up the
stockholding file and take a look.
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Select the first LastName field inside the Collection of
Links called theStocks (confirm that you have done this
by checking the name panel at the top left of the
stockholder window). Go to the Database menu and
.select Show Linked Record or use the OOG shortcut.
By selecting the Show Linked Record option you are asking
Reflex to automatically open up the file that contains the record
associated with the Link you are currently viewing. A window
containing the linked record in the stockholding database will open
up behind the stockholder window. Take a look at this second
window:

Go to the Window menu and select the" stockholding"
window name.
The stockholding data entry window will appear. It will contain the
stockholding record which is linked to the Link you selected in the
stockholder data entry window.
•
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Notice that the Link called the Stockholder in the currently active
window contains the values of the first two fields (the Key) in the
stockholder file. You can explore this record to record link in a very
dynamic manner by changing the name of a stock that somebody
owns.

Select the stockName field in the stockholding data entry
form.
Currently, the stockName field contains "Apex Chemicals"; let's put
another stock name in and see what happens.

Type: Lukas Air. Then complete the record update by
selecting Enter Record from the Database menu or by
using the OOw shortcut
As soon as you confirm the new stock name by selecting the Enter
Record option, Reflex automatically changes the list of stocks that
are owned by Frank Barrett in the stockholder file. Originally, Frank
Barrett owned Apex Chemicals and Solgen. After the update, Frank
Barrett is correctly shown as owning Lukas Air and Solgen.

Check this by making the stockholder window active just select its name from the Window menu or click
anywhere on it.
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As you can see, records in the two files are linked in such a way that
changing some or all of the contents of fields that are part of the Key
will automatically update copies of that information held in
associated records.
Before we move on, you had better change the record you altered
back to its original state just so the database information remains
consistent.
Replace Lukas Air with Apex Chemicals in the Frank
Barrett stockholding record.
• So far, you've changed a record in the stockholding file and seen
it update a linked record in the stockholder file.
To explore the other ways in which associations are maintained
between records let's add a new record to the six that already exist in
the stockholder file.
Make the stockholder data entry window active. Go to
the Database menu and select New Record (you can also
use the OOE shortcut to do this if you wish).
A blank new record will appear in the stockholder window.
Type in the information shown below using the Tab key
to move from field to field. Stop when you have entered
the Tel# value.

o
X Te1#
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Press the Tab key once again to select the first field in
the empty Link called theStocks.
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Begin typing as if you were about to enter some
information into this empty field (type just a few
characters).
Instead of text appearing, a dialog box will be displayed informing
you that you cannot enter anything into this Linle

This Link can only be filled in (or deleted) by
RefieH. When you enter (delete) the Linked
record this Link will be updated.

I[

OK

)1

Reflex is telling you that the Link you are trying to fill in is for
display purposes only - the program will copy over all relevant
information from an associated record in the stockholding file when
that record is filled out (created). Until then, the empty Link must
remain empty.
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This dialog appears whenever you attempt to fill in a Link where the
"other side" of the Link is part of a record Key; in the current case
you are erroneously trying to fill in a Key field gmy of a
stockholding file record where no linked record exists.
To complete the procedure then, you must enter a related record in
the stockholding file.

Make the stockholding database window active by
clicking on it or selecting its name from the Window
menu.
The stockholding database window will move in front of the
stockholder database window.

Create a blank new record by going to the Database
menu and then selecting New Record or using the OOE
shortcut.
The first field in this record (the first field inside the Link called
the Stockholder) will already be selected for you.
In this LastName field type: Nesbitt. In the FirstName

field type: Alan. Complete the record as shown below.
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When you enter this record, Reflex will copy over information from
the current stockholding record to the associated stockholder record.
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Enter the new record into the database by using the
Enter Record option in the Database menu or the OOw
shortcut.
Reflex will not only enter the new record into the stockholding
database, but it will also copy over the Key field information from
this new record to the Alan Nesbitt record in the stockholder
database. Check this by making the stockholder window active.

Click on the stockholder window or select its name from
the Window menu.
stockholder

II
LastNamelNesbitt
....................................................................................:
Firs t Nam e rA·l"iiri ............·. ·..................................................·. l
~

t{·~:·:·:§:·~·~·~:·r~:·~·:~:·:·:·~·:~:·6.'~:·:·:·:·:·:·:.:.:.:.:.:.:.:.:.:.:.:.:.:.:.:.:.:.:.:.:.:.:.:-]
Cit Yr.~·.~.E( 6·.~"~·.0. ·~·.·.·".·.·".·.·.·".·.·.·.·.·".·.·. . . . . . . . . . . . . . . . . . . . . . . . . . . . .J
Stat e r.¢. ~. . . . . . . . . . . . . . . . . . . . . . . . .:. . . . . :. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . J
Zip r.~·. ~·. . ~·. ?·. .~. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .J

Add res s

I
111111

. :~ ::.Ii.:~

:I . . :i. • • :i. .
:i.:i ..
::
........ .......

theSt::~: ~~:~;~i~F~!~I~:;~;:;;;:~::::J·IRevstar··i
........................................................................................................................................ illili
111111

Q

Reflex has copied over the last and first name (Nesbitt, Alan) and
the name of the stock (Revstar) that you just entered in the
stockholding file.
• Now you've seen how to enter a new stockholder record in the
stockholder file and create a linked record in the stockholding file.
First, you created a record for Alan Nesbitt in the stockholder file.
On attempting to enter data in the Link called theStocks, you found
that Reflex didn't allow you to do this. The reason is that the Link
called theStocks is intended to contain copies of the Key fields from
an associated record in the stockholding file (this is only because the
other side of the Link - called the Stockholder - has been included as
part of the Key). Reflex does not allow you to fill in "this side" of
any Link where the "other side" is part of a record key.
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In this particular database design, the procedure you've just gone
through can be shown in a pictorial fashion as below:
Step 1: Create a record in the stockholder file -notice that there is
currently no associated record in the stockholding file.

stockholder
LastName:
FirstName :
Address:
City:
State:
Zip:
Tel#:

stockholding

NesbittAlan
18 Grey land Lane
Burlingame
CA
91101
415111-2120

!1 !il~I ~ !I !il li l il il!I I~li~l ~i l l~ l il ~1 ~1 1 1 1 1
Part 2: Enter a record for Alan Nesbitt in the stockholding file Reflex will check to see if a stockholder record with the same Key
- "Nesbitt, Alan" - exists.

Re fIe X chec k.s to see if the
k.ey fields ILastNarne" and
"f irst Name match in boff;
records,
II

theStockho lder I Nesbitt I Alan I
Address: 18 Grey land Lane
City: Burlingame
State: CA
91101
415111-2120

122

stockname : Revstar
stock Amt : 250
stock Price : 46

Entering Information in Multiple Files

Part 3: In this case the Key fields "LastName" and "FirstName"
match, so Reflex will now copy over the complete Key (Nesbitt,
Alan, Revstar) from the stockholding record to the Link called
theStocks in the relevant stockholder record. This completes the
record-to-record association.

stockholder
1r:::~~:~~~~:~~::::::::~~~:~~~:;=::::::::::::::::::::::::::::::::::!~

FirstName : Alan
~l
Address: 1"8Greyland Lane
II
11
City: Burlin9ame
11
i~
State: CA
1i
II
Zip: 91101
1l
11
Tel#: 415111-2120
11
II the-Stocks I Nesbitt I Alan I Revstar~~

II
II

j

stockholding
m stockname' Revstar
m stockAmt: ~
m stockPrice:
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Reflex offers one more way of making sure that records are entered
and linked correctly.

Make the stockholding window active by clicking on· it
or selecting its name from the Window menu. Create a
blank new record in the stockholding file by using the
OOE shortcut.
The first field in the new record will already be selected for you.

Type in the new stockholding record as shown below:
D
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When the record is completely filled out, select Enter
Record from the Database menu to insert the record into
the stockholding file.
However, rather than entering the new record into the stockholding
file, Reflex displays the following dialog:

There is no record in Database "stockholder" with this key. Shall we
enter one for you?
Enter

Cancel

To explain, this dialog is telling you that there is no record with the
Key (Gordon, John) in the stockholder file.
• If you click on the Enter button, Reflex will create a stockholder
record with the correct Key field entries (LastNarne will be
"Gordon" and FirstNarne will be "John"), and the current
stockholding record will be inserted into the database. The dialog
will then go away.
• If you click on the Cancel button, the dialog will go away and
Reflex will return you to the stockholding record that you just typed
in. No associated record will be created in the stockholder file, and
the current stockholding record will not be entered into the database.

Click on the Enter button in the dialog.
Reflex will now go ahead and create an associated record in the
stockholder file.

Check that a new record has indeed been entered by
selecting a field in the Link called theStockholder in the
stockholding window and choose Show Linked Record
in the Database menu or use the OOG shortcut.
This will display the relevant linked record in the stockholder
window.
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Click on the stockholder window or select its name from
the Window menu to make it active.
The John Gordon record should now be visible. Notice that only the
key fields of the John Gordon record have been copied over from
the stockholding record by Reflex - you can now complete the rest
of this record if you wish.
• You have now used Reflex's automatic record generation feature
to enter a stockholder record based on the information supplied by
you in a new record in the stockholding database.
Pictorially, we can show what has just happened.

Step 1: First, you filled in a new record (for John Gordon) in the
stockholding file and then attempted to enter that record - Reflex did
not immediately allow this since there was no record in the
stockholder file with the Key "Gordon, John".

Step 2: A dialog appears asking if you wish to have Reflex
automatically create a record in the stockholder file with the correct
Key (Gordon, John). On clicking the Enter key on the dialog,
Reflex then: creates the stockholder record, places the correct entries
in the LastName and FirstName fields, and places copies of the
current stockholding record's Key (the one you just entered for John
Gordon) inside the Link called theStocks.
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LastName : Gordon
FirstName : John
Address: City:
State:

Zip:
Tel# :

To summarize, there are two main methods of entering
information in the two connected files described above:
• Enter the stockholder information first. Then move to the
stockholding file and enter information there on the stocks and the
people who own them.
• Alternatively, enter the stock information first and use Reflex's
automatic record creation procedure to enter a linked record in the
stockholder file.
For a more general discussion of how data may be entered when
using multiple file databases, see the section entitled Details &
Techniques.
The stockholdings database system described above has been
presented more as an introductory design than one that you might
use in real life. So instead of using it to demonstrate the advanced
reporting features of Reflex, let's continue by looking at a more
practical stock/stockholdings system that features three database
files.
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A Three File
Stocks Database

Go to the Window menu and select Database Overview.
When the Overview window appears, go to the File
menu and select Close all Documents. Once all
documents are closed, remove all file images from the
Overview window by clicking on the status icon in each.
Once the Overview is clear, go to the Overview menu
once again and select Show Database File.
A standard file dialog will appear asking for the name of the
database you wish to see.
Make sure that the Reflex Examples disk is selected
(click on the button marked "Drive" if you need to
switch drives) and locate a file called: person. With the
person file name selected, click on the Show button.
The person file will appear in the Overview window.
Use the OOG shortcut to show the two linked files - they
are called company and stockbuy (you will need to use
the OOG key combination twice since there are two
files).

Ll person

E1

LastName
FirstName
Address

City
State
Zip
netWorth
theStocks

Ll stockbuy

Lr

company

stockname
symbol
price
pri ceOate
~

theStockholders

thePerson
theComp-any
amount
pricePaid

As you can see, this is a fairly sophisticated database system. It can
store information on individual stockholders in the person file and
it can store information on companies that have those individuals as
stockholders in the company file. The stockbuy database file
records each purchase of a stock by a stockholder.
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It is important to note how the various Links have been set:

• theStocks: This is a Collection of Links to "stockbuy" Records
since stockholders will typically hold more than one stock.

• thePerson: This is A Link to one "person" Record. In other
words, each stockbuy record will be a.ssociated with at most one
record in the person file.
• theCompany: This is A Link to one "company" Record. In
other words, each stockbuy record will be associated with at most
one record in the company file.
• theStockholders: This is a Collection of Links to " stockbuy"
Records since companies will typically have more than one
stockholder.
Before we start producing reports on this database trio, you should
open them up to see the information they contain.

Double click on the name bar of the person file.
The person file window will appear and the first record will be
displayed.

o

person

EjLastName
LastName

Data Entry

The Link Collection in this file contains infonnation copied over
from the key field in the stockbuy file (LastName, FirstName,
stockName).
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Select the first LastName field inside the Link by
clicking on it. Use the OOG shortcut to Show Linked
Record.
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Data Entry

This will automatically open up the stockbuy file - however, the
stockbuy data entry window will not become the active window.

To view the linked stock buy record, go to the Window
menu and select stockbuy.
The stockbuy database window will move in front of the person
database window.
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Notice that this data entry fonn has two separate Links. One, called
thePerson, contains the Key of the person file (LastN arne and
FirstNarne) and the second, called theCornpany, contains the Key of
the company file (stockName).

To view the linked record in the company file, click on
the field inside the Link called theCompany and use the
OOG shortcut.
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-0

stockbuy

LI stockNome
thePerson
theCompany
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Doto Entry

To make the company database window active, select its
name from the Window menu.
person
stockbuy

company

Ej stockNome

Doto Entry
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A Three-File Stocks Database

The Link Collection in the company file contains the key field values
obtained from the stockbuy file (LastName, FirstName and
stockName - click on them and look at their names in the name
panel). Having seen how the records in this three file database are
associated, you can now start to produce some reports.
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Stocks Database

A major feature of Reflex is that you may use familiar spreadsheetlike formulas to retrieve information from one or more sources.
The notion is that instead of working only within an onscreen matrix
of spreadsheet cells, Reflex formulas are able to search single files,
sets of files (a database), the Links in files, and Repeating
Collections in Reports to find any valid value or set of values.
This section will acquaint you with the basic structure of Reflex
Formulas by providing some relevant examples. All examples given
here will refer to the database structure shown below. This is the
same three-file database introduced previously under the title "A
Three-File Stocks Database".

LI person
LastName
FlrstName
Address
City
State
Zip
netWorth
theStocks

LI

LI

V

stockbuy
thePerson
theComoany
amount
prlcePaid

company
stockname
symbol
price
priceDate

~

theStockholders

• The first file - called person - is designed to store information
on each stockholder. The fields allow you to find out the name of a
person, their address details, and their net worth. The Link called
theStocks allows you to find out which stock purchases were
made by a person (theStocks is a Collection of Links to "stockbuy"
Records).
• A second file - called company - is designed to store
information on the company that issues a stock. The fields it
contains allow you to find out the name of the stock, its stock
market symbol, its current market price, and the date of that price.
The Link called theStockholders tells which purchases have been
made of that company's stock (th~Stockholders is a Collection of
Links to " stockbuy" Records).
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• The third and last file - called stockbuy - represents the event
when a stockholder buys some stock of a particular company. The
fields it contains have to do with the amount of stock bought, and
for what price. The two Links - called thePerson and
theCompany - connect the records in the person file with records
in the company file, and thus provide access to records in those
files. The Link called thePerson tells which person bought stock and
the Link called theCompany tells which company stock was bought
(thePerson is A Link to one "person" Record and the Company is A
Link to one "company" Record).
Suppose that you were using this database and had to find out some
basic information such as:
• What are all the names of all the stockholders and where do they
live?
• What are the names of all the stockholders and what are their
individual stockholdings worth?
• Which stockholders hold a specific stock?
How would you seek out the answers to these questions using
Reflex? Let's first work with one of the problems mentioned above:
"Get the names of all stockholders and the cities and states in which
they live".

Important: Before starting to create any of the reports,
you must make sure that the Examples disk is inserted in
a disk drive and that the three files named person,
stockbuy and company are displayed in the Overview
window.
This will ensure that Reflex automatically knows where to find these
files.

Once the file images are displayed, go to the File Menu
and select New Report.
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A dialog will appear asking you to choose between a table-style
report and a report you design yourself.

Choose the last option - a report which you design
yourself.
A standard file dialog will now appear asking that you name the
report.

Type: StockReport
A new report window will appear; it will already be set for Report
Design activities. Check the activity box at the lower left comer to
make sure. Since you are attempting to show the first name, last
name, city and state values of each person (and therefore of each
record in the person file), you need to create the fields required to
display those values.

To create a field in a report: Place the cursor wherever
you want the field to be located. With the mouse button
depressed, drag the cursor downwards and to the right.
A black rectangle will appear, varying in dimensions as you move
the cursor.
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Reporting on the Stocks Database

When you have a black box of reasonable size, go to the
Describe menu and select Text Field.
The black box will take on the appearance of a field. You have just
created the first of four fields that you will need. Rather than draw
the other three manually, you can use the Duplicate option in the Edit
menu or the OOD shortcut to make copies of the current field.

With the text field selected, use the OOD shortcut to
create the three remaining fields - each new field will
appear underneath the previous one.
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To have the top-most field display the first name of each person we
must supply it with the correct formula.

Select the top-most field and then click in the formula
panel. Type: FirstName
In the correct circumstances, this field will now be able to display
the FirstName value from each record in the person file.
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Select the other fields in order and give them the
formulas:
LastName
City
State
You've now told Reflex what information will be shown by all four
fields. Go ahead and attempt to calculate the report.

Go to the Report menu and select Calculate or use the
8€b shortcut.
Instead of producing the report for you, Reflex displays an error
message in each field, as shown below:
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The problem is that although you have told Reflex which database
fields you want to see - FirstName, LastName, City, and Stateyou have not told it which specific file contains these fields. The
Error(24," Name not found") message appears in each field because
Reflex has not been given the name of a Source in which to find
the names that you supplied. A Source the name of a database file, a
Link, or a Repeating Collection in a Report. To see the complete
error message, just open up any of the fields or look in the section
entitled "Error Messages" for an explanation of error Number 24.
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To tell Reflex the name of the Source for the four fields, you'll need
to create a Repeating Collection.
• A Repeating Collection is the mechanism by which you can
obtain a particular view of a Source once you have provided a query
for that Source. For every valid record in the query, the repeating
collection will generate a report record. By itself, however, the
repeating collection does not show field contents or values - this is
the job of the fields within a repeating collection.
Right now, you have the fields, but no repeating collection. To
create one:
Draw a black rectangle over the fields as shown below:
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Now go to the Describe menu and select Repeating
Collection.
The black rectangle will take on the appearance of a repeating
collection and it now surrounds the four fields. (If Reflex sounds a
beep or displays a dialog which says: "Objects in a form may not
'Overlap", the repeating collection was probably not big enough to
contain the display fields. Just try again with a larger one).
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The repeating collection is already selected for you (the outline is
black, instead of gray). If it has somehow been deselected, simply
click anywhere on the thick vertical handlebars to select it again.
You are now ready to provide this repeating collection with the nam(
of the file that you wish it to provide a view on (i.e. the query).
Since we want to find some information on stockholders, the Source
you must refer to is the person file (this is where the four values we
seek are stored).

With the repeating collection selected, click in the
formula panel so that you may enter some text there.
(Alternatively you could have used the Edit Formula
option in the Report menu or the OOQ shortcut). Type the
query as shown below:
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This is the simplest Reflex query - the name of a Source.
Use the 00= shortcut to calculate the report.
You should now have a listing of each stockholder and the city and
state in which they live.
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However, as you can see, the report is not really well designed in
that only two complete records are visible on the screen at one time.
To overcome this you may alter the design of the basic Design
Template so that the records are presented more satisfactorily.
Go to the Report menu and select the Design option.
The report changes from its Display appearance to its Design
appearance.
Click on either of the repeating collection's handlebars.
Notice the small white resize box that appears in the
bottom right-hand corner. Place the cursor over this
resize box - it should change into the shape of an arrow and press the mouse button. With the mouse button still
held down, move the cursor to the right. Stop when the
repeating collection looks like the one shown below.
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Next, click on each field and, using the resize box that
appears, make them narrower (we are going to fit them
all in one line so they need to fit easily within the
current repeating collection).
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Now you have some space to move the fields around.
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Click on the second (LastName) field and move it
alongside the top-most (FirstName) field.
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Move the remaining two fields (City and State) so that
you end up with a single row of fields.
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Notice that the last field was not positioned correctly in the image
above. This is an easy problem to remedy.
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With the State field still selected, hold down the Shift
key and then click on the City field, as shown below.
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Both fields will how be selected.

Go to the Format menu and select the Align Tops
option.
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Reflex will now reposition the selected fields so that they are aligned
correctly.
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With all the fields in a single row, you can now make the final
design adjustments until the template is just right.
Select all the fields by Shift-Clicking.
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Move the group of fields up to the top left corner of the
repeating collection.
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Select the repeating collection and use the resize box to
reduce its size until it just surrounds the fields.
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Finally, add a label above each field, outside of the
repeating collection (move the repeating collection down
if you need more room above it). Just click down on the
report space above the repeating collection to get a little
black box. Type the label contents. Use the alignment
options in the Format menu to arrange them neatly.
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Recalculate the report with the 0= option to see how this
new design template displays the records from the
person file.
Ii: File Edit Format Describe Report Fonts Style Window
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~

StockReport

II

Notice that the City fields for Barbara Jackson and Joanna Richards
only have the word "San" inside them. This is because the City field
is slightly too small to show the complete field value of "San
Francisco". This is easily changed.

Go to the Report menu and select the Design option.
When the design window appears, open up the repeating
collection and, using the methods described earlier,
move the State field over to the right and make the City
field wide enough to show the longest city field value.
Reposition the labels correctly and then recalculate the
report once again.
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You can now go on to modify the fonnulas that work with this
basic template in order to produce more and more specific reports.
For example, with only a small change in the current query we can
qualify the view we have of the Source to find out which
stockholders live in a particular city - let's say San Francisco.

Select the repeating collection by clicking on either of
the vertical handlebars. Click in the formula panel and
add a qualification to the text already there so that it
reads as below:
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You have just made the original fonnula (person) more specific by
adding a qualification to it (WHERE city = "San Francisco").

Use the 00= shortcut to calculate the report.
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Only information on those stockholders that live in San Francisco
are included in this report.
Let's try a few more queries with the single person file before
moving on to more sophisticated reports involving the use of Links
and multiple database files. This time, you will produce a report on
all the stockholders in San Francisco that have a net worth exceeding
a minimum level.

Select the repeating collection and then click in the
formula panel. Add text until it looks as below:
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IIperson WHERE City = "San Francisco"AND netWorth > 240000
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The original simple formula (person) has now been constrained with
a two-part qualification (WHERE City = "San Francisco" AND
netWorth> 240000).

Use the 00= shortcut to calculate the report once again.
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Information on those stockholders that live in San Francisco and
which have a net worth over $240,000 is displayed (in this case
there is only one).
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To actually find out the net worth of all stockholders:

Select the repeating collection and make sure that the
query reads: person. This ensures that all records in the
person file will be represented in the report, as opposed
to just those that live in San Francisco with a netWorth
exceeding $240,000.
Now you have to include a new field to display the netWorth value.

Modify the design template as shown below, giving the
Current Worth field the formula "netWorth".
Note that the Current Worth field is of the Number type since it is
intended to display dollar and cent amounts.
Ii: File Edit Format Describe Report Fonts Style Window
-0
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Calculate the report with the 00= shortcut.
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Instead of just listing the networth of each individual, you might
also want to sum the net worth of all stockholders as a group. This
is very easy to do with a computed, or calculated field.
Up to now, we have let Reflex supply default names for each field
and repeating collection created (fields start off at f1 and repeating
collections start off at rl). While this is fine so long as a small
number of fields and repeating collections are involved, things can
get a bit confusing when there are many such objects to refer to. For
the next report, it will be helpful if the current repeating collection
(called rl) is renamed to theWealthy.

Select the repeating collection and select the text (rl)
that appears in the Name Panel at the top left corner of
the window. Type: theWealthy.
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Reflex is now aware that you wish to refer to this repeating
collection as theWealthy instead of simply rl.

Select the netWorth field and rename it to theWorth in
the same manner.
Reflex is now aware that you wish to refer to this field as theWorth
instead of f5.
• It is a good practice to give fields a,nd repeating collections
meaningful names instead of simply using the defaults automatically
supplied by Reflex.

149

Create a new number field and a label outside of the
repeating collection as shown below. Select the field
and click in the formula panel. Enter the formula:
SUM(theWorth from theWealthy).
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Note that this field has also been renamed TotalWorth.

Go ahead and recalculate this report with the 8€b
shortcut. Use the scroll bar to move to the end of the
report and see the value in the field labelled Total
Worth.
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The figure of $2,218,000 represents the sum of the net worth of all
stockholders that appear within the repeating collection you renamed
as TheWealthy. If the repeating collection were only displaying
records for those stockholders living in San Francisco, the Total
Worth field would provide only the sum of those qualified records
displayed.
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• Another way of obtaining the total worth of all stockholders is by
creating a single field and giving it the fonnula: SUM(netWorth
FROM person).
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You can even add a qualification to the single field fonnula so that
you can obtain the total net worth of specific stockholders.
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= "San Francisco")
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Using a fonnula with a single field differs from the use of a
repeating collection in that the single field can only supply a single
summary value - it cannot produce a sequence of records as does a
repeating collection. Also, this field obtains the values it requires
directly from the person database file. The computed field that
works with a repeating collection instead obtains its values from the
relevant fields inside that repeating collection.

151

Using Formulas
with Links &
Multiple Files

In the previous examples, you simply created a set of fields and
placed them inside a repeating collection in order to report on some
values from a single file. What happens when the values you want
to report on are located in more than one file?
Just as spreadsheet programs can work with information located in
any cell of a matrix, Reflex can work with information located in
one or more Sources.
To demonstrate this, let's list all the people that own stocks. This
may seem trivial, but it will provide a good starting point for
understanding how you can use the Links between database records
to search for information.
For this task you are going to need two fields and one repeating
collection. You may redesign any current template in the report or
you can add a completely new one below it - just ensure that it is
exactly the same design as that given below.

Create two text fields in the usual manner. Select the
first one, click in the formula panel and type:
FirstName. Select the second text field, click in the
formula panel and type: Lastname
You now have two fields - with the formulas FirstNarne and
LastName - that will actually display values from each record in the
person file. Now you must use a query, along with a repeating
collection, to tell Reflex which particular set of records in the person
file you are interested in viewing.

Create a repeating collection around the two fields in the
usual manner. With the repeating collection selected,
click in the formula panel. Add text so that it reads as
shown below. Then click in the name panel and add text
so that also reads as shown.
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Let's take a moment to explain what's going on here.
Earlier, when you wanted to get a view on all records in the person
file, the repeating collection was simply given the Source name
"person". Now that you want to see records that meet some specific
criteria (all those people that own at least one stock) you must
qualify the reference to the person file.
In this instance, the qualification refers to the Collection of Links
called theStocks which connects a person file record to associated
stockbuy records. Therefore, the repeating collection will produce a
record for each person showing first and last name values only if the
Collection of Links called theStocks contains at least one stock value
for that person.
Check on this by using the 00= shortcut to calculate the
report.
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You will find that this template will produce a total of 5 names, but
there are in fact 6 records in the person file. In other words, one
person does not currently own any stocks. You can find out the
name of this person by making a small change to the current
repeating collection formula.
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Select the repeating collection by clicking on it. Click in
the formula panel and alter the text to read as shown
below:
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Ilperson WHERE NOT EXISTS(theStocks)
Fi rst Name

Last Name
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Michaels
!
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The simple addition of the "NOT" in the formula will have a
dramatic effect on this template; instead of producing a record for
each person that owns at least one stock, the template will now
produce only one record - it will be for the individual who does not
currently own any stocks.

Discover the name of this individual by calculating the
report with the 00= shortcut.
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You can now use variations of this template to see how some of
Reflex's special functions can be used with formulas to compute
desired report values.
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To find out the names of all stockholders and the cost of their
individual stockholdings create the design template shown below
(you can use the current report or open up another if you wish):
"
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Fi rstname:

Lastname

Cost of Stocks

Note that the two name fields are Text fields and that the field
labelled "Cost of Stocks" is a Number field and must be set as such
via the relevant option in the Describe menu.

Select the repeating collection and then click in the
formula panel. Type: person
The only thing left to do is tell Reflex where to go and look for the
stock cost. Check the database image given at the beginning of this
section. You'll see that the total cost of a each stock that a person
owns is equal to the amount of that stock mUltiplied by the price they
paid for each share of it.
The values you want are stored in the amount and pricePaid
fields in the stockbuy file.

Select the field labelled Cost of Stocks. Click in the
formula panel and type: SUM(amount*pricePaid FROM
theStocks)
This essentially says: "Compute the cost of each stockholding for a
person by multiplying the amount of stock held by the price paid for
it. Do this for each of the stocks that this person holds and then sum
all these costs to get the total cost. You can get the values you need
from the Collection of Links in the person record called theStocks H •
• The general form for this is SUM(formula FROM Query)
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We can pictorially show what is happening here:

FOIlMVLA

FirstNsme LastNsme Cost of Stooks

person:

SOURCE

DESIGN TEMPLATE

-

person

r::::::::::::::J r:::::::::::::.'.1 C:::::::::::::::::.l ....
Rep eat in g Coli ecti on pro""; des
"";ewon the person file

FirstNsme

FirstNarn e :
LastNarne:

person

LastNsme Cost of Stooks

I
I FirstNsme I

[: :I: : : ·:·:~: : :I: ·I: : : ~: ·:·: : I: : : .·r~; ~ ; :.; :; ; ; ; :;: .

rLastN:ame

The first an d last nam e fi el ds 0 btain
their val ues from a pers on rec ord

person
LastNsme
FirstNsme

SUM( am 0 unt • ptic ePai d
FROM theStocks)

LastNsme Cost of Stooks

.............................
I

............................
The cost of each stockh olding is
computed bymultipl~ng the amount
of each stock by the ptic e paid forit.
Use the Collection of Links caJled
theStocks to access these fields in
the stockbuy records

Use the 00= shortcut to calculate the report.
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Although the previous examples show how to use Links to check
whether a person has at least one stock, and how to use functions to
compute desired values, they did not allow you to see the actual
names of the stocks. To get this kind of infonnation you need to
display field contents from the person and stockbuy files at the same
time. In the following example we will also show how to produce a
concatenated field (a single text field which contains values from
more than one field).

Go to the Report menu and select Design.
For the new template you will need two text fields and two repeating
collections as shown below:
•
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Outer repeating collection

Report

Fonts

Style

Window

StockReport

Inner repeating collection
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• The outer repeating collection will obtain the FirstName and
LastNarne values from the person file. We will now arrange it so
that these two field values are displayed in the single field below the
label Name.

Select the outer repeating collection and click in the
formula panel. Type: person.
This tells Reflex that this repealing collection will provide a view on
the person file.

Select the field below the label Name and click in the
formula panel. To produce a concatenated field type:
FirstName&" "&LastName.
•
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El f 1

File

Edit
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Describe

Report

Fonts

Style

Window

StockReport
IIFirstName&" "&LastName

Note the two ampersand ("&") characters - these are the operators
that will join the two values into a single string in the field labelled
Name. Also, there must be a space between the double quote marks
otherwise the the first and last name values will be displayed as one
long string of characters instead of a first name, a space, and then a
last name.
What about the stockname value? It does not reside in the person
database file, so where exactly do you look for this information?
Remember that in one previous example you used the Collection of
Links called theStocks to give the cost of each person's
stockholding. Can you use the same Collection of Links to obtain
the actual names of each stock that a person owns? Yes, partially.
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• The inner repeating collection will obtain the names of the stocks
that each person owns by providing a view on the Link called
theStocks.

Select the inner repeating collection and then click in the
formula panel. Type: theStocks
This inner repeating collection will now provide a view of each
individual's stockholdings for the field placed inside it. What values
should this field actually display? Check the file images given at the
beginning of this section. Note that you can get the stock name
values from the Link called theCompany and then the field called
stockName. To get access to the stock name information, just
supply the field name you wish to display and the location of that
field.

Select the field inside the inner repeating collection.
Click in the formula panel and add the text shown
below:
•
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I theCompeny's stockNeme

Essentially, this reference to the Link called theCompany says:
"For the current person and his current stockbuy, get the name of
the stock via the Link called the Company ".
Nested repeating collections, such as in this example, are used for
producing lists of lists, or in other words, for producing a list of
objects and for each such object, a list of additional objects.
In this example, we are producing a list of people, and for each
such person a list of the stocks that person owns.

159

Reporting on the Stocks Database

We can pictorially show how this template works:

FORMULA

SOURCE

DESIGN TEMPLATE

Name

Stock Names

person:

person

r:::::::::::::::::::::::::::::::1
Outer repeating collection
a ~e'w' on the person file

Name

FirstName&" "&LastName:

pro~des

person

Stock Names

[-: ,: .;.·:.:-.:~: : .~ :,: .: : : :.-'r.~-'0):) ~]
The first an d last nam e fi el d val ues
are concatenated by the use of the
ampersand and double quote
characters
Name

Stock Names

LastName

I

FirstName

I

person
LastName
FirstName

stoclc:buy

theStocks :

the Person
theComp.8fty.

The inner repeating collection pro~des
a ~e'w' on the stocks that a person o'w'ns
~a the Coli ecti on of Links call ed
theStocks

person
Last Name
FirstName
theStocks
Name

Stock Names

theCompSn'fs stockName :

The field in the inner repeating
coli ecti on 0 btains the st ock nam e
from the Link call edt heC om pany
and the field called stock Name
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theStockholders

stoclc:buy
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To see the results of the design template calculate the
report with the 00= shortcut.
A report listing all stockholders and the stocks that they currently
own will appear. Use the scroll bar to see more of the report than
can be seen in the window at one·time. Note that there is an empty
space next to the name Ralph Jeffries since he does not currently
own any stocks.
•
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The above example shows how you can use a sequence of names
(eg: theCompany's stockName) to refer to Sources and the values
their fields contain. Refer to the sections on Functions and Formulas
and the next section - Details and Techniques - for further hints and
guidance on creating databases and reports.
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Section Three
Details and
Techniques

Details and Techniques

Reflex Icons

There are a number of Reflex icons you will encounter:

The Reflex program icon: There are a number of ways of
Reflex

starting Reflex from the Finder. You may select the icon and then
choose the Open option in the Macintosh File menu or you may
simply double click on the icon. Alternatively, select the icon and
then choose the Startup option located in the Special menu - the next
time you use the disk the Finder will automatically start Reflex for
you. For more information on this latter topic, refer to the Macintosh
owners guide.

The Database Document Icon: All database document icons
take the form of a group of file cabinets. Can be opened from the
Finder by first selecting it and then using the Open option in the File

The Report Icon: All Report document icons take the form of a
stylized print-out. Can be opened via the Open option in the File
menu or by a double-click.

El1EJ

Bad[;]

o

The Damaged database icon: Although it will rarely be seen,
there is a special "damaged database" icon that appears when you
create a new file and, before it is completely saved, the Reflex
program terminates because of a system or program error.

The !sortscratch file icon: From time to time a generic icon
with the name !sortscratch may appear on the desktop. This is the
sort scratch file; it takes up no space on disk and helps speed
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up each sort operation since the file does not need to be created
during sort operations. If !sortscratch is deleted for any reason, it
will be recreated as needed.

o
Obtaining Help

The !sorttemp file icon: Temp files with this name - plus a
version number - will only appear when there has been a system
crash. They should be deleted since they serve no useful purpose
and take up disk space.
Reflex's major help function is available in one of two
ways:
> Select the Help option from the. menu. A Help window will
appear which contains a range of choice buttons and a list of topics
on which Help is available. Select the topic you need help on and
click on the Show Topic button.
Help
D
( Stww ropi( ) (ShOW !ndeH ) ( Cancel
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Field Data Types
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Show Topic will display relevant Help text.
Show Index will return you from within a particular topic to the
main Help Index to make another choice.
Next and Previous move you from within a particular topic to the
next or previous Help topic.
Cancel returns you to Reflex.
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To get an explanation of almost any item on the screen
or any menu command:
> Hold down the 88 key and then press the question-mark ("?") key;
it doesn't matter if you use the Shift key or not. The arrow cursor
will tum into a large question mark. A description of almost any
item or menu command can be obtained by placing the question
mark cursor over the particular item and clicking the mouse button
once. The Help window, as described previously, will appear and
Person Info
FirstName
LastName
6i rthDate

iRo·jJ·s·ri"s··············..········..·································1
f2··/·Y:3?4·S·::::::::::::::::::::::::::::::::::::::::::::::::::::::::j
:. ...................................................................................:

Enter Data

I

display the explanation you seek.
Note that this latter form of Help cannot be used with dialog boxes they are either self-explanatory or have their own Help feature (as
with the QueryBuild dialog).

Designing &
Creating
Database Files

There are two very similar methods of creating a new database file:
the first is available anywhere while the second is only available
when the Overview window is active.

To create a new database file:
> Go to the File menu and select the New Database File option.
Reflex will display a standard file dialog box requesting that you
supply a name for the new file. Enter the chosen name and click on
the Create button or press the Return or Enter key. Reflex will then
place a file image for the new file underneath the last file image in
the Overview window.
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> Place the cursor at the position where you wish the new database
file image to appear. Hold down the mouse button and move the
cursor to the right - a black box will appear. When the box has been
drawn, go to the File Menu and select the New Database File option.
Reflex will display a standard file dialog box requesting that you
supply a name for the new file. Enter the chosen name and click on
the Create button or press the Return or Enter key. Reflex will then
place a file image for the new file at the position you indicated with
the black box.

Note: If you attempt to give a new database file the same name as
an existing file a dialog box will appear asking if you wish to replace
the old with the new. If you click on the Yes button you will lose all
data stored in the existing file and anew, empty, database of the
same name will be displayed in the Overview window. If you click
on the No button, you will be able to enter another, unused, file
name.
Moving and
Resizing File
Images

Database file images may be moved and/or resized whenever the
Overview window is active.

To move a file image:
> Click once on the name bar and then, with the mouse button still
held down, move the file image to its new location. Moving the file
image down to the bottom edge of the Overview window will cause
the contents of the window to scroll. Reflex always saves the
location of a file image when you hide it or quit from the program so
that it will appear in the same place the next time you call it up.

To resize a file image:
> Click once on the file image name bar ( avoid clicking on the
status icon at the top left comer, however, since this will "Hide" the
file image). Resize the image by dragging on the small white box
that appears at the lower right-hand comer. If a file image contains
empty space (where a field was deleted, or you just made it too big),
Reflex will automatically discard the unused space when the file is
removed from the Overview and then called up again.

Note: File images cannot be overlapped like windows. If you
attempt to Show a file image and there is not enough room left in the
current Overview window display area, Reflex will scroll the
window upwards and place the requested file image below all
others. The same goes for any situations where you try to overlap
one file image with another.

168

Details and Techniques

Entering Field
Names in File
Images

Once a new file image has been created in the Overview window
you can then start entering field names. Reflex allows up to 255
fields per record provided their combined size does not exceed 1002
bytes. The maximum field name length is 32 characters.

To enter fields in a file image:
> When a new file image is created, the first field space is already
selected for you so you can type in the first field name straight
away. Subsequent fields may be entered by going to the Overview
menu and selecting the Insert Field option or by pressing the Return
key.
> To add fields to the end of a group of field names, just click once
on the last field name and use the Insert field option or press the
Return key. Enter the new field name.

> To add fields within an existing group of field names, just click
on the field name above where you want the new field to be
positioned and then use the Insert Field menu option. A new field
space will appear where you can enter the new field name.

Editing &
Deleting Field
Names in File
Images

Deleting an
Existing Field

To select an existing field name:
> Click on the field name once - the whole field will be selected.
You cannot edit the field name text at this point, but you can move
the field up and down in the file image and you may use any of the
valid options in the Overview window menus.
> Specifically, a field name selected in this way can be deleted from
a file image by using the Clear option in the Edit menu. If you
attempt to do this with a database file that contains data, Reflex will
first display a dialog warning you that you will "lose all data for that
field" if you proceed. If you ever delete a field in error, you may
undo the action by immediately using the Revert to Old Design
option in the File menu.
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To edit field name text:
> Click on the field name twice. This will place a text insertion point
at the current mouse cursor location. Use standard Macintosh text
editing techniques to edit the existing text. Fields can be renamed in
this manner. You cannot move a field name in a file image when it is
selected as text. Nor can you draw a Link line from a field selected
as text.
Setting Field
Types

Reflex provides seven field data types: Text, Number, Integer, Date,
Time, Logical, and Sequence Number. Each time a new field is
created its default type is Text.

To create other field types:
> Select a field name. Go to the Describe menu and choose the field
type you require. A check mark will appear alongside the relevant
Describe menu option whenever that field is selected.

You may change the field type of an unsaved database file whenever
you wish. Use this feature with caution on an existing database
since it can lead to errors once a file contains data. An example
might be when you attempt to change a date field to a Number field;
this will result in an error dialog informing you that "A value was
not valid for field "X" of File "XXX". In other words, you cannot
change a Date field (which contains values in the format
Month/Day/Year) to a Number field (which expects values in the
form of Integers with an optional fractional part). On the other hand,
it is possible to change a Date field to a Text field without any
problem since the Text data type can handle all other data type
formats and values. However, you will not be able to do every
operation with a Text field value that you can with the other types. If
you do ever encounter the error dialog mentioned above while trying
to save a file modification, Reflex will halt the save procedure and
recommend that you revert your database file design to the last saved
version. The database design cannot be saved while invalid values
exist in file records.
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A special case is the Sequence Field type. This field type can be
used to automatically tag records with record numbers as they are
entered or to provide a numbering system for employees, customer
orders, checks, or whatever. There may be only one Sequence field
per file (the Sequence field option will be deactivated if the currently
selected database file already contains a Sequence field).

Note: More specific information on data types and their range of
valid values is provided in the section entitled Reflex Formulas
and Queries in the Reference Section.
Creating Key
fields

Record Keys are required so that every record in a database file can
be uniquely identified (a Key is composed of one or more Key
fields ). You can only set or modify Key fields in file images
displayed in the Overview window. All fields set as part of the Key
are clearly identified by means of an underline.

To create Key fields:
> Select a field name in a file image that you wish to make a Key
field (the whole field or just the field text may be selected). Go to the
Describe menu and select the Key Field option or, alternatively, use
the OOK shortcut. If there are no other Key fields, the first field you
make a Key field will move up to the top of the file image. If other
Key fields exist, subsequent Key fields are positioned immediately
below the last Key field and immediately above the first non-key
field.
> Alternatively, a non-key field can be automatically converted into
a Key field by clicking on it once, and then dragging it among a
group of Key fields. You cannot move a field name while its text is
selected.
> A Key field can be made a non-key field by selecting it and then
choosing the Non-Key field option in the Describe menu.
> Alternatively, a Key field can be automatically converted into a
non-key field by selecting it and then dragging it among a group of
non-key fields. You cannot move a field name while its text is
selected.
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Since Reflex automatically sorts database file records by the existing
Key, any changes you make to the Key will affect the order in
which records are displayed in the relevant data entry window.
Reflex will not allow you to open or save a file design which does
not include at least one Key field.
N ole: When you reposition fields in a file image, this does not
automatically reorder the fields in the file's data entry form. Also, all
position changes made to non-key fields in file images are not saved file image field names will appear in the data entry form order the
next time the file image is shown or opened. You can, however, use
the Reflex Form Layout option to modify the data entry form as
desired. If you modify a data entry form, the order of field names in
the associated file image is not updated until you remove it from the
Overview window and call it up again.
See Example 1 at the end of this section for a description of how to
convert a database Key from one type to another. See Example 2 for
a description of how to convert a single name field (firstname and
lastname in one field) to two fields (lastname and then firstname).

Setting the
Justification of
Field Contents

Reflex allows you to arrange the format of individual field contents
while a file image is displayed in the Overview (also see the sections
on Form Layout and Reports). The default fonnat is to have field
contents left justified.

To set field contents in a file image:
> Select the field by clicking on it (the whole field or just the text
may be selected). Go to the Format menu and choose from among
the Contents Left, Contents Right, and Contents Center options.
New values entered in the associated data entry form will be justified
as specified. Existing record values will be reset as specified.

Setting Field
Display Formats

Reflex provides default display formats for Number, Integer, and
Date fields. You may alter these display fonnats as you wish.

To change a Number or Integer field display format:
> Select a field of type Number. Go to the Format menu and select
the Display Format option. Choose the format you desire from the
possibilities presented in the dialog box that appears.

172

Details and Techniques

To change a Date field display format:
> Select a field of type Date. Go to the Format menu and select the
Display Format option. Choose the format you desire from the
possibilities presented in the dialog box.

Fixed/Variable Text display format:
The Text field display format dialog is only available when the
selected text field is in a Report. A Fixed Height text field is of
constant size, regardless. During report design activity a variable
height text field will always appear as big as you initially made it.
During report display, a variable height text field will shrink to the
minimum height allowed by the text it contains (this may be zero to
n lines).

Note: Reflex expects to be given plain Number and Integer values
which it then converts into any specified display format. For
example, entering the number" 1" in a Number field set to the
Percent display format will result in the value "100%" being
displayed. Reflex will generate an error message if you attempt to
enter "100%" directly since this is not a valid Number value. The
same is true for Date fields. Just enter the date in the standard
Month/Day/Year format and let Reflex convert the value into any
specified display format.

Creating Links
Between File
Images

The Reflex method of linking the records in multiple files is based
on the notion of drawing a line - called a Link line - between names
in file images displayed in the Overview window. Only a single
Link line is drawn between two names, but a single file image may
have more than one Link line between it and other file images.

An example of creating a Link line in new or existing
database files:
> Insert a name which will act as the Link in file Alpha. Insert a
name which will act as the Link in file Beta. Select the whole name
in either file image by clicking on it once - you cannot draw a Link
line while a field is selected as text. With the mouse button held
down, move the cursor over to the name in file Beta. A line will
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appear between the name in Alpha and the cursor tip. When the
cursor tip is over the name in file Beta, let go of the mouse button. A
Link line will bridge the two names which now appear in bold type
and are referred to as Links. You may confirm the design by using
the Save Design option in the File menu.

Important: You cannot draw Link lines between existing field
names (field names of database files that have previously been
saved). Any attempt to do this will result in an error dialog box.
Refer to Example 3 to see how the records in existing independent
files can be linked. This technique can be used to convert files from
other applications into Reflex files with Links.

Deleting Links
Between File

Images

Links may only be deleted in the Overview window; the exact
procedure depends on whether you are working with new, unsaved
database files or existing files.

Important: Be aware that because Links always come in pairs
(there are always two Links connected by a single Link line), you
cannot delete only one of them. Selecting and deleting one Link will
automatically delete the other Link.

To delete Links from an unsaved database:
> Select either Link by clicking on it once. Go to the Edit menu and
select the Clear option. The two Links and the connecting Link line
will be removed.

To delete newly inserted (and unsaved) Links in an
existing database:
> Same procedure as above.

To delete Links from an existing database:
> Select either Link by clicking on it once. Go to the Edit menu and
select the Clear option. A dialog box will appear informing you:
"If you delete this field you will lose all the data for that field. You
can choose Revert to Old Design in the File menu to undo all
changes. to the design."
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Click on the OK button to continue with the Link delete. Click on
the Cancel button to halt the Link delete.

Setting Record
Links

Reflex allows the Links between the records in files to be one-toone, one-to-many, and many-to-many. Links may only be set when
the relevant file image is displayed in the Overview window. When
a Link line is drawn between two Link names, both the names are
Links to one ".. " Record (one-to-one) by default.

To create a one-to-many record Link arrangement:
> Select the Link you wish to be the "many" side. Go to the
Describe menu and select the A Collection of Links to "... " Records
option. You do not need to alter the setting of the other end of the
Link line since it is already a Link to one " ... " Record.

To create a many-to-many record Link arrangement:
> Select a Link. Go to the Describe menu and select the A Collection
of Links to "... " Records option. Select the other Link. Go to the
Describe menu and again select the A Collection of Links to "... "
Records option.

Note: Links may be all or part of a record Key so long as they are
not A Collection of Links to ".. " Records. This is because you
cannot have an object containing one or more (multiple) values as
part of Key.
Saving File
Designs

You may save a file design provided that it contains one or more
fields, at least one field set as the Key, and it does not contain any
invalid field values (see Setting Field Types, above).

A new file design may be saved by:
> Going to the File menu and selecting the Save Design option or by
using the OOs shortcut. After a short time the X mark in the status
icon will disappear, signifying that the database file is ready to be
opened. Alternatively, new files only may be both saved and opened
in one procedure when you double-click on the name bar (not the
status icon) of the file image.
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An existing file that has been modified may be saved by:
> Going to the File menu and selecting the Save Design optionor by
using the oos shortcut. Alternatively, you may double-click on the
relevant file's name bar whereupon a dialog appears asking you if
the modifications should be saved or if you wish to cancel the
database file open.

Note: If any problems are encountered by Reflex during a save (the
file has no Key field, for example), a dialog will be displayed
informing you of the probable cause.

Showing
Database File
Images

When file images are displayed in the Overview window they are
not opened - the image simply provides you with an overall view of
a file's design and provides a focus for modifications to that design.
To Show a single file image:
> Go to the Overview menu and select the Show Database File
option. A standard file dialog will appear asking that you indicate the
name of the file to be shown. Select the name from the file list and
click on the Show button. The file image will appear at its last saved
position unless another file image blocks the way.

To Show the file(s) linked to the currently displayed
file:
> Make sure that the currently displayed file is selected. Go to the
Overview menu and select the Show Linked file option or use the
ooG shortcut. Any linked file(s) will be displayed.

Note: If you have renamed or deleted a linked file at the Finder
level, Reflex will not be aware of this. Refer to Example 4 on how
to deal with this situation.

Hiding File
Images
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When file images are removed from the Overview window they are
not affected in any way - they are simply no longer displayed.
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To Hide a file image:
> Select a file image. Go to the Overview menu and select the Hide
Database File "... " option.

Or, to remove an image more rapidly:
> Click once on the status icon located at the top left comer of the
file image.
Note: File images cannot be hidden if they have been modified or
there is some outstanding error. First save the modifications, or
revert to the last saved version, and then try to hide the file image
once again. Also, file images cannot be hidden while their associated
window is open. In this situation simply close the window and try
to hide the file image again.

DATA ENTRY
The Data Entry
Form Window

After you have successfully created a Reflex file you can then open
it for data entry. Reflex data entry forms are initially presented in the
default format shown below:
Ii File Edit Format Describe Database Search Misc Window

This standard form allows you to immediately start entering data
without having to worry about field layout. If you wish to change
the default form layout to something of your own choosing, you can
do this by selecting the Form Layout option from the Database
menu.
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All data entry windows feature:
> A name panel and a formula panel at the top.
> The Name Panel displays the name of the currently selected field.
The name panel can be resized horizontally to accommodate longer
field name.s (up to 32 characters).

> The Formula Panel is where you directly type in formulas and
queries to find records that meet certain qualifications. Alternatively,
the QueryBuild option will automatically construct a formula or
query based on information that you supply and then paste the result
directly into the formula panel. The formula panel can be resized
vertically to accommodate long formulas.
A data entry window will always have the message "Data Entry"
showing in the activity indicator at bottom left of the window.
Validation of
Field Entries

To enter information in a database file record you simply type valid
values into the fields that a record contains. There are a two criteria
that define whether a field entry is "valid".

Field Types:
> The first test of whether an entry is valid is dependent on a field's
type. Date fields expect to see information in a date format
(month/day/year), Integer fields only expect to see whole number
entries, and so on for the other five data types. Invalid entries will
result in a dialog which offers field specific advice on remedying the
error.

Field Qualifications:
> Reflex allows you to set up entry qualifications for each field in a
record so that only values within an acceptable range may be typed
in ( dates and times within a particular period, employee numbers
above a certain level, part numbers starting with a particular
character, etc .. ).
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Creating Field Qualifications:
> You may only enter field qualifications during Form Layout
activity. Simply select the relevant field and click in the formula
panel. Enter the qualification you require.
'
N ole: Records that contain invalid field entries cannot be inserted
into the database. The first time you attempt to save the unacceptable
record Reflex will display a dialog telling you of the problem and
offering some samples of valid field entries. If you try to close the
data entry window, Reflex will then display another dialog which
says:

"In spite of the preceding problem, do you want to close this
document anyway? You will lose your changes to the last record
modified".
Clicking on the Don't Close button will return you to the data entry
form. Clicking on the Close Anyway button will close the form and
discard changes in the problem record.
It is important to ensure that a field qualification does not conflict
with the type of field it is associated with. For example, creating a
qualification that requires a specific text character to be entered at the
beginning of a Number field will: A) Result in a field type error
dialog if you do enter the text character in the number field during
data entry; B) Result in a field qualification error dialog if you do
not enter the text character during data entry. If this situation ever
occurs, simply select Revert to Old Record and then choose the
Form Layout option from the Database menu. When the Form
Layout window appears select and change the field qualification. It
is up to you to make sure that field qualifications are appropriate.

For a fuller description of field types and the scope of acceptable
values for each, see Interlace Formulas & Queries in the
Reference section. See Example 5 for a description of how to create
field qualifications.
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Entering Records
Into a Database

Entering information into a blank new record:
> Prior to typing the first character into a record field, there is no
status icon in the top left comer of the data entry window next td the
name panel. When the first character is entered, Reflex displays an
"X" mark next to the name panel signifying that the record has been
modified. Saving the new record replaces the X mark with a
document shaped icon signifying that the record is now part of the
database.

Modifying an existing record:
> Prior to modifying the existing record, there is a document-shaped
status icon at the top left comer of the data entry window. When the
record is modified, an "X" mark appears in the document-shaped
icon signifying that the displayed copy of the record no longer
matches the version saved on disk. Saving the modified record will
remove the X mark from the status icon.

Note: The tab order in data entry forms is always left to right/top to
bottom (i.e. the order of fields in the Overview file image is not
used). When you reach the last field of a record~ pressing the Tab or
Return key wraps the field selection back to the first field. The
Return Key works just like the Tab key except within Link
Collections where pressing Return will produce a blank new Link.
Pressing the Shift key along with the Return key while ina text field
will enter a carriage return in that field. The Shift-Return character in
text fields appears in export/import files as the Line-Feed character
(Control-J).
Record Validation
& Saving
Records

Reflex checks all aspects of a new record before it inserts it into a
database file.

Selecting the Enter Record option in the Database Menu
or pressing the Enter key:
> This action causes Reflex to: A) Make sure that field values meet
any existing field specifications; B) That there is at least one Key
field that is not empty; C) That the new Key field values are not a
duplicate of an existing record Key; D) That the fields inside any
Links are the Key of some linked record (if Link checking is turned
on). If the record passes these tests, it is then inserted into the
database. If the Enter key was pressed, a new blank record is
displayed in the data entry window.
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Selecting the Save Record option in the File menu:
> This places the current record into the file to which it belongs
provided it has passed all the validation tests. This command also
writes all record changes made to disk so that the disk copy of the
file is as accurate as possible.
Note: It is possible that you may encounter an error dialog when
saving a record to disk - the disk may be full, for example. If the
disk is full, simply return to Reflex by clicking on the OK button of
the dialog that appears and then use the Save As option located in the
File menu to place the unsaved file on another disk.
A single database file may not span disk volumes, but the individual
members in a multiple file database may exist on totally separate
disks. However, be aware that with the Hierarchical Filing System
(HFS) by Apple, Reflex will not automatically find the member files
of a multiple file database if they are stored in separate folders. If
you cannot store related databases in one folder on a single disk,
you must: A) Make sure that you have displayed the relevant file
images in the Reflex Overview window; B) Open the files.

The Auto~Save
Feature

Reflex incorporates an auto-save feature which ensures that changes
to database records are saved at regular intervals.

> If there is no activity within Reflex for approximately two minutes
all changes made to all open database files are automatically saved to
disk.
Note: As with other data saving procedures, problems (such as
disk full errors) can occur during an auto-save. An informative
dialog will be displayed on these occasions.

Data Entry Form
Layout

To change the design of a data entry form you must select the Form
Layout option from the Database menu.
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The switch into Fonn Layout is clearly indicated by three visual
clues:
•

File

Edit
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Describe

Layout

Fonts

Style

Window

newdatabase

I

> The most obvious change is that a design grid appears behind the
fields and field labels. The grid aids in field and label positioning (it
can be turned off if you wish) and there are a range of fonnatting
options available in the Fonnat menu that make accurate positioning
very simple.
> The data entry fonn activity indicator contains the message "Fonn
Layout" instead of "Data Entry".
> The Database menu is replaced by the Layout menu.

You modify data entry form designs by:
> Selecting a label and changing the default name supplied by
Reflex. The font and style of labels and field contents may be
specified by selecting the object and then selecting the appropriate
option from the Fonts and Style menus. The default font/style for all
newly created objects can be preset to a particular font and style. To
do this, click down on blank space in a design window and select
the relevant menu options. All installed Macintosh fonts and
sty les are supported.

•
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> Selecting a field or label and changing its position and/or size.
When you click once on a label or field you will select the whole
field and this will display the object's handlebar (for moving the
object) and its resize box (used to make the object larger or smaller).
You cannot move/resize a label or field when its contents are
selected (you have clicked twice on the object).
> Multiple objects (labels, fields and pictures) may be moved as a

group by using the Shift-Click technique. First select one object in
the group to be moved. Then, with the Shift key held down, click
on all the remaining members of the group. You can now let go of
the Shift key and move the objects. If you change your mind and do
not wish to move all the selected objects, you may deselect specific
members of the group by clicking on them once again with the Shift
key held down.

Note: Selected objects may be manipulated by any valid Reflex
menu option (you may use the Duplicate option in the Edit menu, for
example). Be aware that Reflex will not allow you to overlap objects
in data entry forms (or reports) so all object manipulations must take
account of this fact.
Data entry forms (and reports) are "infinite" in size to the right and
down. However, the window elevator boxes will only take you as
far as the last object in the right/down direction. If you wish to
move beyond the last object(s), just use the window scroll arrows.
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Pictures in Data
Entry Forms

Pictures can be added to data entry fonns to improve their
appearance or to match some existing fonn that you use.

To add pictures to data entry forms:
> Copy the desired picture to the Macintosh clipboard from
whatever graphics .program you are using. Open up the data entry
fonn that is to receive the picture and then choose Fonn Layout fron
the Database menu. When the Fonn Layout window' appears click
down on blank fonn space to obtain a small black box. Select the
Paste option from the Edit menu to insert the picture into the fonn.
The picture will appear as part of each record in a file.

Note: Fields may be embedded (placed within) pictures that are
pasted into data entry fonns. An example of this is given in Exampl~
6 at the end of this section. Make sure that you only paste in final
versions of pictures since you cannot edit pictures within Reflex.

Creating Reports

When you select the New Report option from the File menu, a
dialog appears asking you to make a choice between a table-style
report on a file and a report which you design yourself. There is no
fundamental difference between these two report options, it is just
that Interlace provides you with a basic report framework - the table·
style option - which can be modified as desired.

The Table-Style Report:
> This report fonnat will display file records as rows across the
screen; as many fields as can fit will be shown, but you can always
scroll to the right to view those fields beyond the right window
boundary.

To create a Table-Style Report:
> Select the New Report option from the File menu. You will be
given the choice of a report on any currently selected database; a
report on another database; or a report you design yourself.
Selecting the first option will then display a dialog which asks whict
fields you want to include in the report. Secondly, you are presented
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with the QueryBuild dialog which allows you to tell Reflex which
records from the file you want to view. If you want to see all
records, just click on the Find All button. A complete listing of the
file records will appear (you will have to use the window scroll bars
to see those records outside of the window display area).
The second report dialog option - a report on another database allows you to specify which file you wish to produce a report on - it
does not differ from the first option other than that.
If you wish to set up a record qualification with the aid of
QueryBuild, specify the field names to search, the operator to use,
and the value to find. Only those records that meet the qualification
will be listed. They can then be printed via the Print option in the file
menu.

Custom Reports:
If you want to produce an Reflex report from scratch you will select
"A Report you Design yourself'. Here, you do not initially specify
which file will be reported on since you will probably want your
report to obtain information from many Sources. (Of course, any
new or existing table-style report may be altered to do this). The
process of creating a custom report is essentially freeform and, as
such, can involve many actions. You are able to search one or more
files for highly specific values, you can specify the way that report
data will appear, you can include computed fields, and you can set
up repeating collections. (See Repeating Collections below for
further information on this topic.)

To create a custom report:
> Select the New Report option from the File menu. Select the last
option that appears on the report dialog - A report that you design
yourself. Reflex will then open up a blank report window for you.
After specifying where report data will be obtained from (by means
of formulas and queries), you calculate the report just as you might
calculate a spreadsheet file with the Calculate option in the Report
menu or the 00= command shortcut). On calculation, a welldesigned report will display actual values in field positions
according to the formulas you entered. If Reflex is unable to
successfully produce a report field value, the report calculation
procedure ends and either an error message will appear in the
affected field or an error dialog appears telling you the type of
problem that has occurred.
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The contents of reports can be printed, referenced by other reports,
and exported as a mail merge text file. Repeating collections within
one report may be referenced by repeating collections in other
reports exactly as database files are referenced.

Note: An additional feature is that report contents can actually be
converted into Reflex database files by exporting them to a text file
and then importing them back into a database. See
Importing/Exporting Data, below, for more information on this
topic.

Names

A Database file, a report, fields in database files and reports, Links
and Link collections, and Repeating Collections can all have names.
A name is starts with either an alphabetic character, an underbar or a
number sign followed by up to 31 alphabetic characters, underbars,
number signs, or digits.
To name an Object:

> Files and reports are given names when you invoke NewDatabase
File or New Report in the File menu and enter a name into the
standard file dialog box that appears. Database fields are created and
given names in file images displayed in the Overview window. To
name all remaining objects simply select the object, then either select
the text in the Name Panel or select Edit Name from the Report
menu.
Names in Reports:
> In reports, all fields are given default names starting with fl.
Repeating collections are given default names starting with r 1. It is a
good practice to change these defaults to something more
meaningful.
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Name uniqueness:
> Report and database file names must be unique within the disk
volume (if you have Apple's new HFS system, they must be unique
within the Finder folder). Database field and Link names must be
unique within a single file (you cannot have two fields with the same
name in that file, but you may have two fields in different files with
the same name).
> Directly within the bounds of a report or repeating collection
names must be unique. In other words you cannot two fields with
the same name in a given report or repeating collection, but you may
have two fields of the same name provided one is within an inner
repeating collection.

Referencing objects by name:
> To reference a database file or report simply supply its name in a
formula. If you wish to refer to an object inside a database file or
report, you can supply a sequence of names that leads to that object.
At the simplest level, a name sequence could specify a field name in
a report. At a more complex level you may: A) Refer to a field in a
database file by the Link names that lead to it; B) Refer to a field
within a single repeating collection or nested repeating collections by
the name of the report and the repeating collection(s) that enclose the
field.

> Within repeating collections, you can refer to objects in the
associated Source just by using their name in a formula. If an object
with that name is not found, Reflex then looks to see if there is a
"CALLED" synonym for that name (see Reflex Formulas & Queries
for more information on Called). Otherwise, Reflex looks to see if
there is an object within the repeating collection with the specified
name. If none of these searches succeed, Reflex goes to the outer
repeating collection (if any) and once more attempts to search for the
name. Names on the left-hand side of a FROM operator are treated
in a similar manner. Reflex will first attempt to find the name within
the Source specified on the right-hand side of the FROM operator.
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Note: Case is not significant in names. Also, space characters are
not changed to the underbar ("_") character within the formula
panel. Be aware that the spelling (upper/lower or upper and lower)
of a given name is shared within a report or database file and that tht
most recent spelling entered becomes the model for future entries of
that name. For example, if you had a field in one repeating collectior
called J obStatus and you added a field called jobstatus in another
repeating collection, both would then appear as jobstatus.

Repeating
Collections

A Repeating Collection is the report mechanism which provides a
view on the records in a database file or even in another repeating
collection. Repeating Collections may be nested (placed within each
other) so that you can produce lists of lists.

To create a Repeating Collection:
> Draw a generic black box anywhere in a report window. Go to the
Describe menu and select Repeating Collection option. A repeating
collection, recognizable by its two vertical handlebars, will appear.

To nest repeating collections:
> Simply create or place them within each other. Be aware that
repeating collections may not overlap each other - as with all
Reflex objects except pictures.

Note: It is important that you always change a Repeating
Collection's default name to something more meaningful- see
Names, above. Be aware that when a report is closed only the
Design Template of a repeating collection is saved to disk - the data
it displays is not.
Importing!
Exporting Data

Data may be exported/imported from/to databases and reports. Then
are three data transport methods that are supported.

The Clipboard format:
> This option allows you to export qualified records to or import

suitably formatted information from the standard Macintosh
clipboard. The data format is the same as for Text files, only the dat;
is held in the clipboard.
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The Text File format:
> This option allows you to export/import records in text file
format. Reflex separates each field in any text file with a tab
character and ends a record with a carriage return. In the case of
records which contain a Link, both the single-valued fields and the
Key field copies inside the Link are separated by tabs - a single
carriage return character marks the end of each record.

For example:
Field(tab)Field(tab)Link Key field(tab)Link Key field(tab)Field(cr)

In the case of records which contain both single value fields and
Link Collections, the format is a little different. Single-valued
fields are separated by tabs and the last one is followed by a carriage
return; each Link within a Link Collection is placed on a separate
line with tabs separating Key field values and a carriage return at the
end of each Link. The last Link of a Link Collection is ended with
two carriage returns.
The example below shows how a record that contains three singlevalued fields and a Collection of Links containing three Links might
be exported:
Field(tab)Field(tab)Field(cr)
Link Key field(tab)Link Key field(tab)Link Key field(cr)
Link Key field(tab)Link Key field(tab)Link Key field(cr)
Link Key field(tab)Link Key field(tab)Link Key field(cr)(cr)
Field(cr)

The Mail Merge format:
This option allows you to export/import records to or from a text file
in a mail merge format. You will then be able to use the mail merge
file with word processing programs such as Microsoft Word™ to
produce personalized letters, circulars, etc. The only difference
between this format and the standard text file format is that there is a
header at the beginning of the file which lists the names of the fields
that make up each record and certain text strings are delimited with
quotes (eg: empty fields, and fields with embedded commas). Refer
to the Microsoft Word user manual for more specific information on
how to make best use of this feature.
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To export all database file records:
All or just some records may be exported from a database file.
> Open the relevant database file and select Export Records from the
Misc menu making sure that there is no Record Qualification in the
fonnula panel. A dialog will appear asking that you specify the
export fonnat. You may choose from the three options described
above. Next, another dialog appears requesting that you specify the
fields from which to export data. Select each relevant field and click
on the Include button (to include all fields, just click on the Include
All button). If you are exporting to the clipboard, Reflex will
proceed with the export procedure. If you are exporting to a text or
mail merge file, you will be asked to provide the file name.

Exporting Information from a subset of a Database:
> Open the relevant database file. Enter a Record Qualification in
the fonnula panel (you may use the First, Last, Next, Prior Record
commands to verify your record selection). Then proceed with the
record export as detailed above.

Exporting Information from Report Fields (outside of all
repeating collections):
> Make sure that no repeating collection is selected. Invoke the
Export Data option in the Report menu and a dialog will appear
asking that you specify the export fonnat. You may choose from the
three options described above. Next, another dialog appears
requesting that you specify the fields from which to export data (the
list will only contain the names of fields not contained in any
repeating collection). Select each relevant field and click on the
Include button (to include all fields, just click on the Include All
button). If you are exporting to the clipboard, Reflex will proceed
with the export procedure. If you are exporting to a text or mail
merge file, you will be asked to provide the file name.

Exporting Information from Repeating Collections:
> Select the relevant repeating collection by clicking on it. Proceed
as above, but be aware that the export field list will only contain the
names of the fields contained within the selected repeating
collection.
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In other words, you may only export data from the fields within a
single repeating collection at a time. The chosen fields will be
exported for all records in that repeating collection, no matter if they
are nested under different repeating collections.

Note: A useful feature of Reflex is that report data may be used to
create new database files or update the information in existing
database files. See Example 7 for a description of how to use report
data to update the records information in an existing file.
Printing

The Overview:
> You may produce a hard-copy version of a database design (for
documentation purposes or whatever) by printing the file images
displayed in the Overview window. Simply make the Overview
window active and select the Print option from the File menu. Be
aware that all file images available in the Overview window (not just
those visible) will be printed.

Database Records:
> You may obtain copies of individual database records by selecting
the Print option from the File menu when the relevant record is
displayed in the active data entry window.

To print Report designs:
> Open a report window and make sure that the activity indicator
reads "Report Design". Select the Print option in the File menu.
Fields and repeating collections will be printed in their box-like
design appearance. You will only be able to obtain a print-out of the
design template and not the data produced by a repeating collection.
Special objects such as Page Break icons are also printed.

To print Report data:
> Open a report window and make sure that the activity indicator
reads "Report Display". Select the Print option in the File menu. The
data contained within a repeating collection will be printed as
appears on the screen. Although repeating collections and field
boxes are visible on the screen in display mode, their box-like
borders will not be printed.
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Note: Objects (a label a picture, for example) below a repeating
collection in a report design float down in the report display to
maintain the same distance beneath that repeating collection. Objects
below multiple repeating collections float down to keep the same
distance from the longest repeating collection (the repeating
collection that reaches farthest down the report).

Headers &
Footers

Headers and Footers are printed only for reports printed in display
mode. Headers are printed at the top of every page except the first
page (so that the header does not conflict with column headings, for
example). Footers are printed at the bottom of every page.
Before printing, the heights of all headers and footers are inspected
and enough space is reserved at the top and bottom of all pages top
accommodate the largest header and footer. The report as a whole
and any repeating collection can have a header and/or a footer.
When a page break occurs, the top or bottom page break line can cut
across repeating collections. If the top/bottom page break line does
not cut a repeating collection, then any existing header/footer of the
report is used. If the top/bottom page break line cuts across one or
more repeating collections, the header/footer of the innermost
repeating collection(s) that define a header is used. With side-byside repeating collections, two or more headers/footers may be
printed.

To create a overall Report Header/Footer:
> Make sure no repeating collection is selected. Select the Show
Header or Show Footer option from the Report menu. An empty
header/footer box will appear. Only one header or footer can be
displayed at one time.

While a header or footer is displayed the report undeneath it cannot
be edited. A header can only contain labels and pictures and these
are created in the same way as in the rest of a report. However, if
the special strings "[page]",and "[date]" (without quotes) are
included in a label, all occurences of these strings will be replaced
by the current page and date in the printout. (These values are
obtained from the Macintosh clock/calendar). When a header is
printed, its top edge is placed up against the top of the page and the
height of the header is measured from its top edge. When a footer is
printed, its bottom edge is placed up against the bottom of the page
and the height of the footer is measured from its bottom edge.
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The Show Header option in the Report menu changes to Hide
Header when it is selected. The same goes for Show Footer.

To create a Header/Footer for a Repeating Collection:
> Select the relevant repeating collection and then follow the same
procedure as above.

To select a Header/Footer:
> Select the Show HeaderIFooter option from the Report menu.
When the object appears, move the cursor close to its top or bottom
edge - notice that the crosshair cursor changes to an arrow shape
when correctly positioned. Press the mouse button and move the
object up or down as desired. Note that the location of a header has
no effect on where the header will be printed.

To remove a Header/Footer:
> To remove a header/footer from a report or repeating collection
simply show the header/footer (it will automatically be selected) and
use the Clear option in the Edit menu. Alternatively, just select the
current header/footer as described above and use the Clear option.

Keeping Objects
Together On the
Printed Page

> The No Page Breaks icon: To create a No Page Breaks icon:
Make sure the report window activity indicator reads "Report
Design". Draw a thin vertical black box as high as the object(s) you
wish to keep together and then select the No Page Breaks option
from the Describe menu. This icon attempts to keep the objects to its
left/right together on the same printed page.

Note: The No Page Breaks icon expands in report display to keep
its top and bottom aligned with the tops and bottoms of the objects
to its left and right. Remember that Page Break icons are not printed
in report display.
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Specifying Page
Breaks On
Printed Pages

> Page Break Before Icon: To create a Page Break Before
Icon: Make sure the report window activity indicator reads "Report
Design". Click down on the report to create a small black box.
Select the Page Break Before option from the Describe menu. This
icon ensures that a page break occurs at the top edge of the icon in
the printed report.

> Page Break After Icon: To create a Page Break After Icon:

Make sure the report window activity indicator reads "Report
Design". Click down on the report to create a small black box.
Select the Page Break After option from the Describe menu. This
icon ensures that a page break occurs at the bottom edge of the icon
in the printed report.

Note: Page Break icons float down in report display to keep both
below anything that was above them in the design and aligned with
anything that was to the left and right.

Halting Reflex
Operations
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> To halt a range of time-consuming operations (searching for
database file records, calculating reports, exporting/importing
information, printing, etc ... ) simply hold down the "00" key and
then press the period (".") key.
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EXAMPLE 1:
Changing The
Key Type of a
Database File.

This example shows you a simple method of converting the key of a
database file from one design (lastname and firstname) to another
(employee number). The database shown below is used.

El

NewKey

LastName
FirstName
Tel#
Employer

To Change from the LastName/FirstName key to an
Employee Number Key:
> Select the complete file image or the last field in the file image.

> Go to the Overview menu and select the Insert Field option.
> Enter a new field called EmployeeNumber and use the relevant
Describe menu option to make it a Sequence or Integer field.

> Save the modified database file design (shown below) and then
open it by double-clicking on its name bar.

El

NewKey

EmQloyeeNumber
LastName
FirstName
Tel#
Employer

> Enter employee numbers for each existing employee record.
> Close the database and return to the file image in the Overview
window.
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> Select the EmployeeNumber field by clicking on it and move it
above all other fields - it will automatically become a Key field.
Select the LastName and FirstName fields in tum and use the NonKey Field option in the Describe menu to make them non-key fields.

Note: If you use an Integer field for the Key, you will have to
manually enter employee number values for each existing record and
for each new record as it is filled out. On the other hand, if you use
a Sequence field, you will only have to provide values for those
records that already exist - new records will be automatically given a
"highest existing number plus 1" value.
Reordering field names in the file image does not automatically
reorder the fields in the associated data entry form. Use the Form
Layout option in the Database menu to modify the data entry form as
you wish.

EXAMPLE 2:
Converting a
Single Field into
Two Fields.

This example shows you how to split the contents of a single
database file field (eg: "Barbara, Jackson") into two separate fields
(Lastname = "Barbara" and FirstName = "Jackson").The database
file shown below is used.

EJ

SlngleName

Name
Address

City
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A record from this database would appear as:
It File Edit Format Describe Database Search Misc Window
SingleName

II

To split the Name field into a LastName and a FirstName
field:
> Select the SingleName file image.
> Go to the File menu and select the New Report option.
> When the report dialog appears asking you which type of report
you wish to create, select the first option - a Table-Style report on
"SingleNarne".
> When the fields to report on dialog appears, select and include all
the fields except for the Name field.
> Next, the QueryBuild dialog will appear. Click on the Find All
button since you want to modify the contents of all existing fields.
> Provide a name for the new report -let's call it NameConvert.

> When the report appears, it should appear something like the one
below (of course the data will differ, depending on the records in
your database file):
It File Edit Format Describe Report Fonts Style Window
NameConuert
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> Next, add two fields called LastName and FirstName inside the
repeating collection.
> For the LastName field enter the following fonnula in the formula
panel:

MID(Name,LOCATE(Name,", ")+2,LENGTH(Name))
This formula uses the MID and LOCATE functions to "strip out" all
the text that appears after the comma that separates the first name and
last name in the single Name field.
> For the FirstNarne field enter the following fonnula:

MID(Name,I,LOCATE(Name,", ")-1)
This formula uses the MID and LOCATE functions to "strip out" all
the text that appears before the comma in the single Name field.
> Calculate the new report with the
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Last Name

II~ackson
i

Format

00= shortcut.

First Name
lBarbara

.........................
041 Hemlock Ct.

ISan Francisco

> Now you'll need to create a New DataBase File in the Overview
window that has the desired LastNamelFirstName Key fields, as
shown below:

LJ LastFirstName
LastName
FirstName
Address
City
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> Return to the NameConvert report and select the repeating
collection and then select the Export Data ... option from the Report
menu. Decide whether you want to export the data to the clipboard
or a text file (you will be asked to provide a name for the text file).

> After selecting the Export format, you will then have to specify the
order in which the fields should be exported from the report. In1cude
LastName, FirstName, Address, and City.
> Open up the new LastFirstName database file. Go to the Misc
menu and select the Import Records option and then indicate where
the records to be imported can be found (the clipboard or a text file
in this case).

> Finally, select the order in which the import fields should be
entered into the LastFirstName database file (LastName, FirstName,
Address and City). Reflex will now import all the records and you
will have a new database with records that appear as below:
•
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Search

Misc

Window
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EXAMPLE 3:
Linking Single
Reflex or "Foreign"
Database Files

It is very easy to link the records in two independent database
whether they were created within Reflex or imported from another
application. The two database files shown below are used for this
example.

Lj

Ljcompany
Name
Address

Person

Name
Salary
WorksFor

> The first thing you have to do is enter a Link name in each file
image and draw a Link line between them. Insert the Link names
shown below:

~Company

~ Person

Name
Address
Employees

Name
Salary
WorksFor
theCompany

> Next, draw a Link line between the two Link names. Set the
Employees as A Collection of Links to "Person" Records. Ensure
that theCompany remains A Link to One "Company" Record.

~company

~ Person

Name
Address

Name
Salary
WorksFor

Employees

---------

theCompany

> Open up the Person database file and export the Key field (Name)
and the "linkage" field called W orksFor.
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> Reimport the data back into the Person file, only this time import
the Works For values into the new Link field called theCompany.
Interlace will automatically copy the Name Key and the new values
in theCompany over to the Collection of Links in the relevant
Company records.

> The records in these two files are now linked and you can delete
the original W orksFor field since its values exist in the
Employee/theCompany Link pair.

l j Company
Name
Address
Employees

EXAMPLE 4:
Renaming &
Deleting
Database Files in
the Finder

lj

Person
Name
Salary
the Company

If you rename a database file at the Finder level, Reflex will not be
aware of this. This can lead to problems when you try use a file or a
set of files that used to be linked with the renamed file.

To make Reflex aware of a renamed file:
> When you try and Show Linked File (or make changes to a
database file that has Links to other files) and Reflex cannot find the
previously linked file, it will display the following dialog:

Database File "topic" couldn't be found. I f you
haue deleted" topic" in the Finder, please see
Details 6' Techniques in the RefieH manual. If
you haue renamed "topic" please enter the new
name and select "rename."

IsubHeading
(( Cancel ))
(Rename)
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In the previous example, Reflex could not find a file called "topic"
which was part of a linked set . If the file has been renamed at the
Finder level, simply enter the new name (subHeading) in the text
box provid~d and click on the Rename button.

To "clean up" after deleting a database file with Links to
other files:
If you have deleted a database file with Links in the Finder you must
remove any Link "remnants" that exist in the remaining database
files. To do this:
> Show the image of each file that contained Links to the deleted
file.
> Select the now useless Link names (they will still be in bold type)
and select the Clear option in the Edit menu.

> Reflex will display the Rename dialog box. Just click on the
Cancel button.
> Now, Reflex will display the following dialog box:

The Linked Database File is not open in the Ollerlliew
window. Use the Show Database file ... command to show
that file before attempting to clear this Link field.
HOWEUER, if the Linked Database file NO LONGER EM I STS,
you may choose Destroy Link. If you do this, you will
DELETE RLL DRTR fOR THIS LINK.

I(

Cancel

)1

Destroy Link

Note: If this Link is also a key, this dialog box won't appear, and it
won't be possible to destroy the unconnected Link.
Read the dialog text carefully, then click on the appropriate button.
> If you click on the Destroy Link button, Reflex will delete the
Link and the data it contains. You must then save the modified file
design(s).
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EXAMPLE 5:
Creating Field
Qualifications

To create a field qualification, the active window must be a data
entry Form Layout window.
> Select the field you wish to enter a qualification for.
> Enter the qualification formula - this qualification may be as

simple or as complex as you wish.
Th~

example shown below will only allow part numbers beginning
with the number" 1" to be entered in the Part# data entry field.
•

File

Edit

Format

o

Describe

Layout

Fonts

Style

Wil

PartShipments

PartName i:..........................................................................i
:

EXAMPLE 6:
Placing Pictures
In Data Entry
Forms & Reports

Placing pictures in Reflex data entry forms and reports can greatly
enhance their appearance and usability.
We start off, below, with a straightforward spreadsheet-style report
that uses Reflex's PMT (payment) function to calculate the payments
that have to be made on any loan. The parameters are: the amount
owed, the annual interest rate, and the payment periods.

P~[M~;~~~~-~~~~~il::\\~-l!~~r~!----··. . . . . . . ·.iI
P.=:.:J=-

Tot.l

p.ymenL~~~~;~~i~lHHH

"R"~~d~t "D~:~;"g~"ki"" :Iilililililililililililililililililililililililililiiililililililililililililililililililililililililililililillli"(; ~
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By placing a picture into the report (as described in this section
under Placing Pictures in Data Entry Forms/ Reports) and
moving the fields around a little, a completely different visual effect
can be given.

PaymentSchedule

.
. . .
......................................................................
.
. . .

This is a simple graphic placed into a report. You can, of course,
create pictures of the documents that you already use and paste them
into data entry forms.
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EXAMPLE 7:
Bulk Updates of
Database Fi Ie
Records

Rather than browsing through a whole database and changing every
record (to give everyone a 10% raise, for example), you may create
a report on a database that modifies one or more record values.
These new values can then be exported from the report and then
imported into the original database or a completely new database. By
only reporting on a subset of a database file (producing a report only
on those people with a particular job title, for example) you may do
selective bulk updates of record information.

To give everyone in the employee database shown below
a 10% raise:

Ej

Employee

Last Name
Fl rstName
JobTltle
Sal ary

> Create a table-style report on the Employee database - including
only the LastName, FirstName and Salary fields.
> Give the Salary field the formula shown below:
•
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Style
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EmployeeRaise

Lj Salary

Sol ory* 1. 1

:· LostNome

.

FirstNome
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......................................................................................................
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...
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.
..
··
...
..
.
.
.
.
.
.
.
.
.
.
..
..
..

When the report is recalculated all salary field values will be
increased by 10%.
> Export the values from the modified report in the same LastName,
FirstName, Salary order.
> Import the updated values into the original database file - Reflex

will replace the old values with the new.

Note: If Reflex comes across a Key that does not already exist in
the database file it will create a new record with that Key and
associated fields.

205

Section Four:
Reference

Reflex Formulas and Queries

REFLEX
FORMULAS &
QUERIES
DATA TYPES

Reflex fields may one of seven distinct data types - Text,

Number, Integer, Date, Time, Logical and Sequence.
Label and Picture objects are used strictly for decoration. The user
typically specifies the type of each object at the time of its creation
via the Describe menu options.
The two data types, Error and NA are used to indicate anomalous
conditions; these are typically, but not always, generated by
Reflex (see section on Functions).
In addition to the range of values defined below, each of the seven
major data types can have a defined blank (empty) value. The blank
value for each type is used when no value is desired for a field.

Text

The Text data type consists of a variable number of characters from
the Macintosh character set. This includes letters, numbers,
symbols, and special foreign language characters.
In Reflex, text that does not fit on a single line will be wordwrapped according to the standard Macintosh definition of a word
boundary. Long text strings placed in multi-line text fields will
therefore appear as paragraphs; these paragraphs can be separated by
the use of carriage returns placed between them. Text that is
wrapped beyond the last line of a text field - and can therefore not be
seen - is still counted as part of the current text object. To view the
hidden text, simply make the text field larger using its resize box.
· Text may be arranged as a single line ..
··
··
·

.
...
.

.
...
.

...
..

...
..

...
..

...
..

Sometimes, text can be
arranged in paragraphs.

· There are times when one 1i ne will not ....... .....
.
Just use a carn age
.
be enough - text wl11 be wrapped as
return between
........... .
· necessary.
paragraph blocks.
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Any text included in formulas must be contained (delimited) within
double quotes. Any double quotes in the text itself must be repeated
twice to distinguish it from the actual text delimiters.
Example 1:
..
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eHample_report
"Text must be delimited with double quotes"

~fl

..... ) ..... ) ... ITe.xt

m~st b~

deli ~ite~

Wit~ dou~le q~otes .I ..... )

l

.......

.
.
..
.
···
...
...
...
...
...
...
...
...
...
..
...
..
··
..
...
..
..
..
..
.
.
.
.
·
.
.
.
.
.
.
.
.
.
.
.......................................................................................................

Example 2:
..

File

Edit

~D

Format

Report

....... ~ ....... ~ . ..ITe.xt
...

...

Style

m~st b~ "del~mite.d" Wi.th do.uble ~uote.s
...

...

.

..

...

...

The Text Sort order is: A a B b C c...... Z z
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Fonts

UJin

eHample_report §
"Text must be .... deli mited .... with double quotes"

~fl

···

Describe
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.
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Reflex Formulas and Queries
Number

The Number data type consists of whole and fractional numbers
represented in floating point format.
• Reflex provides up to 15 decimal digits of precision.

Example:
"
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• Exponents in the range +308 to -324 may be used. Exponents are
indicated by following a number with the letter "E" or "e" and the
exponent value.
The Number Sort order is: -1,0, 1,2,3 ... 9

Integer

The Integer data type is actually a subset of the Number data type.
An Integer is a positive or negative whole number up to 2 billion .
(2,147,483,647 to -2,147,483,647 inclusive, to be precise). This
data type exists because such values are used frequently and can be
stored more compactly and computed more quickly than Numbers.
Also, Integer fields will not accept entry of values that contain a
decimal point - this can be used to prevent entry of fractions where it
makes no sense (i.e. ".3 children").
The Integer Sort order is the same as the Number Sort Order
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Date

The Date data type consists of the month, the day, and the year
expressed as integers and separated by the slash character ("!,,).
• The Month is from 1 to 12 for January through December.
• The Day is from 1 to 31 as allowed by the corresponding
Month.
• The Year is either expressed as from 04 to 99 for the years
1904 to 1999, or as from 1904 to 2039.
• Note that dates may be used in formulas, but only if they are
preceded with the @ symbol (this makes them a date constant an
thus distinguishes them from the division of three numbers).
Example:
•

§D
X f1
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eHample_report §
IF(TODAV > @ 12/31/99,"New Century","Too Early")

.
. ,..---------------,:
:
:
:
....... ~ ....... ~ ... ITO.O Ear.ly
I.~ ....... ~ ....... ~ ....... ~.
.
.
.
.
.
.
.
.

(Note: The field in which the result of the above formula will appear
must be a text field, not a date field since we are asking for one of
two text strings to be displayed).

Date Sort order examples are: 8/20/47, 2/13/48, 2/16/48,
7/12/58, 12/16/58 ....
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Logical

The Logical data type consists of a TRUE or a FALSE value or a
YES or a NO value.
YES is functionally equivalent to TRUE and NO is functionally
equivalent to FALSE.
Example:
"
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~f1

....... L......... L...-IT_RU_E_ _ _ _ _ _ _ _ _---II. ~ ....... L....... .

The Logical Sort order is: Blank, NO, FALSE, TRUE, YES

Time

The Time data type follows the 24-hour format and consists of
hours minutes and seconds separated by the colon character (":").
• The Hour value may be between 0 to 24.
• The Minute value may be between 0 and 59.
• The Second value may be between 0 and 59 and is optional, with
zero as the default.
• Time values may be used in data entry and report formulas
provided they, like Date values, are preceded by the @ symbol.
The Time Sort order is: 01:00:00,02:00:00 ...... 24:00:00
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Sequence

The Sequence data type consists of an integer value that, for data
entry, can be set automatically by Reflex to a unique value, or as
desired by the user.
• The first record in a database file will be given the default
Sequence value of 1; the second record will be given the default
value of 2, etc ...
• The user may change a record Sequence field to any value they
wish provided it has not already been taken by another record.
Reflex will then ensure that the next record Sequence field will have
a value of the largest Sequence value in the file + 1.
• In reports, a Sequence field is just like an Integer field.

The Sequence Sort order is the same as the Number and Integer
Sort order.

FORMULAS &
NAMES

A Name consists of a leading letter character followed by zero or
more letters, digits, underbar characters ("_"), or number sign
characters ("#"). Reflex does not allow spaces in names that
consist of more than one word. (The underbar character will
automatically be substituted if you inadvertently enter any spaces in
names while defining the name of a database file, a report, a field, a
repeating collection, or a Link. Although Reflex allows you to use
long, descriptive names they cannot be more than 32 characters in
length.
The name of a field is a simple formula that refers to the value of that
field. The name of a Database file, a Link, or a Repeating
Collection are collectively referred to as Sources.
• You cannot use Reflex keywords - such as AND, OR, NOT,
FROM, WHERE, and CALLED - as names.
• You cannot use Reflex function names that have no arguments
- such as TRUE, FALSE, INFINITY, TODAY, PI, NOW, NA and
PREVIOUS - as names.
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NAME SEQUENCE
FORMATS

To refer to infonnation in linked database files or reports other than
the one you are working with, a single name reference is not
adequate. Instead, you must use a Sequence of Names. A
sequence of names can use one of three equivalent fonnats.

The 'OF' Format

The word 'OF' can be used to separate the sequence of Names.
Examples:
netWorth OF thePerson
symbol OF theCompany

The Possessive
Format

This Name fonnat requires that you place the possessive fragment apostrophe S ('S) - at the end of all but the last of a sequence of
names - spaces are also still required between the words. Note that
this fonnat requires that you put the names in the opposite order to
that of the OF fonnat.
Examples:
thePerson's netWorth
theCompany's symbol
The apostrophe S is still required even if the name being referenced
is plural and therefore already ends with an S.
Example:
theStocks's amount
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The Dot Format

The third Name format allows the user to simply use the dot
character (".") instead of the apostrophe S.
Examples:
thePerson.netWorth
theCompany.symbol
Possessive format and dot format references are functionally
equivalent in terms of the sequence in which names appear; they
may be freely intermixed.
The "OF" Name format can only be mixed with the the latter two
formats where the Name sequence begins with OF and then
switches either to the possessive or the dot fonnat. Once the
possessive format or the dot format has been used in a Name
Reference, you cannot switch back to the OF format.
Example:
MAX(netWorth of theStockholders.thePerson FROM company
WHERE stockName = "Revstar")

QUERIES

At its simplest, a query is just the name of a Source.
Examples:
Employee
netWorth
theStocks
However, more selective views of Sources are made possible by
providing a query that features the Source name, followed by a
"WHERE", which in tum is followed by a Qualification. A
qualification is just a formula that returns either TRVE or FALSE.
The qualification can refer to the various data fields of a record by
name and can include some comparisons.
Example:
Person WHERE netWorth < 200000
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The "Called" Option

In queries involving more than one file, you will sometimes find that
a field name in one file is the same as that of a field in another file.
This is always the case when the query has to use the same file
twice.
Example:
If the problem is to find the name of every stockholder that has a
greater net worth than somebody called Smith, you can use the
following design template.

But what do you actually put in place of the ??? to refer to Smith's
net worth? The answer is provided by the "Called" option which can
be used to supply a synonym for the name Smith, as shown in the
completed design template.

(Jerson Called 8m ith
WHER£ last Name

=~'~b·.:. . . . . . . . . . . . . . . . . . . ._
. '..~2::.:

~:;:::r1~~E~!itb's
netWorth

I

·: :.:·~:· ~ .:·~ ·.· · ~·:~ ]

L.·:.:.:::::.·.·:·.·:.·:..

.... 1

I

..........................................................................................................

The Called option can be used with any Source, not just a database
file as in this example.
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FUNCTIONS &
FORMULAS

A Function call typically consists of the name of a function followed
by one or more parameters contained in parentheses and separated
by commas. Some Functions - including PI, TODAY, NOW, and
FALSE - do not require parameters (See the section on Functions
for more specific information).
• A function parameter is a formula.

Example:
ROUND(netWorth)
• Some functions - including SUM, MAX, COUNT, and
AVERAGE - accept an indeterminate number of parameters.

In general the format is:
AVERAGE(formula FROM query)

A specific example is:
A VERAGE(netWorth FROM person)
This function will obtain the netWorth value from every person
record and then compute the average of these values.
• The COUNT function is a special case in that it can take a query
as a parameter.

The general format is:
COUNT(query)

A specific example is:
COUNT(person WHERE city = "San Francisco")
This example COUNTs the number of Person records that meet the
qualification.
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FORMULA
COMPONENTS
Expressions

An Expression is the combination of some basic elements - a text, a
number, a reference Source name, a function or a parenthesized
formula - and one or more operators.
The arithmetic operators are:
+

*

/

A

Addition
Subtraction or Negation
Multiplication
Division
Exponentiation

All arithmetic calculations in Reflex can use either Numbers or
Integers or both. Integers are automatically converted to Numbers
when necessary.

Order of Evaluation

If several arithmetic operators are used in a single expression, the
calculations are performed in the order:

Negation
Exponentiation
* or / Multiplication or Division
+ or - Addition or Subtraction
A

If you wish, a different order of calculation can be produced by
using parentheses to group sub-expressions that are to be calculated
first.
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The Text Operator

There is one textual operator - the ampersand character ("&"). The
ampersand can be used to concatenate text values, or text values and
a number values. Reflex can convert dates, numbers and other data
types to text as needed.
For text to text concatenation the format is: "Text" & "Text"

Example:

Ii: File Edit Format Destribe Report Fonts Style U
~D

StotkReport

~fl
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Database file fields may be concatenated in reports so that multiple
fields appear as one field. The format is:

Fieldname&" "&Fieldname...
Example:
In this example, the values of the separate first and lastname fields
(which have the formulas firstname and lastname, respectively) are
concatenated in the field labelled "First & Last Name". The repeating
collection is providing a view of the Person file.
"

o
~ f3
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Report

Fonts
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firstname&" "&lastneme
First & Last Name
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Comparison
Operators

A Comparison consists of one of the six following operators:

=
<>
<
>
<=
=>

Equal
Not Equal
Less Than
Greater Than
Less Than or Equal
Greater Than or Equal

Numbers and Integers may be compared. Text objects may be
compared using the standard Macintosh primary ordering of the
character set. Dates and Times may also be compared.
Examples:

10 < > 50
5 < 12
IF(10*10 = 100, "Equal", "Not equal")

Logical Operators

Reflex provides support for the standard Logical operators AND,
OR,NOT.
Examples:

amount> 100 AND pricepaid <50
netWorth >100000 OR age >50
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Reflex
Formula Syntax

Formula ::= {Query FROM } Query
Query ::= Qualification [CALLED Name] [WHERE Qualification ]
Qualification ::= Negation { ( AND I OR) Negation }
Negation ::= [ NOT] Comparison
Comparison ::= Compound [ ('=' I '<>' I '<' I '>' I '<=' I '>=') Compound]
Compound ::= Expression { '&' Expression
Expression ::= Term { ('+' I '-' ) Term }
Term ::= Power { ('*' I 'f) Power}
Power ::= Factor { '/\' Factor}
Factor ::= '''' Text' '" I Number I '@' (Date ,I Time)
Logical I ['+' I '-'] (Reference I Function I '(,Qualification ')')
Function ::= FunctionName [ '(' [ Formula { ',' Formula }] ')' ]
FunctionName ::= ABS I ATAN I AVERAGE I CHAR I COS ICOUNT I
DATE I DAY I ERROR I EXISTS I EXP I FV IHOUR I IF I INCLUDES I
INFINITY lINT I ISERROR IISNA I LENGTH I LN I LOCATE I LOG I
LOOKUP I MAXI MID I MIN I MINUTE I MOD I MONTH I NA I NOW I
PV I PI I PMT I PREVIOUS I PV I REPEAT I ROUND ISECOND I SIN I
SQRT I STARTS I STDEV I SUM I TAN ITIME I TODAY I YEAR
Reference ::= Name [OF Reference I { (' 's' I ',' ) Name}
Name ::= (letter I '_' I '#')

{letter I '_' I '#' I digit}

Date ::= Integer 'f Integer 'f Integer
Time ::= Integer [':' Integer [':' Integer]]
Logical ::= TRUE I FALSE I YES I NO
Number ::= (Integer [',' {digit}]
[ ('E' I 'e') Integer]
Integer ::= ['+' I '-']

digit {digit}

Text ::= {character}
Consists of
{}

Repeat as many times as

[]

Optional
Or
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Reflex Menus

REFLEX
MENUS

In addition to the standard Apple (ti) menu~ Reflex provides a range
of main menus and menu options which change (are updated)
according to the type of activity you are doing. Reflex menus are
used in the standard Macintosh manner. Menu options that are not
appropriate for the current activity will be dimmed (gray) and you
will not be able to select them.

The Overview
Menu bar

The Database Overview menu bar is the first that appears after
you load the Reflex program. It contains everything you will need to
create new database files, show the images of existing database
files, and modify existing database files. Reflex program
information and Reflex's Help system can be obtained via the
relevant options contained in the ti menu.

The Data Entry
Menu bar

The Data Entry menu bar appears when you open a database file
for data entry. This menu bar contains everything you will need to
enter, modify, and delete records. Records may be exported and
imported with options in the Misc menu.
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The Form Layout
Menu bar

The Form Layout menu bar appears when you choose the Form
Layout option from the Database menu in the Data Entry menu bar.
This menu bar contains everything you will need to customize your
data entry forms.

The Report menu
bar

The Report menu bar appe~rs when you create a new report or
open an existing report. This menu bar contains everything you will
need to design, display and modify reports.
The rest of this menu reference section is devoted to brief
descriptions of the options found within each menu heading.
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Apple Menu

APPLE MENU

I Ell

File
Edit
About RefleH •••
Help

Format

Describe

Report

Fonts

Style

Window

Control Panel
Chooser
Scrapbook
Note Pad

The • (apple) menu contains two Reflex specific options and a list
of all available desk accessories. The list of desk accessories will
vary depending on the number currently installed. (Use Apple's·
Font/DA Mover™ utility program to install or remove desk
accessories.) The two Reflex options - which provide program
version information and access to Reflex's main Help facility cannot be changed by the user.

The About Reflex option produces a dialog box giving copyright
and program version information. Click the OK button to send the
dialog away.
Help
Rulers
Chooser
Scrapbook
Hlarm Clock
Note Pad
Calculator
Key Caps
Control Panel
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Reflex's major Help function is available in one of two ways:

Rulers
Chooser
Scrapbook
Rlarm Clock
Note Pad
Calculator
Key Caps
Control Panel

• Select the Help option from the. menu: A Help window will
appear which contains a range of choice buttons and an index of
topics on which Help is available. Select the topic you need help on
and click on the Show Topic button.
-D
( Show Topic ) ( Show ~ndeH ) (

Help
Cancel

)(

Field Data Types
... Date
.. .Integer
... Number
... SeQuence
.. .Text

.. .Time
Files

II

Show Topic will display relevant Help text.
Show Index will return you from within a particular topic to the
main Help Index to make another choice.
Next and Previous move you within individual Help topics.
Cancel returns you to Reflex.
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Apple Menu

• To get an explanation of almost any item on the screen or any
menu command, simply hold down the 00 key and press the
question-mark ("?") key (it doesn't matter if you use the Shift key or
not).The arrow cursor will tum into a large question mark. A
description of almost any item or menu command can be obtained by
placing the question mark cursor over the particular item and
clicking the mouse button once. The Help window, as described
previously, will appear and display the explanation you seek.

Personlnfo

II
Enter Data

Note that this latter form of Help cannot be used with dialog boxes they are either self-explanatory or have their own Help feature (as
with the QueryBuild dialog).
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FILE MENU

. Edit Format Describe
New Database File •..
New Report •..
Open Database File •.•
Open Report .•.

Report

Fonts

Style

Window

I: !OS(~

Close All Documents
Saue Design
S<WH

3CS

fI~,,,

Reuert to Old Design

3CR

Page Setup •..
Print •.•
Quit

The File menu is where you design, save, open and close the
various types of Reflex documents that you will create. This menu
also has an option that allows you to revert the design of database
files and reports, and the contents of database records, if for any
reason you do not wish to keep the modifications you have made.
Standard Macintosh Page Setup and Print options are included.
The last menu option - Quit - returns you to the Finder.

228

File Menu

New Report •••
Open Database File ...
Open Report ...
Close
Close RII Documents
Salle Record
XS
Salle Rs ...
Rellert to Old Re~ord XR
Page Setup ...
Print ...

The New Database File option is selected when you want to
design a new database file. Reflex responds by displaying a
standard file dialog requesting that you name the new file.
• Entering a name and clicking on the Create button causes a blank
file image to appear in the Overview window. Its name bar contains
the name you supplied. If the name has already been taken, Reflex
will ask you if you wish to replace the existing file. Make a decision
and click the required button.
• If you change your mind and decide not to go ahead with building
a new database file just click on the Cancel button and the standard
file dialog will disappear.

You may preselect where Reflex will place a new file by dragging
diagonally in the Overview window with the mouse button
depressed. A black box will appear as a location marker. If you do
not preselect a spot, Reflex automatically places the new file in the
Ov'erview window along the left margin, below the lowest file
currently visible.
The New Database File option is always available from the File
menu regardless of what you are doing within Reflex.
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I

The New Report option is selected when you want to design a
new report. Selecting this option produces a dialog box which offers
a selection between a ready-made table-style report and a report
which you design yourself.

•••

Open Database File •••
Open Report •••
I: los(~

Close RII Documents
Saue Design

ses

S<W(~ fl~,,,

Heuert to Old Design seH
Page Setup •••
Print ...
Quit

• Table Style Report on the currently selected database or another
database you choose: This is the quickest way to produce a simple
columns and row sty Ie report on a single database. You can
customize both the layout and the contents of the record list via the
Design Report menu option in the Report menu. Record
qualifications entered directly into the formula panel or via
QueryBuild can be used to restrict the records that are displayed. All
table-style reports can be redesigned to work with multiple files.
• A report which you design yourself: Custom reports may be as
simple or as complex as you wish - there is no initial default format
as with table-style reports. Report form layout is entirely up to the
individual user's taste or requirements.
In all reports: Fields can be created, positioned and repositioned,
text labels may be created and displayed in different fonts and font
styles, and pictures can be pasted in via the clipboard.
A most powerful feature of reports is Reflex's formulas and queries
which can be used to produce reports of an unusually complex
nature.
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File Menu

The Open Database File option is used to open up a data entry
form for an existing file. The file may already contain data or it may
have just been created and must now be opened for initial data input.

New Database File ...
New Report ...
II·

I ••

1 ••

Open Report ..•
I: !!)S(~
Close All Documents
Saue Design

There are two methods of opening an Reflex file:
8€S

S<n~(~ Hi-H'

Reuert to Old Design
Page Setup •••
Print •.•
Quit

8€R

• If the Overview window is not active, go to the File menu and
select the Open Database File option. When the standard file dialog
appears, select the file name that you wish to open and click on the
Open button. The data entry form will open for that database and
you may add, edit or view the records it contains.

• The fastest way to open a database is to double-click on its name
bar (but not its status icon) just as you would open a program or
document from the Finder.
The first option allows you to stop the open database file procedure
with a Cancel button, the second clearly does not. Many database
files can be open at one time.
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New Database File •..
New Report •.•
Open Database File •••
I.

I

[ los(~
Close All Documents
Salle Design
S<Hl(~ fl~ ...
Reuert to Old Design

88S

The Open Report option allows you to open up an existing report
form for calculation or modification. This is the only way you can
do this since report forms do not appear in the Overview window
and can therefore cannot be double-clicked. Many reports can be
open at one time. Note that calculating a specific report will open
any reports that it refers to and will show the images of all database
files referenced in the Overview window.

88R

Page Setup •••
Print ...
Quit

New Database File ...
New Report ...
Open Database File ...
Open Report ...
I

•

Close All Documents
Salle Record
Salle As ...
ReLlert to Old Record
Page Setup ...
Print ...
Quit
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31:5
3I:R

If you are working anywhere other than in the Overview window,
the Close option closes the currently active window. If changes
have been made to the current database file or report, the Close
function saves them to disk automatically. Close is not available (it
is grayed) when the Overview window is active. You can, of
course, use the close box on each window to remove an active
window.

File Menu

New Database File ••.
New Report •••
Open Database File •••
Open Report •••
Close
Salle Record
_S
Salle 8s •••
Rellert to Old Record _R

The Close All Documents option closes all active database file
and report windows and saves any unsaved changes. This is a
useful feature if you have to close a number of database documents
in order to make modifications to their structure in the Overview
window or you just want to clear everything away quickly. Close
All Documents does not have any effect on the Overview window.

Page Setup ..•
Print •••
Quit

New Database File ...
New Report •••
Open Database File •••
Open Report •••
[Ios(~

Close 811 Documents
• . I·

I

S<HI(~ fI~",

Rellert to Old Design 38R
Page Setup .••
Print. ••
Quit

The Save Design option reads differently (it is updated) depending
on the activity you are doing. It can be one of four possibilities:
Save Design, Save Report, Save Record, and Save Form.
• Save Design is used to save the design of new database files or to
save changes to existing files. This option may be selected at any
time to save changes to files. New database file designs are
automatically saved when you try to open them the first time. Save
Design must be used to save all changes to an existing database file
structure before it can be opened.
• Save Report is used to save the design of a report you have just
created or the modified design of an existing report.
• Save Record places the current record into the file to which it
belongs. This command also writes all changes made to disk so that
the disk copy of the file is as accurate as possible.
• Save Form is used to save the design of a Data Entry Form you
have just customized.
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New Database •••
New Report •••
Open Database •••
Open Report .•.
Close
Close 811 Documents
Salle Record

38S
~

Salle As...

ReLlert to Old Record

38R

Page Setup •••
Print .•.
Quit

New Database File •••
New Report ...
Open Database File .••
Open Report •••
I: !OS(~
Close RII Documents
Salle Design
38S
S<ItI(~ fli> '"
I

1

I

Page Setup ...
Print ...
Quit

I'

I

The Save As option is used to make copies of existing database
files or reports under another name on the current or some other
disk. The original file is left untouched, but its design and contents
are duplicated and saved under the new name. This is useful if you
run out of disk space since you can use the standard file dialog Eject
button to remove the current full disk and replace it with a blank
(formatted or unformatted) one. You cannot copy a file from the
Overview window - its database window must first be opened. It is
important to note that it is not good practice to make multiple copies
of the same database other than for backup purposes since this can
lead to inconsistent data. Reflex will display an error message if you
try to open more than one version of a file at the same time and the
original file contains Links.

Often, you will wish to undo changes you have made to a database
or report - this is where the Revert option comes in really handy.
This menu option changes to keep track of whatever activity you are
doing. There are four possibilities: Revert to Old Design;
Revert to Old Report; Revert to Old Record, and Revert to
Old Form.
• Revert to Old Design: This option will discard all changes you
have made to the current database file image and reload the last
saved version. Be careful, if you save any changes to disk and then
change your mind, Revert to Old Design will not be able to help you
at all and you'll have to manually recreate the desired file or
structure.
• Revert to Old Report: This option will discard all changes you
have made to the current report and reload the last saved version of
the report.
• Revert to Old Record: This option will discard all changes to the
current database file record and redisplay the last version inserted
into the file. If the record is new (unsaved), using the revert
command will return the record to its original blank state.
• Revert to Old Form: This option will discard all changes to the
current data entry form and redisplay the last saved version of the
form.
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File Menu

New Database File ...
New Report ...
Open Database File ...
Open Report ...
I: lns(~
Close HII Documents
Salle Design

The Page Setup and Print options provide access to standard
Macintosh page size/orientation and printing dialogs as shown
below:
When the Page Setup dialog appears, just select the options you
wish by clicking on the relevant button(s).
~S

S<W(~ f1~",

ReLlert to Old Design

~R

I(

I mageWriter (Standard or Wide)
Paper:

0
0

@ US Letter

o US Legal
o Computer Paper
0

Orientation:

@ Tall

Pagination:

@ Normal pages

Reduction:

@ None

0

R4 Letter
International Fanfold

Tall Rdjusted

0

0

OK

)1

( Cancel)

Wide

No breaks between pages

50 percent

The Print dialog allows you to select the quality of printed output,
the specific pages to print, the number of copies of the document,
and the type of paper (continuous or cut-sheet) that will be used.
Both the Apple Imagewriter and LaserWriter are supported.

I(

I mageWriter (Standard or Wide)
Quality:
Page Range:
copies:
Paper Feed:

0

@ Standard

0

@ RII

0

from:

To:

@ Continuous

0

cut Sheet

High

0

D

OK

)1

Draft

D

( cancel)

For a more detailed explanation on these two menu options refer to
Macintosh™, the owner's manual.
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The Quit option is used to exit from Reflex.
New Database File ...
New Report ...
Open Database File ...
Open Report ...
I: !OS(~
Close RII Documents
Salle Oesign
3€S
S<Ul(~

fh",

ReLlert to Old Design 3€R
Page Setup ...
Print...

• If there are no unsaved changes to database files in the Overview
or any open documents, this option simply returns the user to the
Finder.
• If there are unsaved changes to documents the Quit option saves
them, if possible, and then exits to the Finder.
• If there are unsaved changes to file images in the Overview, you
are asked whether you want to save them. You may save the
changes and continue with the Quit. You may cancel the changes
you have made in the Overview and continue with the Quit. Lastly,
you may opt to return to Reflex.

There are new and/or changed Database
Files in the Oueruiew. Do you want them
saued?

[

Saue Changes

J

Cancel Changes
[Return to Interlace)

236

Edit Menu

EDIT MENU
Cut
Copy
Paste
Clear
Duplicate

8€H
8€C
:~w

:·;n

Paste Function Name
Paste Que

The Edit menu contains all those options you will need to
manipulate objects while using Reflex. There are options to Cut,
Copy, Paste, Clear, and Duplicate objects. The last two
options, Paste Function Name and Paste Query, are used to
place functions and queries in the formula panel of the active
window.

cut
Copy
Paste
Clear
Duplicate

38H
sec
38U
380

Paste Function Name
Paste Qu

The Undo option is used to discard all changes made as a result of
choosing the cut and paste options listed below it in the Edit menu
(or when you select objects and then use the Backspace key
shortcut). If you enter text in a database file or report field or
formula/name panel, and then wish to remove that text, you may
choose the Undo option. If the text area in question was previously
empty, it will become empty once again. If the text area already
contained text which you overwrote or edited, that text will
reappear.
Be careful, Undo will only reverse the last action you did - you
cannot rely on it to bring back items modified or deleted early in a
work session.
If Undo is not applicable or not available for some reason the option
will appear gray and you will not be able to select it.

237

Undo

~2

Copy
Paste
Clear
Duplicate

~C

~U

000

The Cut option is used to delete what is currently selected from the
current database or report and place it in the Macintosh Clipboard anything already in the clipboard will be discarded.
• In a data entry form or report, you can select a single object, or
multiple objects, to cut and paste. The contents of any field that is
Cut (its value, formula, name, type, formatting, current font and
style), are included in the Cut.

Paste Function Name
Paste Query

Undo

~2

Cut

agH

The Copy option makes a duplicate of any currently selected object
or group of objects and places the duplicate in the clipboard.
Anything placed in the clipboard in this way can be pasted into any
other Interlace document.

II

Paste
Clear
Duplicate
P!~s1(~

fun!;Hon

P!~s1 (~ {!U(~qJ

agU
agO
NanH~

The Copy feature is useful when transferring items between the
various Interlace documents you will be working with.
• Copying fields copies everything about that field, enabling you to
save development time when designing very similar forms.
• Copying forml,llas, especially long and complex ones, is a much
safer way of transporting them between documents than retyping.
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Edit Menu

Cut
Copy

88H
88C

The Paste option can be viewed as the companion option to Cut and
Copy. It is used to insert the contents of the clipboard into the
currently selected target. The clipboard contents may orginate from
within Reflex itself or from other applications or desk accessories
such as the Scrapbook.

Clear
Duplicate

880

• Text can be pasted into name and formula panels when those
panels can be edited.

Undo

Pas1(~ run~:1ion N!~nH~

Pas1e OlH~qJ

• Text can be pasted into fields and labels when these objects can
be edited.

• Text and Picture objects (and multiple selections of these objects)
can be pasted into Headers, Footers, and Data Entry Forms.
• All objects, and multiple selections of them, can be pasted into
Reports.
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The Clear option, while similar to the Cut option, does not place
any selected items into the clipboard - it simply discards them.
Cut
Copy
Paste

88H
88C
88U

Duplicate

880

P~~s1 (~

hmtHon NanH:>

P~~s1 H (!lH~1

• In the Overview window you can use Clear to discard a new
database file image that has not yet been saved and to remove new or
existing file image fields. Removing an existing file image field
would be a major change to a design and would therefore require
that you save the changes before opening that file once again. The
contents of any field that is deleted via the Clear option in the
Overview window are lost, as indicated by the dialog:

I f you delete this field you will lose all the data for
that field. You can choose Reuert to Old Design in
the File menu to undo all changes to the design.

n

OK

1

cancel)

• In Form Layout windows you can remove labels, pictures, and
the contents of the formula panel (or multiple selections of these
objects), by clicking on them and choosing the Clear option.
• In report windows you can remove fields, labels, pictures,
repeating collections, and the contents of the formula panel (or
multiple selections of these objects) by clicking on them and
choosing the Clear option. You can also use Clear to remove the
contents of the name panel in a Report window, but you cannot then
leave the name panel empty. If you attempt to do this, you will see
the following dialog:

Illegal name: all names must begin with a
letter.

[
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OK

J

Edit Menu

8€2
8€H
8€C
8€U

Cut

Copy
Paste
Clear

The Duplicate option is used to copy a selected item, or group of
items, without placing the object(s) in the clipboard. Use it to create
multiple fields of the same size and type within reports or to
customize reports with labels and graphic images. First, select the
field, repeating collection, label or graphic image and then choose
Duplicate.
• Database fields cannot be duplicated with this option.

!>as1H

run~;Hon Nnm~~

!>ns1(~ OU(~1

• Duplicates are placed immediately below the original item. If ther
is no space to do this (other fields are too close, for example),
Reflex will first sound a beep. On a second attempt to use the same
command Reflex will respond with the dialog:

Objects in a form may not ouerlap.

OK

J

If you still wish to duplicate the item in question, move it to where
there is more space or reposition the object that blocks the way.
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Undo
Cut
Copy
Paste
Clear
Duplicate

..

.

Paste Query

3€H
3€C
3€U
3€D

The Paste Function Name option allows you to obtain a dialog
box listing all the possible functions that can be used to construct
fonnulas. Each function appears within a standard dialog box
button - to select a function you simply click on the relevant button.

Choose a function name.

[ RBS ]
[ RTRN ]
[RLtERRGE]
[ CHRR ]
( COS ]
[ COUNT]
[ DRTE ]
[ DRY )
[ ERROR]
[ EH ISTS ]

[ EHP ]
[ FLl )
[ HOUR ]
[ IF]
~NCLUDE~
[INFINITY]
[ I NT ]
[I SERROR)
[ ISNR ]
[LENGTH]

[ LN ]
[LOCRTE)
[ LOG ]
(LOOKUP]
( MRH ]
( MID ]
[ MIN ]
[M I NUTE)
( MOD )
(MONTH]

m Cancel
[ NR ]
[ NOW ]
[ NPLl ]
[ PI]
[ PMT ]
fRELlIOU~
[ PLl )
[REPERT]
[ ROUND]
(SECOND]

[
[
[
(
(
[
[
[
(

B

SIN]
SQRT )
STRRTS ]
STDELl ]
SUM]
TRN ]
TIM E ]
TODRY ]
YERR ]

• After making a choice, the dialog disappears and the fu~ction is
automatically pasted for you into the fonnula panel of a data entry
fonn or a report. The precise fonnat of a function depends on its
type, but Reflex provides you with visual help in completing a
fonnula that requires parameters by including a description of the
valid or necessary parameters in an English-like fonnat. For
example:
LENGTH("Text_String")
This function computes the LENGTH of the Text String in the
parentheses. For more specific infonnation on functions see the
section on Functions.
• If you do not wish to select a function, simply click on the Cancel
button.

The Paste Function Name option is available whenever the fonnula
panel in a report or database window is selected.
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Edit Menu

Undo
Cut
Copy
Paste
Clear
Duplicate

3€H
3€C
3€U
3€D

The Paste Query option is the equivalent of the Search On option
available with data entry fonns in that it brings up the QueryBuild
dialog. Query Build provides an automated method of creating
accurate database or report queries. Whenever QueryBuild is
invoked via this menu option, a standard file dialog will appear first,
asking you to indicate the database file·with which you wish to
work. Paste Query is available in all the same situations as Paste
Function Name.

Paste Function Name
Paste Ouery
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FORMAT MENU

nlign
nlign
nlign
nlign
nlign
nlign

Left Sides
night Sides
L\n Centers
Tops
Bottoms
T\B Centers

Hide Grid
.....nlign To Grid
Hide P e Widths

The Format menu contains all the options you will need to format
objects while designing data entry forms and reports. Special
dialogs for Number, Date and Text field/label formats are accessed
via the Display Format option.
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Format Menu

Display Format ...
nH~]n

t (~n

}~[h~s

nH~]n H~~]h t S~d(~~

m~~.~n

t \H

nH~.~n

lops

nH~]n

Ho t toms
"(-.H C(H~t (~r~

nW.~n

There are three very similar options that help you arrange the way in
which field and label contents are displayed: Contents Left,
Contents Right, and Contents Center. They all work in the
same fashion: select one field or label and choose the relevant
option. Fields may be selected within database file images in the
Database Overview window to set content positions.
• Contents Left: This left justifies the contents of a field.
• Contents Right: This right justifies the contents of a field.

[~~n h~fS

• Contents Center: This centers the contents of a field.

•........ ...............................................
,

Hide Grid
.......Rlign To Grid"
Hide Pa e Widths

The Display Format option allows you to customize the way in
which the contents of number, integer, sequence, date field or text
field types will be displayed in data entry forms and reports. Using
this feature on a field name in a file image presets that field's format
for data entry and layout. Select a field and then choose the option.
A dialog will appear showing the range of formats available; an
example of each format will appear as you click on the relevant radio
button.
HH~]n t(~n }~~h~s

~Hh.~n Hh.~h t Shh~~

HHqn t \H

[~~n h~fS

HH~]n lo~)s

HH~.~n

BoHoms

HH~.~n

l\H CHn1 (~r~

Hide Grid
.......Rlign To Grid
Hide Pa
Widths
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Number, Integer, Sequence field dialog:

@ General

OK

o Decimal

o Scientific

Cancel

o Dollars

o Percent

Ill_I Digits to the right of the decimal point (0 to 15)
o Format with commas
[Hample

12345.61

Date format dialog:

@ Short Date Format

o Long Date Format
o Rbbreuiated Date Format
[Hample
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12/31/84

OK
Cancel

Format Menu

Report Text field dialog:

@ FiHed Height

o Uariable Height

n

OK

J

Cancel

The Text field display format dialog is only available when the
selected text is in a Report.
• A Fixed Height text field is of constant size, regardless.
• During Report Design activity a Variable Height text field will
always appear as big as you initially made it.
• During Report Display, a Variable Height text field will shrink to
the minimum height allowed by the text it contains (this may be zero
to n lines).
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[ 0 n h~ n t s U~ t t
[onh~n ts

fH9h1

[onh~nts C(~n1 (~r

Align
Align
Align
Align
Align
Align

Left Sides
Right Sides
L\,R Centers
Tops
Bottoms
r'"B Centers

Hide Grid
./Rlign To Grid
Hide Pa e Widths

Since Reflex's data entry fonns and reports can be highly
customized, you will need to have some facility that does not rely
solely on hand-eye coordination to position items accurately. The
alignment options provide a range of ways in which fields, repeating
collections, labels or pictures may be positioned relative to one
another with great speed.
Multliple objects are selected in data entry forms and reports by Shift
Clicking. This technique involves: first selecting an object by
clicking on it; then pressing the Shift key while clicking on as many
other objects you wish. Each object selected in this manner will tum
black to confinn that it has been selected. You can then use the
standard Edit menu options (cut, paste, etc .. ), move the objects
around manually, or select one of the options described below.
• Align Left Sides: Aligns the left sides of all currently selected
fields, repeating collections, labels and pictures with the left-most
selected item. You select the items to align by Shift-Clicking on
them. Useful when long reports must have labels and fields aligned
vertically over many pages, or fields need to be grouped together in
neat "stacks".

Sel ected but unali gned

Left Sides aligned

• Align Right Sides: Aligns the right sides of all currently
selected fields, repeating collections, labels and pictures with the
right-most selected item.

Selected but unaligned

248

Right Sides aligned

Format Menu
• Align L \R Centers: Aligns fields, repeating collections,
labels and pictures along their Left\Right centers.

Selected but unaligned

Left \Rl ght Centers a1 i gned

• Align Tops: Aligns the tops of a group of fields, repeating
collections, labels and pictures based on the location of the top-most
selected item.

Selected but unaligned

Tops aligned
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• Align Bottoms: Aligns the bottoms of a group of fields,
repeating collections, labels and pictures based on the location of the
bottom-most selected item.

Selected but unaligned

Bottoms aligned

• Align T\B Centers: Aligns fields, repeating collections,
labels and pictures based on the location of their Top\Bottom
centers.

Selected but unaligned

Top\Bottom Centers aligned
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Format Menu

[ on h~n ts L.~ tt
[ on h~n ts m9h1
[on h~n ts C(~n1 Hf

Align
Align
Align
Align
Align
Align

Left Sides
Right Sides
L\R Centers
Tops
Bottoms
T\B Centers

[onh~nts U~H

[ on h~n ts m~jh1
[on h~n ts C(~n1 (~r
t····· ..........·............·.. ·....·· .. ·....·......·..

Align
Align
Align
Align
Align
Align

Whenever you start to design a new report or layout a data entry
form, Reflex automatically provides a visual grid feature to make the
accurate positioning of fields, repeating collections, etc, that much
easier. You can always remove this default grid by selecting Hide
Grid - this option will then read Show Grid, enabling you to bring
the grid back at any time. No grid is shown during data entry or
report display.

The Align To Grid option ensures that fields, repeating collections,
labels, etc, will "snap" to the closest grid point. The design grid in
data entry forms and reports provides a resolution of eight points per
rectangle both in the horizontal and vertical directions. This feature
makes the positioning of items during design work really easy.
Align to Grid is the default - it can be turned off by selecting the
Align To Grid option once again.

Left Sides
Right Sides
L\R Centers
Tops
Bottoms
T\B Centers
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Rlign
Rlign
Rlign
Rlign
Rlign
Rlign

Left Sides
Right Sides
L\R Centers
Tops
Bottoms
T\B Centers

Reflex automatically displays the current page width on any data
entry form or report you are designing. The page boundaries are
signified by a solid black vertical line and the actual location of this
line will depend on the page layout you arrange via the Page Setup
menu option located in the File Menu. It will often be important to
know just where the page width boundary is so that you don't
inadvertently place objects off the page. The Hide Page Widths
option is used to tum the display of such page boundaries on and
off.
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•

File

Edit

Format

Describe

Report

Fonts

Style
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1thDate

Show Grid
v"'Rlign To Grid
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Describe Menu

DESCRIBE MENU

While developing database files in the Overview window,
you will always have to tell Reflex the type of fields with
which it will be dealing. In other words, you must decide
what type of contents a particular field is meant to hold. The
seven possible field types are: Text, Number, Integer,
Date, Logical, Time, and Sequence.
Once a set of fields have been created, you must then decide
which field(s) will fonn the Key. Set Key fields via the Key
Field option. Change Key fields back into ordinary fields by
using the Non-Key field option.
When you wish to have a record in one database file
associated with other records in the same or another file, you
will need to use a pair of Links. The two options - A Link to
One " ... " Record and A Collection of Links to " ... "
Records - are provided for this purpose.
Describe menu options are updated (changed) when you
switch from the Overview window to a database window and
when you make a report window the active window.

• Database window options: When you switch from
the Overview window to a data entry or fonn layout window,
the Describe menu alters only slightly. There are two options
for new objects - Labels and Pictures. Since you cannot set
Links between records or make fields Key Fields or Non-Key
fields while a file is open, these options have changed in their
nature. The options for Links and Key fields are now included
purely for descriptive purposes.
• Report window options: When you switch to a report
window all seven field type options remain, but those for
Links and Key fields are not shown. Instead, the lower part of
the menu includes features for setting up Labels, Pictures,
Repeating Collections, report page Headers/Footers, and the
position of page breaks.
All options are now described in more detail.
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The Overview Describe Menu
I •

File

Edit

Format .lu~'U.IIl=- Oueruiew
TeHt Field
Number Field
Integer Field
Dote Field
logical Field
Time Field
Sequence field

Window

J

R link to One " ... " Record
R Collection of Links to " ... " Records
Key Field
Non-Key field

This is the initial Describe menu that you will see after loading
Reflex. It contains everything you will need to design, create
and modify database file images within the Overview
Window.

Number field
Integer field
Date field
Logical Field
Time field
Sequence field
HUnk 10 Hrw ""," H(~( nn!
H I: n!h'cHon 01" Links 10 ""," fhH onis

.....Key field
Non-Ke field

The Text Field option is used to indicate that a specific
database or report field can contain any text string. A text
string consists of one or more characters from the Macintosh
character set including letters, numbers, symbols and special
foreign language letters. Note that even though some entries
might look more like numbers (telephone number, social
security numbers, part numbers, etc), they do not have a valid
number format and must therefore be classed as text fields.
The following are valid text field entries .
Frank Smith
A name:
1256 Savanna Avenue
An address:
(499) 999-9999
A telephone number:
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Describe Menu

..
TeHt Field
.-

•

I

Integer Field
Date Field
Logical Field
Time Field
Sequence Field

Key Field
.....Non-Key Field

8CK

There are three kin4s of fields that will accept entries strictly in
the fonn of numerical digits: the Number Field, the Integer
field, and the Sequence field. The Number field is used when
you will need to do calculations that require the precision
offered by floating point arithmetic and the capability to handle
very large/small numbers and fractions. Reflex provides up to
15 decimal digits of precision in calculations. Typically,
number fields are used when you are dealing with: the price of
an item; an interest rate; the result of some mathematical
operation; large distances (eg: the distance to local stars),
etc ...
Because of the greater precision afforded by the Number field
option, calculations involving these fields take longer than
fields of type Integer. Integer values may be entered in
Number fields.

...

The Integer Field type operates much like the number field
in that it accepts numerical infonnation - the difference is that
it only deals with whole numbers in the range:
-2,147,483,647 to +2,147,483,647). Integers exist as a
field type because they can be stored more compactly and can
be computed more quickly.

./TeHt Field
Number Field
Date Field
logical Field
Time Field
Sequence Field

Key Field
.....Non-Key Field

3€K
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..

.'

'

Date Fields will only accept entries in a valid date format,
which takes the form of:

TeHt Field
Number Field
I nteger Field

-'.'
'.
LogicDI Field

Month/Day!Year
~

Time Field
Sequence Field

Key Field
....Non-Key Field

While this is the only input format, Reflex allows you to
choose from three date display formats in reports:
WK

Short Date Format: 2/2/86
Long Date Format:
February 6, 1986
Abbreviated Date Format:
Feb 6, 1986
Choose which form you want by using the Display Format
option located in the Format Menu,

.. .'

The Logical Field type is used whenever you wish to
indicate that a condition is true or false, by entering the values
"TRUE" and "FALSE",

'

TeHt Field
Number Field
Integer Field
DDte Field
II

•

•

I

Time Field
Sequence Field

Key Field
....Non-I(ey Field
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WK

Describe Menu

·.

The Time Field option is used to ensure that a specific field
only accepts information in a valid time format. Reflex uses
the 24-hour time format, as below:

TeHt field
Number field
I nteger field
Dilte field
Logicill field

...

Sequence field

It

H I: l)!h~e1 ion of !.inks 10 ., '" ,.
Key field
.....Non-Key field

-,

fI(H

onis
3€K

..

........eHt field
Number field
I nteger Field
Dilte field
Logicill field
Time field

......

..................................................................................'t........................................

Key field
.....Non-Key field

9 am must be entered as
12.1Opm must be entered as
12.10am must be entered as
8.34pm must be entered as

9:00 or 09:00:00
12: 10:00 or 12: 10
00:10:00
20:34:00 or 20:34

Time values may be used in data entry and report form
formulas provided they, like Date values, are preceded by the
@ symbol.

Reflex does not automatically tag each record with a unique
number as it is entered. If you require record numbers, the
Sequence Field type may be used. The actual record
number given to a record will depend on the number of
records already in a database, but the numbering technique is
based on taking the highest number already allotted and
adding one to it. There can be only one Sequence Field per
database - the Sequence Field option will be dimmed (gray) if
the current database file already contains a field of this type.

• If there are 0 records in a database, the first record entered
will automatically be given the Sequence number of 1.
• If records are deleted, "gaps" will appear in the record
number sequence. You may, if you wish, manually give an
existing or new record the Sequence number of a deleted
record. You can also change any existing sequence field
number to fill in a gap between records or to create a gap
between records.
• You can, if you wish, start record numbers at some specific
value (such as starting with a record for a check number of
100).
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'h~Ht

Reflex allows you to associate the records in connected
database files. The two Describe menu options concerned
Record and
with record linking are: A Link to One"

Held

Nmntl(~1" ril~ld

Inh~l.it~r

H(lld
Held
I.o!}i(nl H(lld
'JinH~ H(lld
S(l(IIHHJ('~ I: ield

000"

Onb~

I

I

.

A Collection of Links to Many
I.

I

I

I

I

"000"

Records.

• A Link to One "... " Record: This option is used to arrange
it so that the current record in the current file is associated
with at most one other record in another file to which it is
connected by a link line. (Note that there are situations where
you will want to associate records within a single database file .
Reflex allows you to do this). The A Link to One "... "
Record option is available when a Link in a file image is
selected.

....Key Field
Non-Key Field

• A Collection of Links to Many" ... " Records: This option
is used to arrange it so that the current record in the current
file is associated with zero, one or more records in another
file to which it is connected by a link line. The A Collection of
Links to Many" ... " Records option is available when a Link
in a file image is selected.

"JtmtH(lld
NumtHll" rit~ld
Inh.>I.wr Hold

Ontl'l'hlid
I.o!)i(nl l'iold
Held
S(!(IIHlfHl> H(lld

nnH~

R Linlc to One "stotlcbuy" Retord

························It·__····
K(l~}

rit~hj

""Non-Key Field
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')('K

While both of these options are used initially to setup the state
of a Link at either end of a link line, they can also be used
later to change the status of a Link.

Describe Menu
I·

All Reflex database files must have Oat least one field set as a
Key Field to ensure that every record in that file can be
uniquely identified. The Key may consist of a single Key
field (such as an employee number or a part number) or a
combination of Key fields (such as a supplier name, the name
of a part shipped by that supplier, and a project name which
uses the part shipped by the supplier).

••

..IreHt Field
Number Field
I nteger Field
Date Field
Logical Field
Time Field
S(H!tl(mO~ H(~ld

Key Field
Non-Key Field

#K

• A non-key field may be made a key field by selecting it and
then choosing the Key-Field option.
• A key-field may be changed back into a non-key field by
selecting it and choosing the Non-Key Field option.
All Key fields are immediately recognizable by the underline
that appears below them. Database records will be
automatically sorted in order of the Key fields. That is, if the
Key fields are LastName and FirstName, all records will first
be sorted LastNarne and then on FirstNarne.

Layout Describe Menu

Number Field
Integer Field
Date Field
Logical Field
Time Field
Sequence Field
Label
Picture
R Link to One " •.• " Record
R Collection of links to " ••. " Records
Cop of Ke Field

The Layout Describe menu appears when you select the Form
Layout option from the Database menu during data entry.
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The first seven field type options remain the same as in the
Overview window Describe menu, only the lower portion has
been updated. The four lower options are not commands,
they simply aid the user in indentifying the currently selected
object.
Lobel
Picture
R Link to One " ... " Record
R Collection of Links to " ••• " Records
Co
of Ke field

...

..

A Label may contain a title, a heading, an annotation, an
instruction, or any other descriptive text you want to include
in your data entry forms or reports. A Label may be placed
anywhere in a data entry form or report so long as it does not
overlap any other label or field. If it does overlap, Reflex will
display a dialog to that effect. Also, Labels can be as wide or
as deep as you wish and carriage returns may be used to
section Label text into paragraphs .

NmntHw fi.~111
Inb~I.JN n(~ld
I)I~t.~

l.o~Ji(

Held
01 n(~ld

linH~ H(~ld

S(Hlu(~rH.~

r i(~ld

...
Pil:1un~

't

H !.ink 10 {!n(~ -, '" ,- H(H on1
I: !)lh~I:1 ion of Links 10 -, '" ,l:ol)!.~ of K(~~j n.~ld

n

f!<~(

onis

• In a data entry form, Reflex automatically places labels
next to each field name. These can be changed at any time by
switching into Form Layout and editing the label as you
would any other Macintosh text. You may also create entirely
new labels by clicking down on the form and starting to type.
Alternatively, first draw a black box with the mouse and then
select Label from the Describe menu. Click in the field and
then enter text.
The Label option is available whenever you are customizing a
data entry form or report.
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Describe Menu

Graphic images or Pictures may be created in MacPaint,
MacDraw or any other Macintosh graphics program, and then
"cut and pasted" into a Reflex data entry form or report. This
feature can be useful for inserting special page layout designs
into data entry forms and logos into reports. Fields may be
placed anywhere (embedded) within graphic images for
greater visual effect.

'h~Ht H(~ld

Numtl(~r nt~ld

Inb~I.~.~r H(~ld

011 b~ I: i(~ld
I. (I~ji( I~I I: i(~ld

Hnw

H(~ld

S(~qll(m( t~ H(~ld

n Un~
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n I: 0Ih~I:1 ion (If Links 1

(I •• ,,, ••

r OI)IJ of

fl<H on1s

K(~~j f"i.~ld

This option will be checked when the currently selected object
is, for example, a record Link which is associated with at
most one record in a database file called Person.

.11i1'RIIin.
'h~!!t 1'j(~ld

Nmn!I(H'

ri.~111

Intt~gN

l'ield
1'i(!ld
1.(I~Ji(lll l'ield
'rinH~ 1'i(!ld
S(Hlll(m(.~ l:j(!ld
I)llh~

I

I

n [1)lh~I:Hon

•

This menu option is not a command and is descriptive only; a
check mark appears next to the option when the current
selection is of the Picture type. Pictures may not be edited
within Reflex, they can only be transported from place to
place via the clipboard's cut and paste facilities.

I.

I.

I

I

(If Links 10 "f>t~rs(ln" Ht~:(lrd~

[01)1.4 01 I(!~J n.~hl

'f£>Ht Held
NllJntler nt~ld
Iflh~(.l£>r fj(!ld
Onh~ I:j(lld
1.0gl(IlIH(!ld
linH~ H(lld
S(l(lll(m( t~ I:ield

This option will be checked when the currently selected object
is, for example, a Collection of Links to records in a database
file called stockbuy.

l'ic111re
10 One "s1o(kbw.l" R(!(IHd

n link
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This option will be checked, and a name will appear within
quotation marks, when the currently selected object is a copy
of a Key field from a linked record. Key field copies only
exist within a Link or a Collection of Links in a data entry
form.

.lTeHt Field
Nurntl(~I' rit~hi

Inh~l.lN n(~!d
I}nh~ i=i(~ld

I. (I~ji(l~1 I: i(~ld
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fi(H
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v'f opy of "stO( kName" Key Field

The Report Describe Menu

l -'

File

Edit

Format •• ·
I'
Report
TeHt Field
Numb'er Field
Integer Field
Date Field
Logical Field
Time Field
Sequence Field

Fonts

Style

Window

Label
Picture
Repeating Collection
Header of " ... "
No Page Breaks
Page Break Before
Page Break Hfter

The Report Describe menu appears whenever you create a
new report, or use/modify an existing report. It contains
report specific options that allow you to create Headers and
Footers and to specify where you would/would not like
Page Breaks to occur.
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I

Describe Menu

OeS( ribe
TeHt Field
Number Field
Integer field
Oate field
Logical Field
Time Field
Sequence field

The first nine options in the Report Describe menu are used to
create labels, set fields to different types and identify pictures
that have been pasted into a report. The five remaining options
are discussed below.

-====-=--Label
PicturE'

Repeating Collection
Header of " ..• "
No Page Breaks
Page Break Before
Pa
Break After

I'

The Repeating Collection option is used to create a
repeating collection in a report. Simply draw a generic black
box anywhere in a report and then select this option - the box
will become a repeating collection.

TeHt Field
Number Field
I nteger Field
Date Field
Logical Field
Time Field
Sequence Field
Label
Picture
•• I · .

I

I

•

Header of " .•. "
No Page Breaks
Page Break Before
Page Break After
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Number Field
Integer Field
Date Field
Logical Field
Time Field
Sequence Field

This option is checked when the selected object is a Header in
the current report. If a Footer is selected this option becomes
Footer of "... ".

Label
Picture
Repeating Collection
•••

S

I

.1

No Page Breaks
Page Break Before
Page Break Rfter

TeHt Field
Number Field
I nteger Field
Date Field
Logical Field
Time Field
Sequence Field
Label
Picture
Repeating Collection
Header of " ••. "

Break Before
Break Rfter
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This option is used to indicate that you do not wish the
contents of some specific report object to be split across pages
during printing. Draw a thin vertical black bar next to the
report object and select this option - the vertical bar will
become a No Page Breaks icon.

Describe Menu

This option is used to indicate that you wish page breaks to
only occur before the selected object during printing. Click
the mouse button with the cursor next to the relevant report
object to get a generic black box. Select the Page Break
Before option - the black box will become a Page Break
Before icon.

I'

TeHt Field
Number Field
I nteger Field
Date Field
Logical Field
Time Field
Sequence Field
Label
Picture
Repeating Collection
Header of " .•. "
No Page Breaks
'.1·

:

••

:.

I

•

Page Break Rfter

TeHt Field
Number Field
Integer Field
Date Field
Logical Field
Time Field
Sequence Field

This option is used to indicate that you wish page breaks to
only occur after the selected object during printing. Click the
mouse button with the cursor next to the relevant report object
to get a generic black box. Select the Page Break After
option - the black box will become a "Page Break After" icon.

Label
Picture
Repeating Collection
Header of " ••• "
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OVERVIEW
MENU

Show Database File ...
Hide Database File " .•• "
Show Linked Files 886
Protect Design
Insert Field

The Overview menu is only available when the Overview window is
active. All the menu options here are concerned with operations on
file images in the Overview window.

The Show Database File option is used to display a file image in
the Overview window. It does not open a database file - it merely
displays the structure of the file so that you can view or modify it.
U sing Show Database File presents a dialog box that contains a list
of all Reflex database files that exist on the current disk. Select the
file name you wish to view and click on Open. Alternatively, click
twice on the file image name bar, but not on the status icon.
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Overview Menu

Sho.w Database File •••
_1m ...... ,I.
Show Linked Files It
Protect Design
Insert Field

There are two ways to to remove a file image from the Overview
window:
8€G

• Simply select the file and choose the Hide Database File
option. The selected file name will appear in the menu to visually
confirm which file is about to be hidden. If the selected file is open
or hasn't yet been saved or if no file is selected, this command is not
active (gray).
• Alternatively, use the much faster method of clicking on the file's
status icon. This has the same effect as clicking on the close box of a
Macintosh window.
Hiding a file does not affect a database file in any way - it just
removes its image.

Show Database File •••

After showing an individual database in the Overview window, it is
often useful to show any other files which contain linked records.
Show Linked Files does just this.

I nsert Field

• Reflex shows only the files with records that are directly linked to
those in the selected file; the last file to be shown becomes the
selected file.
• To see any other files containing records linked to those in the
new current file, choose Show Linked Files once again, or use the
000 shortcut.
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Show Database File •••
Hide Database File "Person"
Show Linked Files
386
,.

I

.__.. _........................._................................. ~.........................

Insert Field

Show Datillbase File .••
Hide Database File "Person"
Show Linked Files
386
.,;'Protect Design
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The Protect Design option allows you to stop any changes being
made to an existing file design. To use, you simply select the
relevant file image and then choose the Protect Design option (a
check mark will appear next to it in the menu). To remove the
protection, select the file image and then choose the Protect Design
option once again.

The Insert Field option inserts a new field space below the
currently selected existing field or, if the entire file is selected, below
the last field in the file image. It can be used with new (unsaved) file
images, or with existing file images; in the latter case you will have
to save the design once again. Newly inserted fields can be placed
at any position within the file image. Also, if you later reposition a
non-key fieldabove a Key field, it will become a Key field; if a Key
field is placed below a Non-key field, it will become a non-key
field. New field(s) will appear below previously existing fields in
data entry forms, regardless of their position in the Overview file
image. You can reorder data entry fields and their associated labels
at any time by selecting the Form Layout option from the Database
menu. If you do this, the order of fields in the file image will be
updated to match the modified data entry form.

Database Menu

DATABASE
MENU

L=.---=-F.:.:.ile~~Ed~i~t_F~o~r.:.:.m~a~t---.::De~s~c~ri~b:..e,llill..
, 1i'1iIi
" •

Search
New Record
Delete Record
Copy Record
Enter Record

Misc

New Link
Delete Link
Show Linked Record

Window

acE
acT
acM
88W
88"
886

Form Layout

The Database menu contains all the data entry options you will
need while using a data entry fonn plus the Fonn Layout option.
This menu only appears when a data entry window is the active
window.

acT
acM
acw
[J(~I(~t(~

Show

The New Record option is used to insert a new blank record into
the active data entry fonn. Once filled in and added to the database
file, the new record will automatically be placed in the correct sort
position depending on the current record Key.

Unk

Unk(~d JI(~(

orli

:-:(i

out
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'=-

_1r.IroIIJi..

New Record

_I·····

I

HE
I

Copy Record
Enter Record
N.~UJ

~

HM
HW

Unk
Unl<

[l(~1(~1 (~

The Delete Record option is used to delete the currently displayed
record from the current database file. If Link checking is enabled,
you can delete any record providing it doesn't have A Collection of
Links to records where the backlink is part of the Key. This is the
same restriction as on deleting a Link; you must delete all such Links
(not records) from the "other end". When you delete a record, it
deletes all its Links for you.

Form Layout

'=-

_1r.IroIIJi ..

New Record
Delete Record
II

'.

I

HE
Hl

I

N.~UJ I.~nk
n(~I(~1 (~

Unl<

The Copy Record option is used to make a copy of the current
record in the active data entry form. This saves a lot of retyping
when a number of very similar records need to be entered. Since
each copy is an exact duplicate of an already existing record, you
cannot insert a record copy into the current file until the Key is
modified so that it is once again unique. Alternatively, you can use
the "Revert" option to change the record copy to a blank new record
if you decide you don't need it.

Form Layout

New Record
Delete Record
Copy Record
•

-.

I

HE
Hl
HM

I

.............................................................. ~ ......................
Unk
:.:H
Unl<
ShOll; t ~nk (HI fI(H ord :.:G
N.~UJ

n(~1<~1H

Form Layout
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The Enter Record option does just that - it enters the current
record into the current database file.

Database Menu

New Record
Delete Record
Copy Record
Enter Record

a€E
a€T
a€M
a€W

Delete Link
It
Show Linked Record

a€G

The New Link option is used to create a new blank Link in a
Collection of Links in the current record. This item is only active if a
Copy of a Key Field in a Collection of Links is selected.

Form Layout

a€E

New Record
Delete Record
Copy Record
Enter Record

a€T
a€M
a€W

New Link

a€H

_I"

The Delete Link option is used to remove a selected Link from the
current record. This item is active only if a Copy of a Key Field in a
Link is selected.

.

Show Linked Record ~:l€G
Form Layout

-I ••

1 ••

New Record
Delete Record
Copy Record
Enter Record

a€E
a€T
a€M
a€W

New Link
Delete Link

a€H

The Show Linked Record option is used to display the record in
another file linked to the current record in the current file. If the file
which contains a linked record is not open, it will be opened. When
the file is open, Reflex will display the associated record in the
relevant database window, behind the currently active window. This
item is active only if a Copy of a Key Field in a Link is selected.

.........................................................................~ ...........

Form Layout
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,I ••

New Record
Delete Record
Copy Record
Enter Record

:M:E
:M:T
:M:M
:M:W

New Link
Delete Link
Show Linked Record

:M:H

For m Layout

272

:M:6

The Form Layout option is used when you wish to switch from
displaying infonnation in a data entry fonn to designing the layout
of that fonn. Grid lines will appear in the layout fonn window and
the activity indicator at bottom left of the window will contain the
words "Fonn Layout".

Search Menu

SEARCH MENU
Last Record
NeHt Record
Prior Record

8€F
8€L
8€N
8€P

Search On...
Find nil
Edit Record Qualification

8€0
8€A
8€Q

The Search menu contains options that help you browse through all
or just some records in a database file. It is also the menu you will
use to display the QueryBuild dialog. It is only available when the
current window is a database window.

Prior Record

3€L
3€N
3€P

Search On...
find HII
Edit Record Qualification

3€0
3€H
3€Q

first Record
•

I.

I

,3€F

I

NeHt Record
Prior Record
Search On •••
find HII .
Edit Record Qualification

3€0
3€H
3€Q

The First Record option displays the first qualified database file
record in the current data entry form. If there is no record
qualification in the formula panel, using First Record will show the
very first record entered into the file. If there is a record qualification
in the formula panel, the first qualified record will be displayed.

The Last Record option displays the last qualified database file
record in the current data entry form. If there is no record
qualification in the formula panel, using Last Record will show the
very last record entered into the file. If there is a record qualification
in the formula panel, the last qualified record will be displayed.
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First Record
Last Retord
I.

I

8CF
8CL

I

Prior Record
Search On •••
Find RII
Edit Record Qualification

8CO
8CR
8CQ

First Record
Last Record
NeHt Record

8CF
8CL
8CN

•

I

I.

I

I

..................................................... ·············It····· ..·······
Search On...
Find RII
Edit Record Qualification

8C0
8CR
8CQ

First Record
Last Record
NeHt Record
Prior Record

8CF
8CL
8CN
8CP

Find RII
Edit Record Qualification

8CR
8CQ

First Record
Last Record
NeHt Record
Prior Record

8CF
8CL
8CN
8CP

The Next Record option is used to move one record at a time
through the records in a database file. If there is no record
qualification in the formula panel, then Next Record will move one
record closer to the end of the file from the current record. If there is
a record qualification in the query panel, this option will move one
qualified record closer to the end of the file from the current
qualified record.

The Prior Record option is used to move one record at a time
through the records in a database file. If there is no record
qualification in the formula panel, then Prior Record will move one
record closer to the beginning of the file from the current record. If
there is a record qualification in the query panel, this option will
move one qualified record closer to the beginning of the file from the
current qualified record.

The Search On option is used to invoke the Query Build dialog
- the Reflex feature which assists you in building record
qualifications that specify which records will be displayed.

. I

Search On •••
_urn •

8C0

Edit Retord Qualification~ 8CQ
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The Find All option is used when you want to display all records
in a database file. This is used when a record qualification is present
in the formula panel and you now wish to remove it.

Search Menu

First Record
Last Record
NeHt Record
Prior Record

lieF
lIeL
lieN
lICP

Search On .••
Find HII

lieD
lIeR

£dlt Re(ord Quallfl(atlon

#<0

The Edit Record Qualification option is used to place the
insertion point cursor in the fonnula panel. If there is no record
qualification in the fonnula panel, the insertion point is placed at the
left-most point of the fonnula panel. If a record qualification already
exists in the fonnula panel, the Edit Record Qualification option
selects,the whole record qualification, ready for editing.
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Mise MENU
Delete Qualified Records
EHport Qualified Records •••
Import Records •••
"ICheck Links

The Misc menu contains features that you will need to delete
multiple records, interchange information with other applications,
and tum Reflex's record linking mechanism on and off. It is only
available when the active window is a database window.

The Delete Qualified Records option acts in two ways. If there
is no record qualification in the formula panel (and all records are
therefore qualified), all records will be deleted. If there is a record
qualification in the formula panel (and only a subset of the database
file is therefore currently qualified) only those records that are
qualified will be deleted. In both cases, Reflex will display a dialog
warning you of what is about to happen and you have the option of.
proceeding with the record deletions or clicking on the Cancel
button.
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Mise Menu

The Export/Import
Options

Reflex provides the Import and Export record options to enable
you to interchange information in a textual format with other
applications, or even between Reflex documents. For example,
information produced in an Reflex report can be exported and then
imported into a database file, thus creating a completely new file.
Reflex expects text files that are to be imported to have a format that
matches the field and Link list specified for the database file that will
receive the text file information. You specify the field and Link list
via a dialog box that appears whenever you select Export Qualified
Records or Import Records. Fields may be chosen for export or
import in any order you wish.
There are three import/export formats that are supported: Clipboard,
Text file, and Mail Merge.For more specific information on Import
and Export, see the discussion in the section entitled Details &
Techniques.

Delete Qualified Records
EHport Qualified Records ..•
Import Records •.•
../(heck link.,

The Check Links option is used to tum Reflex's record link
checking mechanism on and off. When there is a check mark
alongside this option, Reflex will not allow the Links in associated
records to contain inconsistent information. Check Links should
only be turned off if you need to repair a damaged database .
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LAYOUT MENU
Edit Field Qualification
Protect Object
Protect Form
Group Link Key Fields

3€Q

Data E

The Layout menu is displayed when you select Form Layout from
the Database menu. It contains options that allow you to set up field
entry qualifications, protect single objects in a form or the whole
form, and group together the copies of Key field.s that are contained
in a Link.

The Edit Field Qualification option is used to select the formula
panel in a Form Layout window so that you can insert a field
qualification if there is none, or edit any field qualification that
already exists. A field qualification is simply a qualification which
is used to monitor any entry in a specific field.
• If the field qualification is True for a field entry then the entry is
allowed to be a value of the field. Provided all other fields in that
record are also acceptable (they have no field qualifications or they
do not have field qualifications with values of False), the record may
be written to the current database.
• If the field qualification is False for a field entry, then the entry is
not allowed to be a value of the field. No record that contains a field
qualification with a value of false may be written to the current
database. The field containing the invalid entry will be selected and
an appropriate message will appear.
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Layout Menu
Protecting
Objects
The Protect Object and Protect Form options operate in a very
similar manner, they only differ in scope:
• Individual objects (a field, group of fields, labels, or pictures,
etc ... ) protected with the Protect Object option may not be modified
in any way.
• A whole data entry form protected with the Protect Form may not
be modified in any way.
Both levels of protection can be removed by selecting the relevant
menu option a second time.

•

The Group Link Key Fields option is used to disallow selection
of individual Key field copies inside a Link. Key field copies can be
ungrouped by selecting this menu option when it is checked; you
would ungroup Key field copies inside a Link to rearrange or to
resize them.

I

Edit Field Qualification
Protect Object
Protect Form
I

I

•

I

Data Entry

•

I

Edit Field Qualification
Protect Object
Protect Form
Group link Key Fields

3CQ

The Data Entry option switches a Form Layout window into a data
entry windo,W. Selecting this option replaces the Layout menu with
the Database menu.

Data [ntl Y
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REPORT MENU

"

File

Edit

Format

Describe

'. I I
Fonts Style
38=
Calculate

Window

Sort On Fields ...
Edit Formula 38Q
Edit Name
381
Protect Object
Protect Report
EHport Data ...
Show Header
Show Footer
Display
..IDesign

The Report menu contains all the options you will need to design
and calculate ~eflex reports. Data may even be exported from
reports via this menu. It is the only menu with report specific
options.

Sort On Fields
Ed~ t f ormuld
}}(~U
Ed~ t N<HfH~
}}(~ ~
Pro1 H( t nbj~:>~;1
Protect Report
EHport Data
III

III

Show Header
Show Footer
. . . . Display
Des n
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Unlik~ spreadsheet programs which typically recalculate the
complete matrix each time a value is entered, Reflex reports are
calculated manually each time you want to display them. If a report
includes one or more repeating collections, Reflex automatically
switches from Report Design to Report Display on calculation.
Select the Calculate option from this menu, or use the 00=
shortcut.

Report Menu

[d~ t N<~me
~)(~ l
Pro1 e( t Obj~~~;1
Protect Report
[Hport Data ...

When you specify which fields are to be part of the Key in a
database, Reflex uses the key field( s) to sort the records into
ascending order. The Sort On Fields ••. option is used to
produce a report sorted on fields other than the Key field(s). You
should always select the repeating collection that is to contain the
newly sorted infonnation. If you do not, Reflex will select the first
repeating collection in the report for you. If there are no repeating
collections in the report, Reflex will display the dialog shown
below:

Show Header
Show Footer
.......Display
Desi n

You must select the Repeating Collection
that you wish to sort before inuoking this
command .

I(

OK

)1

After selecting the relevant repeating collection and selecting Sort On
Fields ... , another dialog will appear asking you to select the fields to
sort on. Select each field in tum by clicking on them. For each field
to be sorted, click on either the A ...Z,O ... 9 or the Z ... A,9 ... 0 button
to tell Reflex whether you want the records to be sorted in an
ascending or descending order.
Finally, click on the OK button. The dialog will go away and the
report window you are working with will become active once again.
Use the Calculate option or 00= shortcut to see the records in their
new sort order.
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$=

The Edit Formula option is used to place the text cursor in the
Fonnula panel. If there is no text in the fonnula panel, the cursor is
placed at. the far left of the panel. If there is some text in the panel,
the whole panel is selected. You may also click directly in the panel
and change any text there by using standard Macintosh text editing
techniques.

Edit Name
Protect Object
Protect Report
EHport Data ...
I···· .. ·,,, ...... ·.. ,, .. ·,,,, .. ·· ..............·· ...... •.......... ·

Show Header
Show Footer
Display
....... Oesi n

$=

Protect Object
Protect Report
EHport Data ...
Show Header
Show Footer
Display
....... Oesi n
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The Edit Name option is used to select the contents of the Name
Panel in a report window so that you may change the name of any
currently selected object. You may also click directly in the panel
and change any text there by using standard Macintosh text editing
techniques.

Report Menu

Protecting
Reports & Report
Objects

Calculate

3€=

Sort On Fields ...
Edit Formula 3€Q
Edit Name
3€ I

As with data entry fonns, any object in a report or a complete report
itself, can be protected from accidental design changes. To protect
an object simply it and use the Protect Object option. Use
Protect Report to protect the current report. If a field is protected
or a report containing that field is protected, only the value in the
field may be edited.

Prote( t Ob jett
Prote( t Report
EHport Data ..•
Show Header
Show Footer
Display
.......Oesign

Calculate

88=

Sort On Fields ...
Edit Formula· 88Q
Edit Name
88 I
Protect Object
Protect Report

Infonnation produced in a repeating collection of a report can be
exported via the Export Data ... option. Repeating Collection
infonnation may be exported to other applications via the Macintosh
clipboard or to a text file in standard fonnat or mail merge fonnat.
However, a really powerful feature of Reflex is that you can convert
the infonnation in a report into a datbase file. To do this, simply
export repeating collection infonnation and then import it into a new
or existing database file. See the discussion on Exporting and
Importing data in the Details and Techniques section.

Show Header
Show Footer
Display
.......Oesi n
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Header and
Footer Options

Calculate

$=

Sort On Fields ...
[d~

t

~: O~lnu~<~

~)('a

t N<Hne
~)(, ~
Pro1(~( t Obj~~~;1
Protect Report
[Hport Data ...

The Show Header and Show Footer options are used to display
a header or footer for a report. You may have both a header and a
footer in a report, but they both cannot be visible and edited at the
same time. Options are:
• A global header and/or footer for a report.

[t1~

Shol1' Header
ShOll' Footer

.......Display
Design

Calculate

If a header/footer is visible, the Show Header/Show Footer option
changes to Hide Header/Footer and can then be used to hide the
header/footer.

$=

Sort On Fields •..
[d~

t

r ormu~<~

~)t'O

[dH N<HfW
~)(, ~
ProhH t Obj~~~~1
Protect Report
[Hport Data .•.

Show Header
Show Footer
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• A header or footer of a repeating collection: Since it is not
possible to predict how many records will be produced by a given
repeating collection, you are able to attach a header and/or footer to ;:
repeating collection so that if it produces more records than can fit
on a page, your selected header, or footer, will print on the bottom
of each page and the top of the next page that the repeating collectiOl
spans .

The Display option is used to swit~h from report design to report
display; the design grid lines disappear and the report contents are
displayed. If there have been no changes to the report design,
Reflex does not recalculate an already calculated report. If changes
have been made, Reflex will automatically recalculate the report for
you.

Report Menu

Calculate

8€=

Sort On Fields .•.
[d~ t l: oHnu~<}
~j[,O
[d~

t

N<m}(~

~j[, ~

Pro1 ~H t Obj~~e1
Protect Report
EHport Data ..•
Show Header
Show Footer

The Design option is used when you wish to switch from
displaying report contents to making changes to the report design.
If you attempt to make any design changes while displaying report
infonnation, Reflex will at first beep, and then display the dialog
shown below:

The last change can only be done while in
Design mode. Do you want to switch to
Design mode?
(( Design

11

( [ancel )

.....Display
Design

Click on the Design button to switch to report design work.
Alternatively, click on the Cancel button to send the dialog away.
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FONTS MENU

Times
Symbol
Los Rngeles
Heluetica
Cairo
Toronto
San Francisco
Uenice
London
Hthens
Taliesin
Chicago
Geneua
New York
Monaco
Courier
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Since Reflex data entry fonns and reports can feature labels and
fields of different fonts, the standard Macintosh Fonts menu is
included. Select the object you want to set to a particular font and
then select the relevant option from the Fonts menu. All Macintosh
fonts are supported, but the available range will depend on which
fonts you have installed or removed with Apple's Font/DA Mover™
utility. Only the first 16 fonts are shown in the menu. The Fonts
menu is only available when Fonn Layout and Report Design
windows are active. For more detailed infonnation on this menu see
Macintosh™, the owner's guide.

Fonts & Style Menus

STYLE MENU

.",.....Plain
Bold
1IIIIie
Underline

The Style menu is the companion menu to Fonts. It offers the
standard Macintosh font style options. For more detailed
information on this menu see Macintosh™, the owner's
guide.

mm1JDnm~

0lilfDaJQl[!ll
6 Point
9 Point
10 Point
12 Point
14 Point
18 Point
24 Point
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WINDOW MENU

When you have opened more than a few windows it can be difficult
to find the one you want to work with since it may be hidden from
view. In this case, go to the Window menu and select the name of
the window that you wish to work with - it will become the active
window. The name of the currently active window will always have
a check mark alongside it.

Address

City
State
Zip
netWorth

the Stocks

The Window menu is always available.
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Functions

REFLEX
FUNCTIONS

Function Types

Reflex provides a rich list of functions which can be used use to
retrieve information from database files or to create and customize
reports. Those users who are familiar with spreadsheet programs
will recognize many of the functions, but take note that some have
been enhanced for use with database files. Others are unique to
Reflex.
Reflex functions fall into five main categories:

Text Functions: These work with text strings.
Arithmetic Functions: These provide a range of sophisticated
number manipulation capabilities. Both Integers and Numbers can
be handled.
Date Functions: These work with date information.
Time Functions: These work with time values.
Special Functions: These functions provide powerful tools with
which to further retrieve data - some will be new to you. Check to
see if they are appropriate for work you are doing.
Formats, Arguments
& Results

Reflex functions may take zero, one, or more Arguments
(depending on the function), but they always only produce one
Result. Arguments can be text or numeric values, expressions, or
the result of other functions. The type of Result returned is
dependent on the function involved.

Examples:

NOW
The NOW function does not require any argument. It returns a time
result, which is in fact the current time value obtained from the
Macintosh system clock.
INT(5.1)
The INT function takes a single Number as an argument and returns
the integer (whole number) portion. In the example, INT is the
function name and 5.1 is the argument. The result would be 5.
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REPEA T(" *" ,3)
The REPEAT function takes a Text and a Number argument and
displays the text string the specified number of times. In this
example, REPEAT is the function name, "*" is the text string
argument, and 3 is the number argument. The result would be ***.

A VERAGE(1,2,3)
The AVERAGE function takes a List of Numbers as arguments and
returns that average value of that list. In the example, AVERAGE is
the function name. 1,2,3 is the argument list. The result would be 2.
Refer to the Name/Argument!Result heading over each function
name for specific guidance.
TEXT FUNCTIONS

[ CHRR ]

Result: TEXT

Argument Type: NUMBER
CHAR(Number)

The CHAR function converts a given Number value to a Text
String.
Example 1:

CHAR(13)

Example 2: CHAR( 66)

[I NCLUOES]

~
~

carriage return
B

Argument Type: TEXT

Result: LOGICAL

INCLUDES(tI Text_String", "Target_Text_Pattern")

Returns TRUE if the exact Target Text Pattern is found at any
position in Text String. Otherwise it returns FALSE.
Example: INCLUDES("Tuesday", "day")
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,

TRUE

Functions

( LEN 6TH)

Result: INTEGER

Argument Type : TEXT
LENGTH(" Text_String")

Calculates the LENGTH of any Text value and returns an Integer
value.
Example:

( LOCATE)

LENGTH("Four")

Argument Types: TEXT,TEXT

~

4

Result: INTEGER

LOCATE(" Text_String", "Target_Text_Pattern")

LOCATEs the starting position of Target Text Pattern in Text String.
• The first character of Text String is position 1, the second is 2,
etc.
• If LOCATE returns a zero value, the Target text pattern was not
found in Text String.

Example 1:

LOCATE("The result should be five","r")

~

5

This example locates the letter "r" at the beginning of the word
"result".
Example 2:

LOCATE("Tuesday", "Monday")

~

0

In this example, the locate function cannot find the text string
"Monday" in the text string "Tuesday" and so a zero result is
returned.
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(

MID)

Argument Types: TEXT,NUMBER,NUMBER

Result: TEXT

MID(ltText_String", Start_Position, Count_of_Characters)

Extracts a part of Text String, Count of Characters in length,
beginning at Start Position.
Example: MID("254 Middle Avenue, San Diego, CA",20,9)
-+ San Diego
In this example, the MID function extracts "San Diego" from the text
string.

( REPERT )

Result: TEXT

Argument Types: TEXT, NUMBER
REPEAT(" Text_String" , Repeat_Count)

Repeats Text String for Repeat Count times.
Example 1: REPEAT("Say that again .. ",2)
again .. Say that again ..

-+

Say that

This example shows how to repeat a text string a specific number of
times.
Example 2: REPEAT("*",4)

-+

****

Special characters from Macintosh fonts may be displayed a specific
number of times with the REPEAT function as well. This example
displays the "*" character four times.
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Functions

( STARTS)

Argument Types: TEXT,TEXT

Result: LOGICAL

Returns TRUE if Target String STARTS with Target Text Pattern.
Otherwise returns FALSE.

Example: STARTS("Tuesday","Tu")

-+

TRUE

ARITHMETIC
FUNCTIONS

(with zero or
one argument).

(

ABS

)

Argument Type: NUMBER

Result: NUMBER

ABS(Number)

Gives the ABSolute value of Number; it returns the magnititude of
Number without a leading sign.

Example:

(

EHP

)

ABS( -45.4)

-+

Argument Type: NUMBER

45.4

Result: NUMBER

EXP(Number)

Gives the EXPonentiation of the transcendental number represented
by the letter e raised to the power of Number. Also see the LN
arithmetic function below.

Example:

EXP(2.5)

-+

12.1824939607035
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[I NFl N 1TY]

Argument Type: NONE

Result: NUMBER

INFINITY
Gives the largest possible number - it will always be larger than any
number it is compared with, excluding INFINITY.

[

1NT

]

Argument Type: NUMBER

Result: INTEGER

INT(Number)

Gives the INTeger portion of Number
• If Number is an integer, the INT function returns the same
Number.
• If Number contains a whole number and a fraction, the INT
function strips away the fraction and returns just the whole number.
This works for positive and negative numbers.
• If Number is less than + 1 but greater than zero, the INT function
returns a zero (0).
• If Number is between - .999 ... and zero the INT function returns
a zero.

Example 1: INT(443.6)
Example 2:
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INT(.99)

443

-+
-+

0

Functions

(

LN

)

Argument Type: NUMBER

Result: NUMBER

LN(Number)

Gives the natural logarithm of Number to the base e. This is the
inverse function of EXP.
Example 1:

LN(4)

Example 2:

LN(EXP(2»

1.38629436111989

-+

-+

2

Argument Type: NUMBER

(

Result: NUMBER

LOG)
LOG (Number)

Gives the LOGarithm of Number to base 10.
Example:

LOG(100)

-+

2

Argument Type: NONE

(

Result: NUMBER

PI)
PI

Gives the value of PI (n) to 15 digits.
Example 1:. PI
Example 2:

-+

PI * 6 A 2

3.14159275358979
-+

113.097335529233

This example returns the area of a circle with a radius of 6 units of
measurement.
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( ROUND]

Argument Type: NUMBER

Result: INTEGER

ROUND(Number)

ROUNDs Number to the nearest integer value.
• If Number contains a fraction in the range 0 ... to .499 ... then
Number will be rounded down.
• If Number contains a fraction in the range .5 ... to .999 ... then

Number will be rounded up.
• If Number is negative and contains a fraction in the range 0 to

.499 ... then Number will be rounded up to the nearest whole
negative number.
• If Number is negative and contains a fraction in the range .5 to

.999 ... then Number will be rounded down to the nearest whole
negative number.

Example: ROUND(5.499981)

( SQRT ]

-+

5

Result: NUMBER

Argument Type: NUMBER
SQRT(Number)

The SQRT function computes the square root of Number.
• You are not allowed to compute the SQRT of a negative number any attempt to do so will result in an error message.
Example:
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SQRT(100)

-+

10

I

Functions
ARITHMETIC
FUNCTIONS

The general fonns for these functions are:

(with a variable
number of
arguments)

• Function_Name(formula FROM query)

[nUERRGE]

• Function_Name(formula, formula, formula, .•... )

Argument Type: LIST OF NUMBERS

Result: NUMBER

Gives the AVERAGE value of the List of Numbers.
Example 1:

A VERAGE(2,5,3,3)

Example 2:

AVERAGE(salary FROM employee) -+ $39131.66

3.25

-+

This example returns the average of all the salaries paid to
employees stored in the Employee database file.

Result: INTEGER

Argument Type: LIST

[ COUNT]
COUNT(List)

Gives the COUNT of the List. This function deals with how many
list values exist, it is not concerned with the actual list item values
themselves. The List may also be a query.
Example 1: COUNT(1,2,3,4,5)
Example 2: COUNT(employee)

-+
-+

5
15

This example returns the total number of employees stored in the
Employee database by counting the number of records.

297

(

FU

)

Argument Type: NUMBER, NUMBER, NUMBER Result: NUMBER
FV(Payment, Interest_Rate, Periods)

Returns the Future Value of the Payment compounded at the given
Interest Rate, for the specified number of Periods.
Example: FV(1000, .1, 10)

( MRH

)

~

$2593.74

Result: NUMBER

Argument Type: LIST OF NUMBERS
MAX(List_of_Numbers)

Gives the MAXimum value, or largest number, that exists in the List
of Numbers. Opposite of next function, MIN.
Example 1:

MAX(30,23,89,45)

~

89

The maximum value in the list.
Example 2: MAX(salary FROM employee)

~

$54000

The maximum salary earned by an employee in the Employee
database file.

Argument Type: LIST OF NUMBERS

(

Result: NUMBER

MIN)
MIN (List_of_Numbers)

Gives the MINimum value, or smallest number, that exists in the
List of Numbers. See previous function, MAX.
Example 1: MIN(30,23,89,45) ~ 23
Example 2: MIN(salary FROM employee)
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~

$28250

Functions

[ MOD) Argument Types: NUMBER, NUMBER

Result: NUMBER

MOD (Number, Modulus)

If both Number and Modulus are positive, MOD returns the
remainder when Number is divided by Modulus.
If both Number and Modulus are negative, MOD returns the
negative of the remainder.
If the Modulus is positive and Number is Negative the Modulus is
added to the remainder so that the Result is between zero and
Modulus minus 1.
If the Modulus is negative and the Number is positive then the
negative of the Modulus is added to the remainder so that the Result
lies between .the Modulus + 1 and zero.

• Any attempt to divide the first Number by zero will result in an
error message.
• The result will have the same sign as the second Number.

Example: 1

MOD(20, 5)

-+

0

Example 2: MOD(l8, -5)

-+

-2

Example 3: MOD(-5, 4)
Example 4: MOD(-5, -4)

-+
-+

3
-1
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(

NPU

]
Argument Types: LIST OF NUMBERS

Result: NUMBER

NPV(Interest_Rate, List_of_Numbers)

Calculates the Net Present Value (today's value) of specific amounts
of money (the List of Numbers) you will receive in the future based
on some specific Interest Rate.
• The Interest Rate is expressed in decimal fashion (.1 for 10%, .27
for 27%, etc).
• There are Numbers in the List of Numbers, representing the
income over one or more Interest Rate periods.
The example below is designed to show if it would be better to take
a lump sum payment of $10,000 now or have $12,000 paid to you
in $2,000 amounts over the next six years with an assumed inflation
rate of 10%.
Example: NPV(.l, 2000, 2000, 2000, 2000, 2000, 2000)
$9533.08

( PMT ]

......

Argument Type: NUMBER, NUMBER, NUMBER Result: NUMBER
PMT(Principal, Interest_Rate, Period)

Computes the amount of each payment required to pay back a loan
based on the Principal owed, the Interest Rate being charged, and
the number of payment Periods.
Example: PMT(5000, .01,48)

300

......

$131.67

Functions

(

PU

)

Argument Type: NUMBER, NUMBER, NUMBER Result: NUMBER
PV(Payment, Interest_Rate, Period)

The present value of Payment discounted for the numbers of
payment Periods at the specified Interest Rate.
Example: PV(1000, .1, 10)

( STDEU)

-.

Argument Type: LIST OF NUMBERS

$385.54

Result: NUMBER

STDEV(List_of_Numbers)

Gives the STandard DEViation of the List of Numbers.
Example: STDEV(43,23,81)

-. 29.461839 ....

Argument Type: LIST OF NUMBERS

Result: NUMBER

( SUM)
SUM(List_of_Numbers)

Gives the SUM of the List of Numbers.
Example 1: SUM(40,30,35)

-.

105

Example 2: SUM(salary FROM employee)

-.

$586975

This example returns a total of all the salaries paid to employees in
the Employee database file.
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TRIGONOMETRIC
FUNCTIONS

( AlA N )

For all trigonometric functions the angle is represented
in radians, where a full circle of 360 degrees is 2*PI
radians.
.

Result: ANGLE NUMBER

Argument Type: NUMBER
ATAN(Number)

Gives the ArcTANgent of Number. This is the angle for which the
TAN is the given value, ie: ATAN(TAN(x)) = x.

Example: ATAN(l)

(

COS)

.....

.785398163397448

Argument Type: ANGLE NUMBER

Result: NUMBER

COS(Angle_Number)

Gives the COSine of Angle Value.

Example: COS (PI/3)

.....

.5

Argument Type: ANGLE NUMBER

(

SIN)
SIN(Angle_Number)

Gives the SINe of Angle Number.

Example: SIN(PI/6)
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...... 5

Result: NUMBER

Functions

(

TR N

)

Result: NUMBER

Argument Type: ANGLE NUMBER
TAN(Angle_Number)

Gives the TANgent of Angle Number.

Example: TAN(PI/4)

-+

1

DATE FUNCTIONS

( DATE)

Argument Types: INTEGER,INTEGER,INTEGER

Result: DATE

DATE(Year_value, Month_value, Day_value)

The DATE function allows you to manipulate date values.

Example 1: DATE(82,3,21)

-+

3/21/82

This example shows how integer values may be converted to a Date.

Example 2:
DATE(YEAR(TODAY)+l, MONTH(TODAY),DAY(TODAY)) -+

9/25/86

This example shows how you can produce a date one year ahead of
Today's date, which is September 25,1985. (The TODAY function
obtains the date information from the Macintosh system
clock/calendar).
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( YERR )

Result: INTEGER

Argument Type: DATE
YEAR(Date_ Value)

The YEAR function extracts the year value as an integer from Date
Value so that you can view it or apply mathematical operations to it.
• The "@" symbol must precede all date constants in formulas.

,

Example: YEAR(@6/27/46)+40

( MONTH)

-+

1986

Result: INTEGER

Argument Type: DATE
MONTH(Date_ value)

The MONTH function extracts the month value as an integer from
Date Value so that you can view it or apply mathematical operations
to it.
• The "@" symbol must precede all date constants in formulas.

(

Example: MONTH(@6/27/45)+2

-+

Argument Type: DATE

Result: INTEGER

8

DRY)
DAY(Date_Value)

The DAY function extracts the day value as an integer from Date
Value so that you can view it or apply mathematical operations to it.
• The "@" symbol must precede all date constants in formulas.

Example: DAY(@6/27/45)
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-+

27

Functions

( TI ME )

Argument Types: INTEGER, INTEGER, INTEGER

Result: TIME

TIME(Hour_Integer, Minute_Integer, Second_Integer)

• The TIME function allows you to manipulate time values.

Example: TIME(9,3,2)

.....

9:03:02

The .example shows how integer values may be converted to a Time.

( HOUR)

Argument Type: TIME

Result: INTEGER

HOUR(Time_Value)

The HOUR function extracts the hour value as an Integer from Time
Value so that you can view it or apply mathematical operations to it.
• The "@" symbol must precede all time constants in formulas.

Example: HOUR(@ 11 :22:54)

.....

Argument Type: TIME

11

Result: INTEGER

(MINUTE)
MINUTE(Time_Value)

The MINUTE function extracts the month value as an integer from
Time Value so that you can view it or apply mathematical operations
to it.
• The "@" symbol must precede all time constants in formulas.

Example: MINUTE(@11:22:54)

.....

22
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( SECOND)

Result: INTEGER

Argument Type: TIME
SECOND(Time_Value)

The SECOND function extracts the second value as an integer from
Time Value so that you can view it or apply mathematical operations
to it.
• The "@" symbol must precede all time constants in formulas.

( TODAY)

Example: SECOND(@11:22:54)

-+

Argument Type: NONE

Result: DATE

54

TODAY

Obtains today's date from the Macintosh system clock/calendar and
will therefore only be as accurate as the settings of your Macintosh
clock/calendar.

Example: TODAY -+ 11/20/85

Argument Type: NONE

Result: TIME

( NOW)
NOW

The NOW function obtains the current time from the Macintosh's
system clock and will therefore only be as accurate as the setting of
your Macintosh system clock.

Example: NOW
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-+

10:52:21

Functions
SPECIAL
FUNCTIONS

( ERROR)

Result: ERROR

Argument Type: NUMBER
ERROR(Error_Number)

Generates a specific Reflex error message, dependent on the value
of Error Number.
• The error number can be chosen from the range 0 - 42 (see the
section on Error Messages).

Example 1:
"

File

Edit

Format

Describe

Report

Fonts

§D

Style

Wi

function_report

[X] f 1

IF(Testfield

·

.

.

.

.

= 100;That's OK",ERROR(O»
.

?: .... C·.·.·.·.·.·.·.·.·.·.·.·.·.~.:·.·.·.·.·.·.·.·.·.:·.·.·.~

....... ~ .. T e~ t fie 1

...... ~rror !est: ....... 1

..

··

.

..

.............:..............~.:......................·.·.~.·.·.·.:·.·.·.·.·.·.·.·.·.~·.9.1· ... j ....... j . .. . . ..

. .... .

ERR?RI.... j ....... j ............ .

..

..

..

..

ERROR(O) is used as a general error indicator.
Example 2:
"

File

Edit

Format

§D

Describe

Report

Fonts

Style

Wir

Function_Report

IX] f 1

ERROR( 1 1)

....... · ...... 1

ERROR( 11 ;'Wrong Type of Argument .. )I ..

T.. ·.. · .......

ERROR(ll) generates a specific error message
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( EHI STS)

Result: LOGICAL

Argument Type: ANY
EXISTS(Name or Query)

The EXISTS function can be used in two ways. It can check to see
if a field has a non-blank value. It can also be used to check if there
is at least one record in a database file or repeating collection that
meets a qualification.

Example 1:

EXISTS(employee WHERE LENGTH(LastName) = 6)

-+

TRUE

This example checks a database file called Employee for any records
that have a LastName field that contains a value with exactly six
characters. If it finds one, it does not return the field value - it just
returns TRUE. If no records had met the criteria, then EXISTS
would have returned a value of FALSE.

Example 2:

COUNT(employee WHERE EXISTS(Homephone))

This example gives the count of people in a database file called
Employee who have a value in the Homephone field (the Employee
file supplied with Reflex does not have a Homephone field, but you
can add one if you wish).

FRLSE

Result: LOGICAL

Argument Type: NONE
FALSE

Can be used within a formula to indicate that a condition has a value
of FALSE. See NO, YES, and TRUE for companion functions.

Example:

308

FALSE

-+

FALSE

Functions

[___I_F__J

Argument Types: LOGICAL, ANY, ANY

Result: ANY

IF(Condition, Then_Formula, Else_Formula)
If Condition is true, return Then Formula. If Condition is false,
return Else Formula.

• The True and False formulas may be any Reflex formulas.

Example: IF(100 < 200,"Correct","Incorrect")

[I SERROR J Argument Type:

Any

-+

Correct

Result: LOGICAL

ISERROR(Formula)

Returns TRVE if the value of the Argument is one of the defined
Reflex Error values.

[

I SNR J

Argument Type: Any

Result: LOGICAL

ISNA(Formula)

Returns TRVE if the value of the Argument is N A.
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[LOOKUP)

Argument Type: Formula FROM Query

Result: ANY

LOOKUP(Formula FROM Query)

The LOOKUP function finds the first record from the query that
meets its qualification and computes the formula for that record and
then returns the computed value. If no record is found that meets the
qualification the LOOKUP function returns NA.

Example 1: LOOKUP(netWorth FROM person WHERE
FirstName = "Mark") -+ $400000
Example 2:
LOOKUP(FirstName&" "&LastName FROM
person WHERE
city = "Los Altos") -+ Mark Hoffman
This example will return a concatenated field (made up of the
FirstName and LastName fields) for each person in the Person
database file that lives in Los Altos.

[

NR

)

Argument Type: NONE

Result: NA

NA

Used to generate the Not Available indicator.

Example: NA
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-+

NA

I

Functions

NO

Argument Type: NONE

Result: Logical

NO
Can be used within a formula to indicate a negative condition - the
NO function is equivalent to the FALSE function. Also see YES and
TRUE.

[PREUIOUS)

Example: NO

-+

Argument Type:

NONE

NO

Result: ANY

PREVIOUS

The PREVIOUS function only works within repeating collections. It
allows you to obtain a running calculation of various field values
included in a repeating collection.
• The Total field shown below will produce a running total of the
salary field in the repeating collection and contains the formula:
Salary + PREVIOUS.

Example:

'*

File

Edit

Format

Describe

D

!Xl

Report

Fonts

Style

Window

Function Report
f3

salary+PREVIOUS

Salary + Previous:

r·· ..·················································· ................. ':

Report Display
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TRUE

Result: LOGICAL

Argument Type: NONE

TRUE
Can be used within a fonnula to indicate that a condition is TRUE.
See YES, FALSE, and NO for companion functions.
Example: TRUE

YES

-+

TRUE

Argument Type: NONE

Result: LOGICAL

YES
Can be used within a fonnula to indicate an affirmative conditionthe YES function is equivalent to the TRUE function. Also see NO
and FALSE.
Example: YES -+ YES
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Reflex Error Messages

REFLEX ERROR MESSAGES

ERROR(l,"Text Result Required")
This error message occurs when you attempt to display a non-text
result in a field of type Text.
ERROR(2,"Numeric Result Required")
This error message occurs when you attempt to display a nonnumeric result in a field of type Number or Integer.
ERROR(3, "Date Result Required")
This error message occurs when you attempt to display a non-date
result in a field of type Date.
ERROR(4, "Logical Result Required")
This error message occurs when you attempt to display a non-logical
result in a field of type Logical.
ERROR(5, "Time Result Required")
This error message occurs when you attempt to display a non-time
result in a field of type Time.
ERROR(6, "Text Argument Required")
This error message occurs when a Text argument is required but you
have supplied some other argument type.
ERROR(7, "Numeric Argument Required")
This error message occurs when a Numeric argument is required but
you have supplied some other argument type.
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ERROR(8, "Date Argument Required"}
This error message occurs when a Date argument is required but you
have supplied some other argument type.

ERROR(9, "Logical Argument Required"}
This error message occurs when a Logical argument is required but
you have supplied some other argument type.

ERROR(lO, "Time Argument Required"}
This error message occurs when a Time argument is required but
you have supplied some other argument type.

ERROR(ll, "Wrong Type of Argument"}
This error message occurs when a specific argument is required but
you have supplied some other invalid type.

ERROR(12, "Reference to Error Value"}
This error message occurs when you refer to an object that contains
a value of type ERROR.

ERROR(13, "Missing Arguments"}
This error message occurs when one or more arguments are missing
from a formula.

ERROR(14, "SQRT Argument Negative"}
This error message occurs when you try to obtain the square root of
a negative number.

ERROR(15, "+ or - Arguments Infinite"}
This error message occurs when you attempt to add -INFINITY to
INFINITY or subtract INFINITY from INFINITY.
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ERROR(16, ,,/ Arguments Invalid"}
This error message occurs when you attempt an invalid division
operation (eg: 0 / 0 or INFINITY / INFINITY).
ERROR(17,

"* Arguments Invalid"}

This error message occurs when you attempt an invalid
multiplication operation (eg: 0 * INFINITY).
ERROR(18, "MOD Argument Zero"}
This error occurs when you attempt supply the MOD function with a
zero argument.
ERROR(19, "SIN, COS or TAN Argument Infinite"}
This error message occurs when you attempt an invalid operation
with one of these functions such as: SIN(lNFINITY) or SIN(INFINITY).
ERROR(20, "LOG or LN Argument Negative"}
This error message occurs when you attempt to use either function
with a negative number.
ERROR(21,

"A

Argument Invalid"}

This error message occurs when you attempt an invalid operation
with this function such as: -3 1\ .5
ERROR(22, "NPV, PV, FV, PMT Interest Argument
Invalid"}
This error message occurs when you supply an invalid NPV interest
rate argument to one of these function, such as: NPV(-2,4,4)
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ERROR(23, "Number too large for Integer")
This error message occurs when you compute a number that is too
large to be handled by an Integer type field.

ERROR(24, "Name not found")
This error message occurs when you supply a Name Reference and
the name you refer to does not exist, or is not available on currently
mounted disks.

ERROR(25, "Circular Reference")
This error message occurs in a number of ways:
• When you have a field refer to itself.
• When you have field A refer to field B and field B refer to field

A.

• When you have field A refer to field B, field B refer to field C, ...
refer to field X, and field X refer to field A.

ERROR(26, "Reference is not a valid Source")
This error message occurs when you attempt to make a reference to
a component of something that is not a Source (a field, for example)
and therefore has po components.

ERROR(27, "Name not found in Source"}
This error message occurs when you use a correct reference to a
component of a Source, but the component you specify does not
actually exist.

ERROR(28, "Empty Link")
This error message occurs when you make a correct reference to a
component of a Link and that Link contains nothing - it is empty.
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ERROR(29, "Invalid Reference to Link Collection"}
This error message occurs when you make a correct reference to a
component of a Link Collection as if it were just a simple Link - the
Link Collection contains many Links and you have just asked for an
unspecified single value.

ERROR(30, "Linked Record not found")
This error message occurs when you reference a link and the linked
record is not found. The message will appear when the Links
between records are inconsistent (corrupted) in some way.

ERROR(31, "MID or REPEAT Argument Invalid"}
This error message occurs when you use a negative Number
argument with either function, such as: MID("Hello", 2, -2}.

ERROR(32, "DATE Argument Invalid"}
This error message occurs when you attempt to use an invalid date
argument with the DATE function such as:
DATE(1985,99,3)
This example has a bad second argument for the month.

ERROR(33, "TIME Argument Invalid"}
This error message occurs when you attempt to use an invalid time
argument with the TIME function such as:
TIME(-8,45,0)
This example has a bad first argument for the hour.

ERROR(34, "Query used incorrectly"}
This error message occurs when you use a Query in the wrong
place, or context such as:
3+Person WHERE Networth > 10000.
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ERROR(35, "Query required")
This- error message occurs when you needed to use a Query but did
not supply one, such as:
LOOKUP (Networth FROM 12).

ERROR(36, "Source Reference Required")
This error message occurs when you needed to supply a reference to
a Source, but did not do so, such as:
LOOKUP (Networth FROM StockReport).

ERROR(37, "Empty Repeating Collection")
This error message occurs when you attempt to calculate a report
that includes a repeating collection that does not contain anything for
displaying the report contents.

ERROR(38, "Not Implemented")
This error message occurs when you attempt to use a new feature
not supported in this version of Reflex.

ERROR(39, "Damaged Formula")
This error message occurs when the internal representation of a
formula has been corrupted. This is a very severe error and should
be reported to Borland International.

ERROR(40, "Unknown Arithmetic Problem")
This error message occurs when Reflex cannot detect the specific
nature of an arithmetic problem. This is a very severe error and
should be reported to Borland International.
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ERROR(41, "Unknown Calculation Problem")
This error message occurs when there has been some unspecified
internal Reflex problem in calculation. This is a very severe error
and should be reported to Borland International.

ERROR(42, "LOOKUP returned Not Available")
This error message occurs when you use the LOOKUP function in a
Record Qualification Formula in a database window and it does not
return the value of TRUE or FALSE - the value(s) you wanted were
Not Available (i.e. NA).
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REFLEX
DATA SHEET
General

> Runs on any 512K+ Mac, Mac XL or Macintosh Plus
> Runs under the Switcher with minimum 300K partition
> Uses additional memory as database buffers for increased
performance
> Context sensitive Help facility
> Hard disk install

Database Design

> Fully Relational, multiple file database
> Maximum field length: 1002 bytes
> Maximum fields per record: 254
> Maximum record length: 1008 bytes
> Maximum records per file: limited only by capacity of disk
> Number of open files: 15
> Design of a database file, its fields, and Links to other files
through visual layout of file images on the Database
. Overview
> Database fields can be Text, Number, Integer, Date, Time,
Logical, or Sequence Number data types.
> Links between files (1-1, I-many, many-many) are defined by
simply drawing lines between database file images.
> Can add, delete, rename, reorder, and change types of fields and
Links, with automatic restructuring of data.
> Multi-field keys.

Visual Layout

>
>
>
>
>
>
>
>
>
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Visual layout of the data entry form and report design allowed
Change size, shape and position of fields
Add, edit, and/or move text labels
Paste pictures from Clipboard into data entry form or report
design
Alignment and formatting of objects.
Grid shown on screen with automatic alignment to grid to
simplify layout
Display format for numbers: General, Decimal, Scientific,
Dollars, Percent with Digits and Commas.
Display format for dates: Short, Long, and Abbreviated.
Complete selection of Macintosh fonts, sizes and styles

Reflex Oata Sheet

Data Entry

Report
Generation

> Data entry fonn can be customized using Visual Layout
> QueryBuild feature can be used to easily retrieve records based
on qualification of values of database fields combined with
AND and OR.
> User can perfonn more complex retrievals by entering arbitrary
fonnulas
> Automatically checks for data of correct type for each field
> User can define more specialized data checks for each field.
> Consistency of Links between files is automatically maintained
(i.e. checks that mentioned record exists)
> Export/lmport data to/from Text files
> Supports Export of data for mail merge operations.

>
>
>

>
>
>
>
>
>
>

>
>
>
>

>

Automatic generation of simple table-style reports for a database
file
Reports can also be designed using Visual Layout
Can reference values in database files by using relational
database functions and operators
Can reference values in other reports
Computed fields with full set of logical, arithmetic, date, time,
statistical, comparison, and text functions and operators
Summary Functions (i.e. COUNT, SUM, AVERAGE, MIN,
MAX, STDEV and NPV) can be perfonned
QueryBuild feature can be used in reports to help construct
database record qualifications
Natural order of evaluation (includes references to other reports)
Repeating Collections allow the calculation of arbitrary values to
be perfonned for each specified record of a database file.
Report layout automatically modified to allow display of these
multiple calculated values in Repeating Collections
Repeating Collections include as a special case nested control
breaks with arbitrary summary calculations
Sorting by multiple values of each Repeating Collection level
Headers, Footers and control over Page breaks
Print report to Screen, to Printer, or Export to Text file (can then
be Imported back into database file to add or update data
records)
Print quality: Draft, Standard, & High Resolution
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New Reflex
Features

>

Rapid browsing through a database. Press Command-Shift N (or
hold down Shift while selecting Next Record from the Search menu) to
scroll 10 qualified records forward through the database. To scroll
backward, press Command-Shift P (or hold down Shift while selecting
Previous Record from the Search menu).

>

Griding by fractions of an inch. Major grid divisions occur every
half inch. Grid points for alignment occur every eighth inch.

>

Finding help under HFS. Under HFS, Reflex looks for the help
file first in the Reflex folder, then in the executed volume, and finally in
all mounted volumes.

>
>

Bumping sequence numbers when Make Copy of Record is chosen.
New option in Overview Menu: Change File Destination.
This will create a new version of the database on the chosen volume and
then delete the old version of the database.

>

Faster selecting of groups of objects in form design. Press
the option key and drag a "lasso" box similar to Finder's. Release the
mouse to select all objects completely enclosed by the box.

>

Additional operations on a group of selected objects. You
can perform the following operations on a group of selected fields: field
type changes, display format changes, font changes, style changes, protect
(unprotect) objects, and text alignment.

>

Controlling page breaks in repeating collections. Select a
repeating collection and choose No Page Breaks from the Describe menu.

>

Supporting non-standard paper sizes. Use the Paper Sizes
command from the File menu to customize page sizes. This information
will be valid for all printers except the LaserWriter, which uses the
system's page size information.

>

Supporting custom import/export files. Select the Custom
Text File button in the first export or import dialog box.

>

Second LOOKUP argument. The LOOKUP function now accepts
an optional second argument. NA will be returned as the default if a
second argument is not specified. For example,

LOOKUP(Amount FROM Order WHERE Name=" -none-" ,0)
return the value zero.

>

WEEKDAY function. This function takes a date argument and
returns an integer for the corresponding day of the week (1 for Sunday, 2
for Monday, 3 for Tuesday, and so forth). For example,
WEEKDAY (@1217/41) returns 1 since Dec. 7, 1941, was a Sunday.

>

Date/Time arithmetic. The following expressions involving dates,
time values, and integers are now supported: date - date, date
+ integer, date - integer, time - time, time + integer, time - integer
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INDEX
A
Activity Indicator 15
Data Entry 15,178
Data Entry Fonn Layout 65
Report Design 47-48
Report Display 47-48
Adding
Fields in Files 7-10,58-59,99-100,103
Fields in Reports 134-135
Labels 144
Links 105-110,173-174
Repeating Collection 137-139
Aligning Objects in Fonns 140-144,248-250

B
Backing Up databases v

c
Called Option 187,217
See Also: Names
Carriage Returns in Fields 180
Check Links Command 277
See Also: Links
Clear Command 240
Closing All Documents 21,233
Concatenating Fields 158,220
Copy Command 238
Creating
Fields in Files 7-10,58-59,99-100,103
Fields in Reports 134-135
Files 5-13,167-168,229
Labels 144
Links 105-110,173-174
Repeating Collection 137-139
Cut Command 238

D
Data Entry 15-19,113-126

See Also: Records,Files
Data Sheet 320-321

Data Type,Fields 8,100,170-171,178,209-214
Date 10,212,256
Integer 103,211,255
Logical 213,256
Number 103,211,255
Sequence 214,257
Text 209-210,254
Time 213,257
Database
Backing Up v
Creating 97-113,167-168
Deleting a File 201-202
Design Concepts 85-96
Renaming a File 201-202
Restoring v
See Also: Files
Database Overview Window 4,167-177
Changing File Designs 58-59,99-100,104-110
Hiding File Images 22,176-177 ,267
Reverting to Old Design 59-60,234
Saving Design Changes 14-15,175-176,233
Showing File Images 21,97-98,176,266,267
Date Fields 10,72-73,173,212,246,256
Duplicate Command 241
Duplicating Objects 135,241

E
Errors
In Field Calculation 136
List of Calculation Errors 313
Exporting Data 188-191,196-199,277
Expressions,See Fonnulas

F
Fields 2
Aligning 140-144,248-250
Contents 17
Contents Alignment 76,172,245
Converting Fields to a Link 200-201
Creating 7-10,58-59,134-135,169
Data Types 8,100,103-104,170-171,178,
209-214
Deleting 48-49,169
Display Fonnat 72-74,172-173,245-247
Field Qualifications 178-179,203,278
File Images 7
Justification 76,172,245
Moving Between Fields 18,57,180
Names 7,149,169.
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Fields (continued)
Renaming 169
Resizing 67
Variable Height 173,247
File Image 6
Adding Fields 58-59,99-100,103,169,268
Changing Key Fields 11-13,54-57,171-172,259
Deleting Fields 169
Fields 7
Hiding File Images 22,176-177,267
Moving 168
Name Bar 6
Overlapping 168
Protecting Design 268
Status Icon 7,14,20
See also: Database Overview Window
Files 2
Adding Fields 58-59,99-100,103,169,268
Changing File Designs 58-59,99-100,104-110
Changing Form 64-74,272
Changing Key Fields 11-13,54-57,171-172,259
Creating 5-13,101-102,167-168,229
Deleting 201-202
Deleting Fields 169
Field Qualifications 178-179,203,278
Finding All Records 28-29,274
Finding First, Last, Next, Prior 22-23,26,273~274
Hiding File Images 22,176-177,267
Opening 15,231
Protecting Design 268
Renaming 201-202
Reverting to Old Design 59-60,234
Saving Design Changes 14-15,175-176,233
Searching 3,22-29,274,275
Showing File Images 21,97-98,176,266,267
Using Querybuild Dialog 23-26,274
See Also: Searching,Records
Finder,Returning to 228,236
Fonts 182,286-287
Setting Default Font & Style 182
Form Layout, Files 64-76,181-184
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Using Pictures 184,203
See Also: Files,Records
Formula Panel 15-16
Data Entry 15-16,178
Editing Qualification for Search 27-28
Report 34,35,135-139
Resizing 15-16
See Also: Formulas
Formulas 209-222
Arithmetic Operators 219
Automatic Conversions 219,220
Calculation in Report 34,35,135-139
Comparison Operators 221
Editing Qualification for Search 27-28
Field Qualification 178-179,203,278
Logical Operators 221
Order of Evaluation 219
Syntax 222
Text Operator 220
Functions 218,242,289-312
ABS 293
ATAN 302
AVERAGE 297
CHAR 290
COS 302
COUNT 297
DATE 303
DAY 304
ERROR 307
EXISTS 152-153,308
EXP293
FALSE 308
FV298
HOUR 305
IF 309
INCLUDES 290
INFINITY 294
INT294
ISERROR 309
ISNA 309
LENGTH 291
LN295

Functions (Continued)
MID 198,292
MIN 298
MINUTE 305
MOD 299
MONTH 304
NA310
NO 311
NOW 306
NPV 300
PI 295
PMT300
PREVIOUS 311
PV301
REPEAT 292
ROUND 296
SECOND 306
SIN 302
SQRT296
STARTS 293
STDEV 301
SUM 149-150,155-157,301
TAN 303
TIME 305
TODAY 306
TRUE 312
YEAR 304
YES 312

G
Grid 251
Align to Grid 251
Hidirig 251

H
Halting Length Operations 194
Help 166-167,226-227
Finding Out About Menus 167,227
Finding Out About Objects 167,227
Finding Out About Topics 166,226

IJ

Installing Reflex iii
Integer Fields 103,172,211,246,255

K
Key Fields 11-13,259
And Sort Order 54
Changing 54-57,171-172,195-196,259
Links as Keys 110-111, 119-121

L
Labels 260
Changing 65-66
Contents Alignment 245
Creating 144
Data Entry Form 15,17,65-66
Deleting 49-50
Justification 245
Report 34
Links 90-96,104-111,261-262
As Keys 110-111, 119-121
Changing Data 117
Changing, Design 108-110,175,258
Check Links Command 277
Converting Fields to a Link 200-201
Creating 104-110,173-174
Deleting 174-175,271
Display in Data Entry 114-115
Entering 118-126,271
Exporting 189,200-201
Importing 189,200-201
In Form Layout 279
In Formulas 152-161,215-216
Showing Linked Record 116-271
Loading Data From Other Programs 188-191
See Also: Importing Data, Exporting Data
Logical Fields 213,256

M
Menu Bars 223-224
Multiple Object Selections 50-51,68-71
Moving Multiple Objects 50-51,68-7.1

Icons, Finder 165
Importing Data 188-191,196-100,277
Links 189
MicrosoftTM Mail Merge Format 189
Text Format 189
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N

Q

Name Panel 15-16
Data Entry 15-16,178
Report 34,149
Resizing 15-16
Names 7,149,186-188
Fields in Files 7,186
Files and Reports 6-7,187
In Formulas 187-188,214-216
See Also: Name Panel
Number Fields 103,172,211,246,255

Queries
Building Queries with Paste Query 38-46
Editing Repeating Collection Query 23-26,146-147
Examples 43-46
Formulas 209-222
Using Querybuild Dialog 23-26,274
See Also: Reports,Searching,Repeating Collections
Quit Command 228,236

o
Opening
Files 15,231
Reports 232
Operators
Arithmetic: +,-,* ,/,A 219
Comparison: =,<>,<,>,<=,>= 221
Logical: AND,OR,NOT 147,221
Text: & 158,220

p
Page Headers & Footers 192-193,264,284
Creating 192-193,284
Deleting 193
Page Width Line 252
Paste Command 239
Paste Function Command 242
Paste Query Command 243
Printing 191-192,235
Headers & Footers 192,193
Keeping Objects on a Page 193,264
Page Breaks 194,265
Page Setup 235
Page Width Line 252
See Also: Page Headers & Footers
Protecting
Database Design 268
Form 279
Object in Form 268,279,283
Report 283

R
Records 2
Auto Save 181
Copying 270
Deleting 270,276
Entering 17-19,180-181,269,270
Finding All Records 28-29,274
Finding First,Last, Next and Prior 22-23,26,273-274
Modifying 180,205,270
Moving Between Fields 18,57,180
Revert to Old Record 234
Saving to Disk 18-19,181,233
Searching 3,22-29,274,275
Using Querybuild Dialog 23-26,274
Validation 18-19,178-179,180-181,203
See Also: Files,Searching
Repeating Collections 34-35,188
Building Queries with Paste Query 38-46
Creating 137-139,263
Displaying Records 35,134-139
Displaying Records via Links 157-161
Editing Query 23-26,146-148
Exporting Data 38,190-191,196-201
Headers and Footers 193
Names 149
Qualifications 35,38-46
Resizing 51-52
Selecting 38
Sorting 36-37,281
Reports 3,184-186
Building Queries with Paste Query 38-46
Calculating 38,280
Creating 30-53,77-82,132-161,184-186,230
Designing 47-48,285
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Reports (continued)
Displaying 47-48,284
Exporting Data 38,190-191,196-201,283
Free Fonn 31,134-161,185-186
Pictures 203-204,184
Status Icon 34
Table Style 30-34,77-78,184-186
Totals 149-150,155-157
See Also: Repeating Collections
Restoring Databases v
Revert Command 234

uv
Undo Command 237

WXYZ
Window Menu 117,288

s
Save As Command 234
Save Command 233
Saving File Design Changes 14-15,233
Searching Files 3,22-29
Editing Qualification for Search 27-28
Finding All Records 28-29,274
Finding First,Last, Next and Prior 22-23,26,273-274
Using Querybuild Dialog 23-26,274
See Also: Records,Files,Reports
Selecting Multiple Objects 50-51,68-71
Moving Multiple Objects 50-51,68-71
Sequence Fields 13,61,214,246,257
Sorting 36-37,78-79,81-82,209-214,281
Default Sort Order 54,57
Source 136-137,152,146
Status Icon
Data Entry 18
File Image 7,14,20
Report 34
Stopping Lengthy Operations 194

T
Text Fields 209-210,246,254
Inserting Carriage Returns 180
Variable Height 173,247
Time Fields 213,257
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4585 Scotts Valley Drive, Scotts Valley, CA 95066

Available ~ better dealers nationwide.
To order by credit card, call (800) 256-8008; CA (BOO) 742-1133.

SlDllla"
Whether you're running WordStar,® Lotus,® dBASE,®
or any other program, SideKick puts all these desktop
accessories at your fingertips-Instantly
A full-screen WordStar-like Editor to jot
down notes and edit files up to 25 pages long.
A Phone Directory for names, addresses, and
telephone numbers. Finding a name or a
number is a snap.
An Autodialer for all your phone calls. It will
look up and dial telephone numbers for you.
(A modem is required to use this function.)

All the SideKick windows stacked up over Lotus 1-2-3."
From bottom to top: SideKick's "Menu Window," ASCII
Table, Notepad, Calculator, Appointment Calendar, Monthly
Calendar, and Phone Dialer.

A Monthly Calendar from 1901 through 2099.
Appointment Calendar to remind you of
important meetings and appointments.
A lull-Ieatured Calculator ideal for business
use. It also performs decimal to hexidecimal to
binary conversions.
An ASCII Table for easy reference.

Here's SideKick running over Lotus 1-2-3. In the SideKick
Notepad you'll notice data that's been imported directly
from the Lotus screen. In the upper right you can see the
Calculator.

The Critics' Choice
"In a simple, beautiful implementation of WordStar's
block copy commands, SideKick can transport all or
any part of the display screen (even an area overlaid
by the notepad display) to the notepad."
-Charles Petzold, PC MAGAZINE

"SideKick is by far the best we've seen. It is also the
least expensive·'Ron Mansfield, ENTREPRENEUR
"If you use a PC, get SideKick. You'll soon become
dependent on it."
-Jerry Pournelle, BYTE

"SideKick deserves a place in every PC."
-Gary Ray, PC WEEK

Suggested Retail Price: $54.95 (copy protected); $84.95 (not copy protected)
Minimum system configuration: IBM PC, XT, AT, PCjr and true compatibles. The IBM PCjr will only accept the
SideKick not-copy-protected versions. PC-DOS 2.0 (MS-DOS) or greater. 128K RAM. One disk drive. A Hayes-compatible modem,
IBM PCjr internal modem, or AT&T Modem 4000 is required for the autodialer function.
SideKick is a registered trademark 01 Borland International, Inc. dBASE is a registered trademark 01
Ashton-Tate. IBM, XT, AT, and PCjr are registered trademarks 01 International Business Machines Corp.
AT&T is a registered trademark 01 American Telephone & Telegraph Company. Lotus and 1-2-3 are
registered trademarks of Lotus Development Corp. WordStar is a registered trademark of MicroPro
International Corp. Hayes is a trademark of Hayes Microcomputer Products, Inc.
BOR 0060A

SideKick, The Macintosh Office Manager,TM brings
information management, desktop organization, and
telecommunications to your Macintosh.TM Instantly,
while running any other program
A full-screen editor/mini-word processor
lets you jot down notes and create or edit
files. Your files can also be used by your
favorite word processing program, like
MacWrite" or Microsoft8 Word.

A convenient alarm system alerts you to
daily engagements.

A complete telecommunications program
sends or receives information from any
on-line network or electronic bulletin
board while using any of your favorite
application programs.

Aphone log keeps a complete record of all
your telephone activities. It even computes
the cost of every call.
Area code look-up provides instant access
to the state, region, and time zone for all
area codes.

A full-featured financial and scientific
calculator sends a paper -tape output to
your screen or printer and comes
complete with function keys for financial
modeling purposes.

An expense account file records your
business and travel expenses.
A credit card file keeps track of your credit
card balances and credit limits.

A print spooler prints any "text only" file
while you run other programs.
A versatile calendar lets you view your
appointments for a day, a week, or an
entire month. You can easily print out your
schedule for quick reference.
A convenient "Things-to-Do" file reminds
you of important tasks.

PhoneLink allows you to autodial any
phone number, as well as acces any longdistance carrier (modem required).

A report generator prints out your mailing
list labels, phone directory, and weekly
calendar in convenient sizes.
A convenient analog clock with a sweeping
second-hand can be displayed anywhere
on your screen.
On-line help is available for all of the
" powerful SideKick features.

Best of all, everything runs concurrently

Suggested Retail Price: $99.95 (not copy protected)
Minimum system configuration: 128K RAM and one disk drive. Two disk drives are recommended If you wish to use other
application programs. HFS compatible.

SideKick is a registered trademark and PhooeLink is a trademark of Borland International. Inc.
Macintosh is a trademark of Mcintosh Laboratory, Inc. licensed to Apple Computer, Inc.
MacWrite is a trademark of Apple Computer, Inc. Microsoft Word is aregistered trademark of
Microsoft Corp.
BOR0069A

The Organizer For The Computer Age!
Traveling SideKick is BinderWare;M both a binder you take with you when you travel
and a software program-which includes a Report Generator-that generates and
prints out all the information you'll need to take with you.
Information like your phone list, your client list,
your address book, your calendar, and your
apPointments. The appointment or calendar files
you're already using in your SideKicke can automatically be used by your Traveling SideKick. You
don't waste time and effort reentering information
that's already there.
One keystroke prints out a form like your address
book. No need to change printer paper;
What's inside Traveling SideKick

you simply punch three holes, fold and clip
the form into your Traveling SideKick binder, and
you're on your way. Because Traveling SideKick is
CAD (Computer-Age Designed), you don't fool
around with low-tech tools like scissors, tape, or
staples. And because Traveling SideKick is
electronic, it works this year, next year, and all the
"next years" after that. Old-fashioned daytime
organizers are history in 365 days.

What the software program and its
Report Generator do for you before
you go-and when you get back
Before you go:
• Prints out your calendar,
appointments, addresses, phone
directory, and whatever other
information you need from your
data files
When you return:
• Lets you quickly and easily enter all
the new names you obtained while
you were away into your
SideKick data files

It can a/so:
• Sort your address book by contact,
zip code or company name
• Print mailing labels
• Print information selectively
• Search files for existing addresses
or calendar engagements

*Suggested Retail Price: $69.95
Minimum system configuration: IBM PC, XT, AT, Portable, PCjr, 3270 and true compatibles. PC-DOS (MS-DOS) 2.0 or later.
256K RAM mimlmum.
·Speclal introductory oHer

SideKick and Traveling SideKick are registered trademarks and BinderWare is a trademark of
Borland International, Inc. IBM, AT, XT, and PCjr are registered trademarks of International
Business Machines Corp. MS-DOS is a registered trademark of Microsoft Corp.
BOR 0083

SUlerler

e

INCREASE YOUR PRODUCTIVITY
BY 50% OR YOUR MONEY BACK
SuperKey turns 1,000 keystrokes into 11
Yes, SuperKey can record lengthy keystroke sequences and play them back at the touch of a
single key. Instantly. Like magic.
Say, for example, you want to add a column of figures in 1-2-3.- Without SuperKey, you'd
have to type 5 keystrokes just to get started: @ sum ( . With SuperKey, you can turn those
5 keystrokes into 1.

SuperKey keeps your confidentialfiles-CONFIDENTIALI
Time after time you've experienced it: anyone can walk up to your PC and read your
confidential files (tax returns, business plans, customer lists, personal letters, etc.).
With SuperKey you can encrypt any file, even while running another program. As long as you
keep the password secret, only YOU can decode your file. SuperKey implements the U.S.
government Data Encryption Standard (DES).

SuperKey helps protect your capital investment
SuperKey, at your convenience, will make your screen go blank after a predetermined time of
screen/keyboard inactivity. You've paid hard-earned money for your PC. SuperKey will
protect your monitor's precious phosphor and your investment.

SuperKey protects your work from intruders while you take a break
Now you can lock your keyboard at any time. Prevent anyone from changing hours of work.
Type in your secret password and everything comes back to life-just as you left it.

Suggested Retail Price: $69.95 (not copy protected)
Minimum system conflguntlon: IBM PC, Xl, AT, PC)r and true compatllln. PC·DOS (MS·DOS) 2.0 or greater. 128K RAM. One disk drive.

SuperKey is a registered trademark of Borland International. Inc. IBM. XT. AT. and PCjr are registered
trademarks of International Business Machines Corp. 1-2-3 is aregistered trademark of Lotus
Development Corp.
BOR0062A

If you use an IBM® PC, you need

T

U

R
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Lightning@
Turbo Lightning teams up
with the Random House@
Concise Dictionary to
check your spelling as
you type!
Turbo Lightning, using the
83,OOO-word Random House
Dictionary, checks your spelling
as you type. If you misspell a
word, it alerts you with a beep.
At the touch of a key, Turbo
Lightning opens a window on
top of your application program and suggests the correct
spelling. Just press one key
and the misspelled word is
instantly replaced with the
correct word. It's that easy!

If you ever write a
word, think a word, or
say a word, you need
Turbo Lightning

You can also teach your new
Turbo Lightning your name,
business associates' names,
street names, addresses,
correct capitalizations, and any
specialized words you use
frequently. Teach Turbo
Lightning once, and it
knows forever.

The Turbo Lightning Dictionary

Turbo Lightning works
hand-in-hand with the
Random House Thesaurus
to give you instant access
to synonyms
Turbo Lightning lets you choose
just the right word from a list of
alternates, so you don't say the
same thing the same way every
time. Once Turbo Lightning
opens the Thesaurus window,
you see a list of alternate
words, organized by parts of
speech. You just select the
word you want, press ENTER
and your new word will instantly replace the original
word. Pure magic!

Turbo Lightning's
intelligence lets you teach
it new words. The more
you use Turbo Lightning,
the smarter it gets

I he I urbo Lightning I hesaurus

Suggested Retail Price: $99.95 (not copy protected)

Turbo Lightning
is the engine that
powers Borland's Turbo
Lightning Library"
Turbo Lightning brings
electronic power to the Random
House Dictionary and Random
House Thesaurus. They're at
your fingertips-even while
you're running other programs.
Turbo Lightning will also
"drive" soon-to-be-released
encyclopedias, extended
thesauruses, specialized
dictionaries, and many other
popular reference works.
You get a head start with this
first volume in the Turbo
Lightning Library.
And because Turbo Lightning is
a Borland product, you know
you can rely on our quality, our
50-day money-back guarantee,
and our eminently fair prices:

Minimum system configuration: IBM PC, XT, AT, PCjr, and true compatibles with 2 floppy disk drives. PC-DOS (MS-DOS) 2.0 or greater.
256K RAM. Hard disk recommended.

BORLAND
INTERNATIONAL

IBM, XT, AT, and PCjr are registered trademarks of International Business Machines Corp. Turbo
Lightning is a registered trademark and Turbo Lightning Library is a trademark of Borland
International, Inc. Random House is a registered trademark of Random House Inc. BOR 0070A

Your Development Toolbox and Technical Reference Manual for Thrbo Lightning
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Lightning Word Wizard includes complete, commented Turbo PascaP source
code and all the technical information you'll need to understand and work
with Turbo Lightning's "engine." More than 20 fully documented Turbo
Pascal procedures reveal powerful Turbo Lightning® engine calls.
Harness the full power of the complete and authoritative Random House®
Concise Dictionary and Random House Thesaurus.
Turbo Lightning's "Reference Manua/"
Developers can use the versatile on-line examples to
harness Turbo Lightning's power to do rapid word
searches. Lightning Word Wizard is the forerunner of
the database access systems that will incorporate and
engineer the Turbo Lightning Library'·of electronic
reference works.

The ultimate collection of word games and
crossword solvers!
The excitement, challenge, competition, and education
of four games and three solver utilities-puzzles,
scrambles, spell-searches, synonym-seekings, hidden
words, crossword solutions, and more. You and your
friends (up to four people total) can set the difficulty
level and contest the high-speed smarts of Lightning
Word Wizard!

TURBO LIGHTNING-CRITICS' CHOICE
"Lightning's good enough to make programmers and users cheer, executives of other software
companies weep."
Jim Seymour, PC Week
''The real future of Lightning clearly lies not with the spelling checker and thesaurus currently included, but
with other uses of its powerful look-up engine."
Ted Silveira, Profiles
"This newest product from Borland has it all."

Don Roy, Computing Now!

Minimum system configuration: IBM PC, Xl, AT, PCjr, Portable, and true compatibles. 256K RAM minimum. PC·DOS (MS· DOS) 2.0 or greater. Turbo lightning
software required. Opllon81-Turbo Pascal 3.0 or greater to edit and compile Turbo Pascal source code.

Suggested Retail Price: $69.95
Turbo Pascal and Turbo Lightning are registered trademarks and Lightning Word Wizard and Turbo Lightning Library are trademarks 01 Borland International, Inc. Random House is.a registered trademark
01 Random House, Inc. IBM, XT, AT, and PCjr are registered trademarks ollnternalional Business Machines Corp. MS-DOS is a registered trademark 01 Microsoft Corp.

BOROOS7

REFLEX@
THE ANALYST

Reflex is the most amazing and easy-to-use database management
system. And il you already use Lotus 1-2-3,@ dBASE,'~) or PFS: File/)
you need Relle~-because it's a totally new way to look at your data.
It shows you patterns and interrelationships you didn't know were
there, because they were hidden in data and numbers.
It's also the greatest report generator lor 1-2-3.
REFLEX OPENS MULTIPLE WINDOWS WITH NEW VIEWS AND GRAPHIC INSIGHTS INTO YOUR DATA.
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The FORM VIEW lets you build and examine your database.
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The LIST VIEW lets you put data in tabular list form
just like a spreadsheet.
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The CROSSTAB VIEW
gives you amazing "crossreferenced" pictures of the
links and relationships hidden
in your data.
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The REPORT VIEW
allows you to import
and export to and from
Rellex, 1-2-3, dBASE,
PFS: File, and other
applications, and prints
out information in the
formats you want.
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The GRAPH VIEW gives you instant interactive
graphic representations.
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So Reftex shows you-Instant answers. Instant pictures. Instant analysis. Instant understanding.

THE CRITICS' CHOICE:
"The next generation of software has officially arrived."
Peter Norton, PC WEEK
"Reflex is one of the most powerful database programs on the
market. Its multiple views, interactive windows and graphics, great
report writer, pull-down menus, and cross tabulation make this one
of the best programs we have seen in a long time ...

The program is easy to use and not intimidating to the novice ...
Reflex not only handles the usual database functions such as
sorting and searching, but also "what-if" and statistical analysis ...
it can create interactive graphics with the graphics module. The
separate report module is one of the best we've ever seen."
Marc Stern, INFOWORLD

Suggested Retail Price $149.95 (not copy protected)
Minimum system configuration: IBM PC, Xl, AT, and true compatibles. PC-DOS (MS·DOS) 2.0 or greater. 384K RAM minimum. IBM
Color Graphics Adapter, Hercules Monochrome Graphics Card, or equivalent. Hard disk and mouse optl_l. Lotus 1-2-3, dBASE, or
PfS: File optional.
Reflex is a registered trademark of Borland/Analytica Inc. Lotus 1-2-3 is a registered trademark of
Lotus Development Corporation. dBASE is a registered trademark of Ashton-Tate. PFS: File is a
registered trademark of Software Publishing Corporation. IBM, Xl AT, and IBM Color Graphics
Adapter are registered trademarks of International Business Machines Corporation. Hercules Graphics
Card is a trademark of Hercules Computer Technology.
BOR 0066A

REFLEX

Includes 22 "instant templates" covering a broad range 01
business applications (listed below). Also shows you how to
customize databases, graphs, cross tabs, and reports. It's an invaluable
analytical tool and an important addition to another one 01
our best sellers, Rellex: The Analyst 1.1.
Fast-start tutorial examples:
Learn Reflex as you work with practical business applications. The Reflex Workshop Disk supplies databases
and reports large enough to illustrate the power and variety of Reflex features. Instructions in each
Reflex Workshop chapter take you through a step-by-step analysis of sample data. You then follow simple
. steps to adapt the files to your own needs.

22 practical business applications:
Workshop's 22 "instant templates" give you a wide range of analytical tools:
Administration
• Tracking Manufacturing Quality Assurance
•
•
•
•
•

Scheduling Appointments
Planning Conference Facilities
Managing a Project
Creating a Mailing System
Managing Employment Applications

Sales and Marketing
• Researching Store Check Inventory
• Tracking Sales Leads
• Summarizing Sales Trends
• Analyzing Trends

Production and Operations

• Analyzing Product Costs

Accounting and Financial Planning
• Tracking Petty Cash
• Entering Purchase Orders
• Organizing Outgoing Purchase Orders
• Analyzing Accounts Receivable
• Maintaining Letters of Credit
• Reporting Business Expenses
• Managing Debits and Credits
• Examining Leased Inventory Trends
• Tracking Fixed Assets
• Planning Commercial Real Estate Investment

• Summarizing Repair Turnaround

Whether you're a newcomer learning Reflex basics or an experienced "power user" looking for tips, Reflex
Workshop will help you quickly become an expert database analyst.
Minimum system configuration: I . PC, AT, and Xl, and true compatibles. PC-DDS (MS-DOS) 2.0 or greater. 384K RAM minimum. Requires Reflex: The
Analyst, and IBM Color Graphics Adapter, Hercules Monochrome Graphics Card or equivalent.

Suggested Retail Price: $69.95
(not copy protected)
Reflex is a registered trademark and Reflex Workshop is a trademark of Borland/Analytica, Inc. IBM, AT, and Xl are registered trademarks of International Business Machines
Corp. Hercules is a trademark of Hercules Computer Technology.

BORDO

Turbo Prolog brings fifth-generation supercomputer
power to your IBM®PC!

Turbo Prolog takes
programming into a new,
natural, and logical
environment
With Turbo Prolog,
because of its natural,
logical approach, both
people new to programming
and professional programmers
can build powerful applications such as expert systems,
customized knowledge
bases, natural language
interfaces, and smart
information management systems.
Turbo Prolog is a declarative language
which uses deductive reasoning to solve
programming problems.
Turbo Plolog's development system
includes:
o
o
o
o

A complete Prolog incremental compiler
that conforms to the Clocksin and Mellish
Edinburgh standard Prolog.
A full-screen interactive editor.
Support for both graphic and text windows.
All the tools that let you build your own
expert sytems and AI applications with
unprecedented ease~

Turbo Prolog provides
a fully integrated programming environment
like Borland's Turbo
Pascal,® the de facto
worldwide standard.
You get the complete
Turbo Plolog programming system
You get the 2DD-page
manual you're holding,
software that includes
the lightning-fast TUlbo
Prolog incremental
compiler and interactive editor, and the free
GeoBase natural query language database,
which includes commented source code on
disk, ready to compile. (GeoBase is a
complete database designed and developed
around U.S. geography. You can modify it
or use it "as is.")
Minimum system configuration: IBM PC, Xl, AT, Portable, 3270, PCjr
and true compatibles. PC-DOS (MS-DOS) 2.0 or later. 384K RAM
minimum.

Suggested Retail Price $99.95
(not copy protected)
Turbo Prolog is a trademark and Turbo Pascal is a registered trademark of Borland International, Inc. IBM.
AT, Xl and PCjr are registered trademarks of Internalional Business Machines Corp. MS-DOS is a
registered trademark of Microsoft Corp.
BOR0016B

VERSION 3.0 with 8087 support and BCD reals

Free MicroCaic Spreadsheet With Commented Source Code!
FEATURES:

THE CRITICS' CHOICE:

One-Step Compile: No hunting &fishing
expeditions! Turbo finds the errors, takes you
to them, lets you correct them, and instantly
recompiles. You're off and running in
record time.

"Language deal of the century ... Turbo Pascal:
it introduces a new programming environment
and runs like magic."
-Jell Duntemann, PC Magazine
"Most Pascal compilers barely fit on a disk, but
Turbo Pascal packs an editor, compiler, linker,
and run-time library into just 39K bytes of
random access memory."
-Dave Garland, Popular Computing

Built-in Interactive Editor: WordStar~like
easy editing lets you debug quickly.
Automatic Overlays: Fits big programs into
small amounts of memory.
MicroCalc: A sample spreadsheet on your disk
with ready-to-compile source code.
IBM® PC Version: Supports Turtle Graphics,
color, sound, full tree directories, window
routines, input/output redirection, and
much more.

"What I think the computer industry is headed
for: well-documented, standard, plenty of
good features, and a reasonable price."
-Jerry Pournelle, BYTE

LOOK AT TURBO NOW!

5J'
5J'
5J'

More than 500,000 users worldwide.
Turbo Pascal is the de facto industry
standard.
Turbo Pascal wins PC MAGAZINE'S
award for technical excellence.

5J'

Turbo Pascal named "Most
Significant Product of the Year" by
PC WEEK.

5J'

Turbo Pascal 3.0-the fastest Pascal
development environment on the
planet, period.

Suggested Retail Price: $99.95; CPIM8_80 version without 8087 and BCD: $69.95
Features for 16-bit Systems: 8087 math co-processor support for intensive calculations.
Binary Coded Decimals (BCD): eliminates round-off error! A must for any serious business application.
Minimum system configuration: 128K RAM minimum. Includes 8087 & BCD features for 16·bit MS-DOS 2.0 or later and
CP/M-86 1.1 or later. CP/M·80 version 2.2 or later 48K RAM minimum (8087 and BCD features not available). 8087
version requires 8087 or 80287 co-processor.

TlJbo Pascal is a registered 1rademirk of Borbnd International. Inc. CP/M is a registered Iradenak
of Digital Research Inc. IBM is a registered InIlemark of IntemationaJ Business MacmIes Corp. MSDOS is a registered Iradenak of Microsoft Cap. W1rdSlar is aregistered tradeInIrk of MicroPro
International.
BOA 0061A

VERSION 2.0

Learn Pascal From The Folks Who Created
The Turbo Pascal® Family
Borland International proudly presents Turbo Tutor, the perfect complement
to your Turbo Pascal compiler. Turbo Tutor is really for everyoneeven if you've never programmed before.
And if you're already proficient, Turbo Tutor can sharpen up the fine points.
The manual and program disk focus on the whole spectrum of Turbo
Pascal programming techniques.
• For the Novice: It gives you a concise history of Pascal, tells you how to write a
simple program, and defines the basic programming terms you need to know.
• Programmer's Guide: The heart of Turbo Pascal. The manual covers the fine points
of every aspect of Turbo Pascal programming: program structure, data types, control
structures, procedures and functions, scalar types, arrays, strings, pointers, sets, files,
and records.
• Advanced Concepts: If you're an expert, you'll love the sections detailing such topics as
linked lists, trees, and graphs. You'll also find sample program examples for PC-DOS and
MS-DOS.8
10,000 lines of commented source code, demonstrations of 20 Turbo Pascal features, multiplechoice quizzes, an interactive on-line tutor, and more!
Turbo Tutor may be the only reference work about Pascal and programming you'll ever need!
Suggested Retail Price: $39.95 (not copy protected)
Minimum system configuration: Turbo Pascal 3.0. PC-DOS (MS-DOS) 2.0 or later. 192K RAM minimum (CP/M-80
version 2.2 or later: 64K RAM minimum).

Is The Perfect Complement To Turbo Pascal@
It contains a complete library of Pascal procedures that
allows you to sort and search your data and build powerful database
applications. It's another set of tools from Borland that will give
even the beginning programmer the expert's edge.
THE TOOLS YOU NEED!
TURBO ACCESS Using B+ trees: The best way to organize and search your data. Makes it
possible to access records in a file using key words instead of numbers. Now available with
complete source code on disk, ready to be included in your programs.
TURBO SORT: The fastest way to sort data using the QUICKSORT algorithm-the method
preferred by knowledgeable professionals. Includes source code.
GINST (General Installation Program): Gets your programs up and running on other
terminals. This feature alone will save hours of work and research. Adds tremendous value
to all your programs.

GET STARTED RIGHT AWAY.-FREE DATABASE!
Included on every Toolbox diskette is the source code to a working database which
demonstrates the power and simplicity of our Turbo Access search system. Modify it to suit
your individual needs or just compile it and run.

THE CRITICS' CHOICE!
"The tools include a B+ tree search and a sorting system. I've seen stuff like this, but not as
well thought out, sell for hundreds of dollars."
-Jerry Pournell, BYTE MAGAZINE
"The Turbo Database Toolbox is solid enough and useful enough to come recommended."
-Jeff Duntemann, PC TECH JOURNAL
Suggested Retail Price: $69.95 (not copy protected)
Minimum system configuration: 128K RAM and one disk drive (CP/M-80: 48K). 1&-bit systems: Turbo
Pascal 2.0 or greater for MS-DOS or PC-DOS 2.0 or greater. Turbo Pascal 2.1 or greater for CP/M-86
1.0 or-greater. 8-bit systems: Turbo Pascal 2.0 or greater for CP/M-80 2.2 or greater.

Turbo Pascal is a registered trademark and Turbo Database Toolbox is a trademark 01 Borland
International Inc. CP/M is a registered trademark 01 Digital Research, Inc. MS-DOS is a
registered trademark 01 Microsoft Corp.
BOR 0063A
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GRAPHIX200l·BQX®
A Library of Graphics Routines for Use with Turbo Pasca/®
High-resolution graphics for your IBM® PC, AT, ®XT,@ PCjr@, true PC compatibles, and the Heath
Zenith Z-100:" Comes complete with graphics window management.

Even if you're new to Turbo Pascal programming, the Turbo Pascal Graphix Toolbox will get you started
right away. It's a collection of tools that will get you right into the fascinating world of high-resolution
business graphics, including graphics window management. You get immediate, satisfying results. And
we keep Royalty out of American business because you don't pay any-even if you distribute your own
compiled programs that include all or part of the Turbo Pascal Graphix Toolbox procedures.

What you get includes:
• Complete commented source code on disk.
• Tools for drawing simple graphics.
• Tools for drawing complex graphics, including
curves with optional smoothing.
• Routines that let you store and restore
graphic images to and from disk.
• Tools allowing you to send screen images to
Epson-compatible printers.

•
•
•
•

Full graphics window management.
Two different font styles for graphic labeling.
Choice of line-drawing styles.
Routines that will let you quickly plot
functions and model experimental data.
• And much, much more ...

"While most people only talk about low-cost personal computer software, Borland has been doing
something about it. And Borland provides good technical support as part of the price."
John Markov & Paul Freiberger, syndicated columnists.

II you ever plan to create Turbo Pascal programs that make use of business graphics or scientific
graphics, you need the Turbo Pascal Graphix Toolbox.

Suggested Retail Price: $69.95 (not copy protected)
Minimum system configuration: IBM PC, Xl, AT, PCjr, true compatibles and the Heath Zenith Z-100. Turbo Pascal 3.0 or later. 192K RAM
minimum. Two disk drives and an IBM Color Graphics Adapter (CGA), IBM Enhanced Graphics Adapter (EGA), Hercules Graphics Card or
compatible.

Turbo Pascal and Turbo Graphix Toolbox are registered trademarks 01 Borland International. Inc.
IBM. Xl AT. and PCjr are registered trademarks 01 International Business Machines Corporation
Hercules Graphics Card is a trademark of Hercules Computer Tech. Heath Zenith Z-100 is a
trademark of Zenith Data Systems.
BOR 0068A
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.EDJ2OR 7tx>tSOX™
It's All You Need To Build Your Own Text Editor
Or Word Processor
Build your own lightning-fast editor and incorporate it into your Turbo Pascal® programs.
Turbo Editor Toolbox gives you easy-to-install
modules. Now you can integrate a fast and powerful
editor into your own programs. You get the source
code, the manual, and the know-how.

Create your own word processor. We provide all
the editing routines. You plug in the features you want.
You could build aWordStar®-like editor with pull-down
menus like Microsoft's® Word, and make it work as fast
as WordPerfect.®

To demonstrate the tremendous power of Turbo Editor Toolbox, we give you the source code for
two sample editors:
Simple Editor
MicroStar

A complete editor ready to include in your programs. With windows, block commands, and
memory-mapped screen routines.
A full-blown text editor with a complete pull-down menu user interface, plus a lot more.
Modify MicroStar's pull-down menu system and include it in your Turbo Pascal programs.

The Turbo Editor Toolbox gives you all the
standard features you would expect to find
in any word processor:
•
•
•
•
•
•
•

Wordwrap
UN-delete last line
Auto-indent
Find and Find/Replace with options
Set left and right margin
Block mark, move, and copy
Tab, insert and overstrike modes,
centering, etc.

MicroStar's pull-down menus.

And Turbo Editor Toolbox has features that word processors selling for several hundred dollars can't begin to match.
Just to name a few:

[!]
[!]
[!]

RAM-based editor. You can edit very large
files and yet editing is lightning fast.
Memory-mapped screen routines. Instant paging, scrolling, and text display.
Keyboard installation. Change control
keys from WordStar -like commands to any that
you prefer.

[!]
[!]

Multiple windows. See and edit up to eight
documents-or up to 'eight parts of the same
document-all at the same time.
Multitasking. Automatically save your
text. Plug in a digital clock, an apPOintment
alarm-see how it's done with MicroStar's
"background" printing.

Best of all, source code is included for everything in the Editor Toolbox.

Suggested Retail Price: $69.95 (not copy protected)
Minimum system configuration: tBM PC, XT, AT, 3270, PCjr, and true compatibles. PC-DOS (MS-DOS) 2.0 or greater. 192K RAM. You must be
using Turbo Pascal 3.0 for IBM and compatibles.
Turbo Pascal is a registered trademark and Turbo Edilor Toolbox is a trademark of Borland
International. Inc. WordStar is a registered trademark of MicroPro International Corp. Word and
MS-DOS are registered trademarks of Microsoft Corp. WordPerfect is a trademark of Satellite
Software International. IBM, Xl, AT, and PCjr are registered trademarks of International Business
Machines Corp.
BOR 0067 A

Secrets And Strategies 01 The Masters Are
Revealed For The First Time
Explore the world of state-of-the-art computer games with Turbo GameWorks. Using
easy-to-understand examples, Turbo GameWorks teaches you techniques to quickly create
your own computer games using Turbo Pascal.e Or, for instant excitement, play the three
great computer games we've included on disk-compiled and ready to run.

TURBO CHESS
Test your chess-playing skills against your computer challenger. With Turbo GameWorks, you're on your
way to becoming a master chess player. Explore the complete Turbo Pascal source code and discover
the secrets of Turbo Chess.
"What impressed me the most was the fact that with this program you can become a computer
chess analyst. You can add new variations to the program at any time and make the program play
stronger and stronger chess. There's no limit to the fun and enjoyment of playing Turbo GameWorks
Chess, and most important of all, with this chess program there's no limit to how it can help you
improve your game."
-George Koltanowski, Dean of American Chess, former President of
the United Chess Federation, and syndicated chess columnist.

TURBO BRIDGE
Now play the world's most popular card game-bridge. Play one-on-one with your computer or against
up to three other opponents. With Turbo Pascal source code, you can even program your own bidding
or scoring conventions.
"There has never been a bridge program written which plays at the expert level, and the ambitious
user will enjoy tackling that challenge, with the format already structured in the program. And for the
inexperienced player, the bridge program provides an easy-to-follow format that allows the user to start
right out playing. The user can 'play bridge' against real competition without having to gather three
other people."
-Kit Woolsey, writer of several articles and books on bridge,
and twice champion of the Blue Ribbon Pairs.

TURBO GO-MOKU
Prepare for battle when you challenge your computer to a game of Go-Moku-the exciting strategy
game also know as "Pente."''' In this battle of wits, you and the computer take turns placing X's and D's
on a grid of 19X19 squares until five pieces are lined up in a row. Vary the game if you like, using the
source code available on your disk.

Suggested Retail Price: $69.95 (not copy protected)
Minimum system configuration: IBM PC, Xl, AT, Portable, 3270, PClr, and true compatibles. PC·DOS (MS·DOS) 2.0 or later. 192K
RAM minimum. To edit and compile the Turbo Pascal source code, you must be using Turbo Pascal 3.0 for IBM PCs and
compatibles.
Tur60 Pascal is a registered trademark and Turbo GameWorks is a trademark of Borland
International. Inc. Pente is a registered trademark of Parker Brothers. IBM, XT, AT, and PCjr are
registered trademarks of International Business Machines Corporation. MS-DOS is a registered
trademark of Microsoft Corporation.
BOR0065A
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REFLEX
FOR THE MAC'M
The easy-to-use relational database that thinks like a spreadsheet.
Reflex for the Mac lets you crunch numbers by entering formulas and link
databases by drawing on-screen lines.
Some of the things Reflex for the Mac wi do for you are included on the
examples disk:
• A 1040 tax application with Schedule A.
• A client billing application set up for a law office,
Schedule B, and Schedule D, each contained in a
separate report document.
• A portfolio analysis application with linked
databases of stock purchases, sales, and
dividend payments.
• A checkbook application.

but easily customized by any professional who
bills time.
• A parts explosion application that breaks
down an objeCt into its component parts for
cost analysis.

Reflex for the Mac accomplishes aI/ of these tasks without programmingusing spreadsheet-like formulas. Some other Reflex for the Mac features are:
• Visual database design.
• "What you see is what you get" report and form
layout with pictures.
• Automatic restructuring of database files when
data types are changed, or fields are added ,
and deleted.
• Display formats which include General, Decimal,
Scientific, Dollars, Percent.

• Data types which include variable length text,
number, integer, automatically incremented·
sequence number, date, time, and logical.
• Up to 255 fields per record.
• Up to 16 files simulta neo~sly open.
• All Macintosh fonts and ~tyles are selectable
for individual fields and labels.
N

Critic's Choice
"... a powerful relational database ... uses a visual approach to information management." InfoWorid
". .. gives you a lot of freedom in report design; you can even import graphics." A+ Magazine
"... bridg.es the gap between the pretty programs and the power programs." Stewart Alsop, PC Letter

,
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